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Disclaimer 
Dieter Spielberg DMS GmbH makes no representation or warranties with 
respect to the contents or use of this help file and specifically disclaims any 
express or implied warranties of merchantability or fitness for any particular 
purpose. Further, Dieter Spielberg DMS GmbH reserves the right to revise 
this help file and to make changes to its content, at any time, without 
obligation to notify any person or entity of such revisions or changes. 

Further, Dieter Spielberg DMS GmbH makes no representations or 
warranties with respect to any ScanFile software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Dieter Spielberg DMS GmbH reserves the right 
to make changes to any or all parts of ScanFile software, at any time, without 
obligation to notify any person or entity of such changes. 

Copyright 
© 1999 - 2006 Dieter Spielberg DMS GmbH, All Rights Reserved 

No part of this document may be reproduced, transmitted or stored in any 
form or by any means, electronic or mechanical, for any purpose, without the 
express written permission of Dieter Spielberg DMS GmbH. 
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Introduction 
Thank you for purchasing ScanFile, the fast, secure and user-friendly 
solution to your document management requirements. ScanFile offers a 
stable and flexible platform for the storage, referencing and retrieval of your 
organisations documents. ScanFile supports a vast range of black and white 
and colour document scanners, and includes several options to make the 
storage of electronic format documents, such as word processing and 
spreadsheet format files a straightforward task, including integration with 
Microsoft Office. 

ScanFile is a multi-user document management system that uses a 
concurrent licensing system, allowing you to maximize your investment in the 
product. 

What is ScanFile? 
The ScanFile solution incorporates three applications: 

• ScanFile 
• ScanFile WebServer 
• ScanFile RemoteStation 
 
ScanFile is the core application and is a full 32bit application that is optimised 
to run on  Microsoft Windows NT4, 2000 and XP Professional based 
workstations. ScanFile can also be installed on Novell Netware and Microsoft 
Windows NT4, 2000 and 2003 servers. 

With ScanFile WebServer, you can give anyone, anywhere in the world 
access to your document libraries. ScanFile WebServer is an Internet server 
based application that allows the retrieval of documents using just a web 
browser. Whether you wish to make documents available over the Internet or 
an Intranet, ScanFile WebServer is the fast, secure, reliable and easy way to 
do it. 

ScanFile RemoteStation is a client-server application that allows you to send 
documents to a central ScanFile store from any location. Using TCP/IP 
connectivity, combined with ScanFile security, client workstations can send 
documents to the RemoteStation server, which will then store them to the 
selected ScanFile document folders. In addition, the RemoteStation Client 
can be used for the retrieval from your ScanFile document store. 
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Important – Please Read 
ScanFile, WebServer and RemoteStation cannot be run without a valid 
software license. The license is contained on a hardware dongle. Once 
ScanFile has been installed, it can be started, and will immediately inform 
you that it is not licensed, and will then open the licensing window. 

Upgrades 
ScanFile 2000 and ScanFile 2002 use a software license called Crypkey. 
This license must not be deleted before installing ScanFile. This also applies 
to WebServer and RemoteStation. 

ScanFile Features 
ScanFile is a very straightforward and easy document management system 
to use and manage, but has all the features required for serious document 
management applications. 

• Intuitive user interface 
• Black & white and colour scanner support 
• Import any electronic format document such as MS Word/Excel files 
• Integration with Microsoft Office 97/2000 and XP 
• Comprehensive document referencing and retrieval features with user-

defined index fields, keywords and full text search. 
• Full document display features including zoom, rotate and enhance. View 

multiple documents 
• Inbuilt document viewer that supports over 200 document types including 

MS Office and PDF documents 
• Automatic barcode indexing* 
• COLD data import* 
• TIFFWriter* 
• Zone and Full text OCR* 
• Forms Recognition* 
• Document Routing* 
• Audit Trail* 
• Full network and jukebox support 
 
* Features marked with an asterix are additional purchases to the ScanFile 
core application 
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ScanFile Options 
The basic ScanFile system comes complete with everything you need to 
create folders and scan and import documents into them. The following 
options can be purchased to enhance the functionality of your ScanFile 
document management solution. 

Global Index 
This adds support for Libraries into ScanFile. 

Barcode 
This allows ScanFile to automatically read and index bar-coded documents 

Keywords 
This allows keyword lists to be applied to ScanFile folders and libraries 

Export 
The Export option allows you to export complete folders/libraries to a 
selected drive and directory. All documents will be exported and a data file 
will be created with the index information associated with the documents 

OCR 
The OCR module has two functions. Zone OCR can automatically index 
scanned documents from data contained within the page of a document. Full 
Text OCR creates a searchable word list from scanned documents, allowing 
you to search the contents of documents 

Forms Recognition 
This option enhances the Zone OCR and allows different forms to be 
scanned into the same folder, and by configuring Forms templates, different 
index zones can be applied for each form. 

Please note: The OCR option is also required if Forms Recognition capability 
is required. 
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TIFFWriter 
TIFFWriter is a printer driver that allows you to 'print' from any Windows 
application into a ScanFile folder. The 'print' will be converted to TIFF format 

COLD 
This module adds support for importing computer generated spool data, 
which might otherwise be output to Microfiche, or held in printed form 

Auditing 
With the optional Audit feature, every event performed by all users can be 
logged to a central database and then reviewed and printed. The events to 
be viewed can be selected by folder or library, user and within a given date 
range 

Document Routing 
Documents can be assigned to pre-defined routes that will send documents 
to specific users and/or folders for viewing/commenting and approval. Each 
route can have multiple steps and documents can be sent from route to route 

LuraDocument 
The LuraDocument file format compresses image files to a higher degree 
than TIFF or JPEG, whilst preserving the quality of the document 

Kofax 
With the Kofax option, support is added to ScanFile for any scanner which 
works with the Adrenaline Image processing board and ImageControls V3.0 

Virtual Printing (VNP) 
With ScanFile VNP, you can create up to 8 virtual printers which allow to you 
‘print’ documents, which are converted to TIFF format and saved to specified 
directories, and can then be automatically imported into ScanFile folders 
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New in Version 8 

New Appearance 
A modern toolbar was added as alternate appearance of ScanFile. The 
classic look is still available. 

Impersonation 
ScanFile Account enabled ScanFile to use a windows account for 
impersonation. Data secured with that windows account can be protected 
from illegal access. 

Audit Trail Management 
Audit Trail Management offers an export function for Audit Trail data. The 
exported files can be merged in ScanFile to a temporary search database to 
retrieve exported data. 

View User 
ScanFile View User. It is possible to license an amount of users who are only 
allowed to view documents. These users do not block a full user licence and 
their rights cannot be altered. 

User Time Out 
A Time Out User functionality was added to ScanFile. A user licence can be 
set free after a certain timespan to avoid license blocking by a user who 
doesn’t work with ScanFile for a longer time period while being logged in. 

Field property ‚External list’ 
New field property External list. The property allows you to assign index 
fields from an index file to the folder fields in ScanFile. When typing in index 
information, a list will pop up for fast selection and – when possible – the 
index field used will try to complete the entry with the next matching index 
from the external list. 
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Keyword Export 
Keywords can now be exported as additional index field. If a document has 
more than one keyword assigned to, it will be exported as many times as 
keywords are assigned to it. Every time with a different keyword. 

Mandatory Keywords 
Extended Folder setting Mandatory Keywords forces the user to select 
keywords before an index is successfully saved 

Auto Open 
ScanFile Auto Open allows the user to 

• select a folder or library that will be opened automatically right after 
ScanFile startup 

• select a setting that will automatically reopen the folder or library that was 
open before the program was closed 

Copy Index Information 
The functions Move to and Send to ScanFile folder, as well as the field 
property Copy Index, offer extended settings to change the order of the 
index information in the target folder. 

Input assistance 
A thesaurus list can be updated via file import 

Input assistance for Thesaurus linked index fields: a word list generated from 
assigned Thesaurus will pup up below the index field for fast selection 

Input assistance for Date fields: a calendar will pop up below the index field 
for fast selection 

Advanced Email Support 
Email attachments can be displayed in an additional window 
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Windows Service 
Remote Services: have been split into a RS Configuration Tool and a RS Service 
(true windows service) 
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Operating Systems 
ScanFile is designed to run as a full or client installation on the following 
operating systems: 

• Microsoft Windows ME 
• Microsoft Windows NT4 Workstation 
• Microsoft Windows 2000 Professional 
• Microsoft Windows XP Professional 
 
As a network installation ScanFile can be installed on the following server 
operating systems: 

• Microsoft Windows NT4 Server 
• Microsoft Windows 2000 Server 
• Microsoft Windows 2003 Server 
 
Additionally, ScanFile can be installed onto Novell systems with restrained 
capabilities (no Remote Services).  

Service Packs 

Please ensure that you keep your operating system up to date with the latest 
service packs. 

Server 
ScanFile is not a client server application and therefore it normally uses only 
storage resources on a server. All important application files are located on a 
server and shared by all ScanFile clients. The server itself – as long no client 
installation is performed – only provides storage resources. 

If the Remote Services are to be run on a server, an additional client 
installation is needed to register all required files on the server. 

ScanFile Requirements 
ScanFile is a 32 bit application designed to require only the least amount of 
resources on server and workstations. The nature of the application requires 
additional storage space to store your documents. In addition the 
specification of a ScanFile workstation has to meet the requirements of every 
day use, attached scanners, type of scanning you are performing and the 
type of documents you work with. 
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Hard Disk Space 
A full installation of ScanFile will require around 100 Megabytes of hard disk 
space. This will decrease to less than 10 Megabytes if a Client install is 
performed. The majority of the Client install consists of common Windows 
components that may already be installed on the workstation. In this case the 
Client install may take up only an additional 5 Megabyte of disk space. 

Additional to the storage space that is needed for the application itself, 
sufficient storage space is needed for your documents. Please ensure that 
you have the correct amount and type of storage for your documents. The 
storage used may be a mix of hard disk space and CD’s, DVD’s and optical 
disk, either using single drives or jukeboxes. 

The amount of storage you might need is the result of a combination of 
factors, such as 

• Are the documents completed or are they still being updated? 
• How many existing documents? 
• What is the average document size on disk? 
• How many documents are created within a period? 
• At what document age does the retrieval rate decrease? 
• Is there a retrieval time requirement? 
• How many retrievals are required per hour/day? 
• How many different applications does a customer have? 
• What index information is used? 
 
Taking these factors into account you can approximate the amount of storage 
space for a given period and put in place your on-line and off-line storage. 

You need to ensure that whatever method of storage is used, adequate and 
regular backups are taken.  

RAM 
Typically, the ScanFile program itself requires between 30 and 60 Megabytes 
of RAM to run. This is dependant upon what operations are being performed 
within ScanFile. When viewing a document, the amount of memory used will 
increase by the requirements of the document and can differ greatly. 

When viewing a scanned or imported image, the compressed file is read from 
disk and then uncompressed into the workstations memory. For a black & 
white A4 document scanned at 300dpi, the uncompressed size will be about 
1 Megabyte. For a 24bit colour A3 document, scanned at 400dpi, the 
uncompressed size will be just under 100 Megabytes. 
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Electronic format documents, such as MS Word or Excel are displayed with a 
multi functional viewer within ScanFile and the memory that is required is 
depend on file type and size. 

The specification for a scanning workstation will be broadly similar to that 
required for viewing the documents scanned. The way a scanner works must 
be taken into account as they do vary in the way images are presented to the 
workstation. 

As an example, The Canon DR-3020 scans A4 black & white documents at a 
maximum resolution of 300dpi. The DR-3020 has inbuilt image compression, 
and will therefore typically send over 35-50k of information to the workstation 
for each page scanned. The DR-5080c however, can scan 24bit colour 
documents up to a maximum of A3 at 400dpi. As the DR-5080c has no 
onboard compression, this can mean that up to 98MB of information can be 
sent from the scanner to the workstation for each A3 colour page scanned. 
This must then be compressed and saved to disk. The size of the saved 
image can range from 2k to 100Mb, depending upon the type of image, and 
the compression levels that are used. 

When calculating the amount of memory a workstation should have, the 
requirements of the operating system need to be taken into account. 
Additionally, the amount of memory used by other applications that are 
operating simultaneously need to be considered. 

If there is insufficient RAM in the workstation, the operating system will use 
the hard disk as virtual memory. This will dramatically affect the 
performance of the workstation. 
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Minimum Requirements 
The following workstation specification is recommended as a minimum 
requirement 

• PC using a 2GHz Pentium 4 Processor 
• 256 MB RAM 
• 17‘‘ Display 
• CD-ROM Drive 
• 40 GB Hard Disk Drive 
• MS Windows 2000 Professional 

Dongle 
ScanFile products are protected from illegal use by utilising a hardware 
dongle. The dongle can be supplied as a USB device or one that attaches to 
the workstation or servers parallel printer port. The parallel port must be set 
to ECP. 
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Overview 
ScanFile can be installed as a standalone system or on a network file server. 
Please read the installation instructions carefully before installing to ensure 
that you fully understand what will be installed, and what needs to be 
prepared prior to installation. 

ScanFile is a networkable program, in that each workstation on a network will 
run ScanFile, and can share common data. The workstations will load 
ScanFile from a common directory on a network server drive. This has the 
advantage of making ScanFile easier to maintain when updates become 
available. 

The installation procedure will be dependent upon which network operating 
system, the server ScanFile is to be installed to, is running. ScanFile can be 
installed on to Microsoft Windows 2000 and 2003 servers and Novell 
Netware servers. Additionally, a workstation running Microsoft Windows 2000 
or XP Professional can be used as a small workgroup server serving up to 
ten connections. 

Important 

Please do NOT attach the dongle to the workstation before installing 
ScanFile for the first time. The Installation program will install the dongle 
device drivers and utility software. 

 

Upgrades 

If you are upgrading from ScanFile 2000 or ScanFile 2002 you must not 
uninstall or delete your previous installation or transfer out the existing 
ScanFile license . 
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Standalone Installation 
To install ScanFile, select Run from the Start Menu and then choose 
SetupSF.exe from the Software directory on the ScanFile CD. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile will be installed into. A default of 
C:\Programs\ScanFile will be offered and this should normally be accepted. 

The Destination directory selection dialogue will also display the available 
disk space on the chosen drive, as well as the space available after ScanFile 
has been installed. Once you have chosen the drive and directory, press the 
Next button. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile installation process will replace. These can be older 
versions of ScanFile components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 

Please note that the ScanFile Installation process will only replace older 
versions of common Windows components. 

Components 
The next step is to choose the ScanFile components to be installed. The core 
ScanFile program will be installed automatically, but you must select the 
additional options individually. Please note that if you have not purchased the 
TIFFWriter, OCR or the Virtual printing option, ScanFile VNP, these will not 
function. 
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Option/Module Description 

MS-Office Integration This option will add Send to ScanFile and Print 
and Send to ScanFile options into Microsoft Office 
2000 or XP. The Version Microsoft Office 97 only 
supports Word and Excel. 

To use the Microsoft Office Integration a Version of 
Microsoft Office must be installed. 

ScanFile CD This facility allows you to create data CDs, which 
have retrieval software copied to the CD. This 
allows retrieval of document from the CDs using any 
PC. 

ScanFile TIFFWriter This option installs a special printer driver, which 
allows you to print documents from any windows 
application as TIFF G4 or JPEG files directly into a 
selected ScanFile folder. 

ScanFile OCR This option offers two facilities. Documents can be 
automatically indexed by the Zone OCR function. 
Additionally, Full Text OCR can be performed 
allowing you to search the documents for specific 
text. 

Extensions Currently the Extension consist of an Exception 
Report utility. This can check the existence of 
numbers of a defined range in a ScanFile folder. A 
log will be created reporting missing numbers and 
numbers that are present several times. 

ASPI Layer This option will install the latest release of Adaptec's 
ASPI drivers for their range of SCSI cards. This will 
be required if you intend to perform scanning on the 
workstation using a scanner attached to a SCSI 
card. 

ScanFile VNP With ScanFile VNP, you can create up to 8 virtual 
network printers which allow to you ‘print’ 
documents, which are converted to TIFF format and 
saved to specified directories, and can then be 
automatically imported into ScanFile folders. 
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If TIFFWriter was selected to be installed, and the operating system on the 
PC is Microsoft Windows NT4, you will be asked to insert the NT4 CD. 
ScanFile needs to install files that are on the NT4 disc. 

Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Licensing 
Once the ScanFile installation is complete, the dongle can be attached to the 
workstation, and then licensed. Please see the Licensing chapter for 
instructions on how to do this. 

Microsoft Server 
ScanFile can be installed onto Microsoft Windows NT4, 2000 and 2003 
servers. Please ensure that the server operating system has been updated 
with the latest Service releases prior to installing ScanFile. 

The ScanFile installation must be performed directly on to the server, not 
from a workstation, as Windows services will be installed. 

Installation 
To install ScanFile to the server select Run from the Start Menu and then 
choose SetupSF.exe from the Software directory on the ScanFile CD. 
Before pressing the OK button, add the switch /U to the end of SetupSF.exe. 
Please ensure that the switch is entered in uppercase: 

<CD-ROM Drive>\Software\SetupSF.exe /U 

The first step is to choose the language that you wish ScanFile to be in. 
Choose the desired language and press OK. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile will be installed into. A default of 
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C:\SFNet\ScanFile will be offered, this can be changed to the server location 
you wish to install ScanFile to. Once you have chosen the drive and 
directory, press the Next button. 

When installing to a server drive, ScanFile should be installed to a server 
Applications directory (e.g. SFNET), not to the root of a server drive. The 
Applications directory is subsequently shared for client use. This is so that 
when a server location is mapped by a client, the ScanFile program 
directory is not the root of the mapped drive. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile installation process will replace. These can be older 
versions of ScanFile components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 

Please note that the ScanFile Installation process will only replace older 
versions of common Windows components. 

Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Licensing 
Once the ScanFile server installation is complete, the dongle can be attached 
to the Server. The Wibu-Key Server service must then be started. This can 
be done manually, or it will be done automatically when the Server is 
rebooted. If you wish to activate the dongle from the server directly, you must 
perform a Client installation to install the required files. Please see the 
Licensing chapter for instructions on how to activate the dongle. 

After this the server installation is complete and you can go on to install the 
ScanFile clients. 

If you wish to use the Remote Services a client installation has to be 
performed on the server to install the necessary components. 
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Novell Netware Servers 
ScanFile can be installed on to a Netware server, but unlike Microsoft server 
operating systems, it cannot be run on the server. In addition, the Remote 
Services are unable to run on Netware servers, although they can be 
configured to run on a client. The installation must be performed from a 
network client running Windows 98, Me, NT4, 2000 or XP. 

Please also note that the license dongle cannot be activated on the Novell 
server. This can be performed on a client workstation after the server and 
client installation. Once the dongle has been activated, it can be attached to 
the Novell server. 

From a network client with Supervisor rights on the Netware server, select 
Run from the Start Menu and then choose SetupSF.exe from the Software 
directory on the ScanFile CD. Before pressing the OK button, add the 
switches /U /NOVELL to the end of SetupSF.exe. Please ensure that the 
switches are typed in uppercase: 

<CD-ROM Drive>\Software\SetupSF.exe /U /NOVELL 

The first step is to choose the language that you wish ScanFile to be in. 
Choose the desired language and press OK. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile will be installed into. A default of 
C:\SFNet\ScanFile will be offered, this can be changed to the server location 
you wish to install ScanFile to. Once you have chosen the drive and 
directory, press the Next button. 

When installing to a server drive, ScanFile should be installed to a server 
Applications directory (e.g. SFNET), not to the root of a server drive. The 
Applications directory is subsequently shared for client use. This is so that 
when a server location is mapped by a client, the ScanFile program 
directory is not the root of the mapped drive. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile installation process will replace. These can be older 
versions of ScanFile components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 
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Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Dongle License Files 
Once the installation has completed, you must edit the file WibuNov.ini, 
which is in the Dongle directory, located off the ScanFile program directory. 
This file is used by the dongle NLM when controlling the ScanFile licensing. 

WibuNov.ini contains references to the location of four license files which 
the dongle NLM interacts with. The four Files are: 

These files in the same directory as the WibuNov.ini, the Dongle directory, 
located off the ScanFile program directory. Open WibuNov.ini in a text editor 
and look for the following sections: 

[WkLAN] 
IpPort=22347 
 
[WKNet 818:1000] 
serverFile<ScanFile-Folder>\Dongle\WKNetSF.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 
 
[WKNet 818:2000] 
serverFile=<ScanFile-Folder>\Dongle\WKNetTic.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 
 
[WKNet 818:3000] 
serverFile=<ScanFile-Folder>\Dongle\WKNetSWS.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 
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[WKNet 818:4000] 
serverFile=<ScanFile-Folder>\Dongle\WKNetSRS.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 

 
The serverFile parameter within each section needs to contain the path to 
the relevant application file. The value of the parameter needs to contain the 
Novell Volume name, and directory name. For example, If ScanFile has been 
installed into a directory called ScanFile, within the Apps directory on the 
SYS volume, then the path would be as follows: 

SYS:\Apps\ScanFile\Dongle\<Filename> 

The section for ScanFile would therefore be changed, as shown below: 

[WKNet 818:1000] 
serverFile=SYS:\Apps\ScanFile\dongle\WKNetSF.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 

 
Once you have changed the serverFile values in all four sections, you can 
save and close the WibuNov.ini file. 

Dongle NLM 
For ScanFile to be able to find the dongle once it has been activated, the 
dongle Netware Loadable Module (NLM) needs to be loaded. The Dongle 
cannot be activated from the Novell Server, this must be done at a Client, 
before attaching it to the server and starting the NLM. Please see the chapter 
Licensing on how to activate the dongle. 

Before loading the NLM copy it from the Dongle directory into the System 
directory on the Novell server. You can then load the NLM at the Novell 
server Console by typing LOAD WKSVNW.NLM followed by the complete 
path to WibuNov.ini as the parameter: 

LOAD WKSVNW.NLM SYS:APPS\SCANFILE\DONGLE\WIBUNOV.INI 

This should also be add to the servers Autoexec.ncf, so that it will 
automatically load if the server has to be rebooted. 

The Installation will now be complete, and Clients will be able to run 
ScanFile. 
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Network Client Installation 
To perform a Network Client Installation select Run from the Start Menu and 
then choose SetupSF.exe from the Software directory on the ScanFile CD. 
Before pressing the OK button, add the switch /N to the end of SetupSF.exe. 
Please ensure that the switch is entered in uppercase: 

<CD-ROM Drive>\Software\SetupSF.exe /N 

The first step is to choose the language that you wish ScanFile to be in. 
Choose the desired language and press OK. 

Components 
The next step is to choose the ScanFile components to be installed. The core 
ScanFile program will be installed automatically, but you must select the 
additional options individually. Please note that if you have not purchased the 
TIFFWriter, OCR or the Virtual printing option, ScanFile VNP, these will not 
function. 

Option/Module Description 

MS-Office Integration This option will add Send to ScanFile and Print 
and Send to ScanFile options into Microsoft Office 
2000 or XP. The Version Microsoft Office 97 only 
supports Word and Excel. 

To use the Microsoft Office Integration a Version of 
Microsoft Office must be installed. 

ScanFile CD This facility allows you to create data CDs, which 
have retrieval software copied to the CD. This 
allows retrieval of document from the CDs using any 
PC. 

ScanFile TIFFWriter This option installs a special printer driver, which 
allows you to print documents from any windows 
application as TIFF G4 or JPEG files directly into a 
selected ScanFile folder. 

ScanFile OCR This option offers two facilities. Documents can be 
automatically indexed by the Zone OCR function. 
Additionally, Full Text OCR can be performed 
allowing you to search the documents for specific 
text. 
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Extensions Currently the Extension consist of an Exception 
Report utility. This can check the existence of 
numbers of a defined range in a ScanFile folder. A 
log will be created reporting missing numbers and 
numbers that are present several times. 

ASPI Layer This option will install the latest release of Adaptec's 
ASPI drivers for their range of SCSI cards. This will 
be required if you intend to perform scanning on the 
workstation using a scanner attached to a SCSI 
card. 

ScanFile VNP With ScanFile VNP, you can create up to 8 virtual 
network printers which allow to you ‘print’ 
documents, which are converted to TIFF format and 
saved to specified directories, and can then be 
automatically imported into ScanFile folders. 

 

If TIFFWriter was selected to be installed, and the operating system on the 
PC is Microsoft Windows NT4, you will be asked to insert the NT4 CD. 
ScanFile needs to install files that are on the NT4 disc. 

Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Remote Service 
The Remote Service is available after a Standalone or Client/Server 
installation on the same machine. The service is not started automatically 
when the installation has finished. If you want to use the functionalities of the 
Remote Service, please go to chapter ‘Remote Services’ for further 
information about setting up and starting of the service. 

Removing ScanFile 
ScanFile can be removed from a workstation or server by selecting ScanFile 
in the Add/Remove Programs option in the Control Panel. 
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If you installed a ScanFile Client and a ScanFile Server on one machine, the 
de-installation from above will only remove the Client. To de-install the 
Server, go to Start -> Run and enter <ScanFile Folder>\Unwise.exe 
<ScanFile Folder>\ScanFile_uninstall.log. 

When ScanFile is installed, whether on a server, or on a networked PC as a 
client, an installation log is either created or updated in the ScanFile program 
directory. This details exactly which elements of ScanFile and common 
Windows components have been installed, as well as any Windows Registry 
entries that have been updated or created. The uninstall program uses the 
information in this file to remove only the elements that were added when 
ScanFile was installed. It is very important that this file is never deleted. 

The ScanFile uninstall program will not delete the following: 

• Folders 
• Libraries 
• User database 
• Audit databases 
• Document routing databases 
• COLD Template database 
• OCR and Forms Recognition template databases 
• Personal Hitlist folders 
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Summary 

Installation Type 
Standalone   SetupSF.exe 
Microsoft Server   SetupSF.exe /U 
Novell Server   SetupSF.exe /U /NOVELL 
Client    SetupSF.exe /N 

Install Location 
Standalone Installation  C:\Programs\ScanFile 
Server Installation  C:\SFNet\ ScanFile 

Backup Location 
For installation rollback 

Components 
Office Integration   MS Office 97, 2000, XP & 2003 
ScanFile CD   CD Folder Retrieval Application 
TIFFWriter   Print to ScanFile Folder 
OCR    Zone, Full Text & Forms Recognition 
Extensions   Exception Report 
ASPI Layer   For Adaptec SCSI cards 
ScanFile VNP   Print to specified Locations 

Personal Hitlist 
Private document store for each user. Used for sending documents to users, 
and by the Document Routing option. 

Remote Service 
Is available after a Standalone or Client/Server installation and has to be 
configured. Please see the Remote Services chapter for more information. 
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Removing ScanFile 
Always use Control Panel – Add/Remove Programs 
Client and Server on one machine, go to Start -> Run and enter <ScanFile 
Folder>\Unwise.exe <ScanFile Folder>\ScanFile_uninstall.log. 

Removing ScanFile does not delete data 
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Overview 
This chapter describes the necessary steps to license ScanFile. The 
licensing system is a hardware dongle you received with the program. This 
dongle is normally delivered in an unlicensed state, and must be activated 
before ScanFile can be run. 

If you have WebServer and/or RemoteStation in addition to ScanFile, the 
licensing for these is held on same dongle as for ScanFile. When installing 
these applications, you will be asked for the ScanFile application path, and 
from this, WebServer and RemoteStation Server will be able to find the 
dongle 

What is the Serial Number? 
The serial number is needed to identify the dongle. The number is engraved 
on the hardware dongle and is needed to download the license key via the 
Internet. 

No new update request is needed, if you mistype your serial number when 
you try to collect a dongle activation key via the Internet. 

What is the Pick Up Code? 
When a ScanFile system is purchased, or when an update to an existing 
installation has been purchased, a Pick Up code is needed. This code in 
conjunction with the serial number is used to license the hardware dongle. A 
Pick Up code will be issued after you ordered a new license or a license 
update. 

How is the license controlled? 
The way the licensing is controlled will depend upon which operating system 
the server or workstation is using. When ScanFile is installed, a directory 
called Dongle will be created in the ScanFile program directory, holding 
various dongle configuration and information files  

Please note that TCP/IP is the only protocol supported by the dongle, when 
used in a network environment. 

Windows NT4, 2000 and 2003 

When a ScanFile Server installation is performed on Windows NT4, Windows 
2000 or Windows 2003 servers, the service WIBU-KEY Server will be 
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installed, and configured to start automatically. Without this service, Clients 
will not be able to find the ScanFile dongle. 

For standalone installations, no service is installed or required. 

Novel Netware 

The Netware Loadable Module (NLM) WKSVNW.NLM that is supplied with 
ScanFile and copied to the Dongle directory during installation must be 
loaded on the Netware server. This can be copied to the Netware SYSTEM 
directory.  

Without this NLM loaded, ScanFile will not find the dongle! 

Licensing 
When ScanFile is installed and then run for the first time, it will report that it is 
not licensed, and will then open the License Manager. When opened after 
the first installation, the License Manager will only show the dongle serial 
number. 

This can also be run from the License Manager option in the ScanFile 
program group whenever you are updating the license. 
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After a successful update or if your dongle is already activated, all licensed 
programs and options will be displayed. 

The dongle can be activated on a Microsoft Windows server or workstation 
once a ScanFile client has been installed. For Novell NetWare server 
installations, the dongle can only be activated when connected to a Microsoft 
Windows workstation, after a ScanFile Client install has been performed. 

There are two methods of activating the ScanFile Dongle via the Internet 
using the License Manager when purchasing a new ScanFile system, or 
upgrading an existing ScanFile installation. Either you update your dongle 
directly via the Internet or you just download a license file. In both cases the 
License Manager is used. 

A Pick up Code which enables you to activate the ScanFile Dongle will have 
been issued when ScanFile was purchased, and this allows you to collect the 
license. Please ensure that the Dongle is attached to the server or 
workstation that you are using, and then run the ScanFile License Manager. 

After the start of the License Manager a password is required unless the 
user login has been switched off. A user needs ScanFile administrator 
rights to be able to update the license. 

If you start ScanFile for the first time and haven’t setup any users yet enter 
the default ScanFile user login: 

User name: admin 
Password: admin 
 
Please note: the password is case sensitive! 

Internet Licensing 
If you have started the License Manager you can start a license update via 
the internet by clicking on the button Internet License. For this option to 
work the server or workstation you started the License Manager on must 
have Internet access. 

After selecting the Internet License option, you will be asked to enter the 
Pick Up Code that you have been supplied with. 
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Once you have entered this and pressed OK, the License manager will 
connect and verify the dongle and pickup code. A confirmation screen will be 

 License Manager will return to the main License Screen, 
and the programs and program options will be listed. The License Manager 
can then be closed. 

Save to / Load from File 
If an Internet connection is not available, a dongle status file can be saved to 
disk and then uploaded to the ScanFile License site, and a dongle activation 
file will then be returned, which can be loaded, and the dongle activated.  

After starting the Licence Manager, click to Save to file. You will be asked to 
enter the Pick-Up code you have been supplied together with your company 
details .A screen appears, where the Pick-Up code and the contact details 
should be entered: 

displayed showing your details and the options purchased. If these are 
correct, press the Activate button to license the dongle. 

Once activated, the
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Once you have entered this and pressed OK, the License manager will open 
a window, allowing you to save your license file. The name of the file is your 
serial number, the file extension is .dsc. 

/dongle  
• Enter or browse to the path where you saved the .dsc file and then click 

on OK. 
extension .dsl will then be returned to you. 
d then browse to the location where you wish to 

save the file 

ill return to the main 

• Transfer the .dsc file to a workstation that has internet access 
• go to the following site using your internet browser: 

www.scanfile.com

• An activation file with the 
Select the Save option an

• Transfer the .dsl file to the workstation connected to the dongle 
• .In License Manager, select the Load from File option and then browse to 

the location where you saved the .dsl file, Highlight the file and then click 
OK. 

 
Now the License Manager updates the dongle with the latest license 
information. Once activated, the License Manager w
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License Screen, and the programs and program options will be listed. The 
License Manager can then be closed. 

U

When you attempt to license your ScanFile dongle, the License Manager will 
search for your existing Crypkey License, and if this is not found, the license 
attempt will fail. In addition, the Crypkey license serial number will be 
validated against the dongle upgrade information, and if these do not match, 
the dongle licensing will fail. 

If the License Manager finds the Crypkey license, the dongle will then be 
activated, and the Crypkey license will be deleted, and your previous 
installation removed. 

Dongle Applet 
When a Server or Client installation is performed, a dongle applet will be 
added to the Windows Control Panel. This can be used to check that the 
dongle can be found by the workstation or server, and can also be used to 
direct ScanFile to use a dongle attached to a specific server or workstation. 

To start the applet open the Windows Control Panel, and select the Wibu-
Key applet, and the following screen will be displayed. 

pgrades 
If you are upgrading from ScanFile 2000 or ScanFile 2002 to ScanFile, it is 
very important that your existing ScanFile installation is NOT uninstalled, 
deleted or the license transferred out prior to licensing your ScanFile dongle. 
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Selecting the Scan option on the default Wibu-BOX Content Tab will scan 
the workstation or the network for dongles, depending upon whether My 
Computer or Network is selected. This enables you to confirm that the 
workstation is finding the dongle. 

You can force ScanFile to only look for a dongle on a specific workstation or 
server by selecting the Network tab and entering the Computer Name or IP 
address of the dongle server in the Server Search List. In the example below, 
ScanFile will use the dongle attached to release-server. 
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Please note: 

On a server in a network installation the WIBU KEY Subsystem “Local” 
should be switched off. Otherwise the server could approach the dongle via 
local drivers and block the network clients. In this case the network clients 
could report “No valid license file”. 
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O
This section describes the first steps after the installation of ScanFile. It leads 
your through the first start-up of ScanFile, the licensing process and informs 

S

. The 

verview 

you about important general settings. 

tarting ScanFile 
During the installation process a ScanFile program group is created in the 
start. Start ScanFile by selecting Programs -> ScanFile –> ScanFile
login dialog of ScanFile is displayed on the screen. 

 

Enter your user name and password in order to continue. The first time you 
start ScanFile login as the pre-installed user admin, password admin. With 
this pre-installed user you can enter all necessary settings and have full 
access to every licensed option. 

Login at first start: 
 
User name: admin 
Password: admin 
 
The password entry is case sensitive! 

The user admin has all rights within ScanFile. Therefore the pre-installed 
password should be changed after the first start, in order to prevent 
unauthorized access. 
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ScanFile Main Screen 
After logging in successfully, the main window will be displayed. If you 
haven’t licensed ScanFile yet, the License Manager will open automatically. 
Please see the Licensing chapteron how to activate your ScanFile dongle 

 

This window will have a standard Windows Menu bar and Toolbars for quick 
access to the applications functions. 

When running ScanFile for the first time, default settings should be applied to 
enable the application to know what input device to use, and where you want 
to store the documents. A short description how to apply these settings 
follows.  

Search Drives 
Before folders and libraries can be created, search drives for ScanFile to 
work on have to be defined. Selecting Choose search drives from the File 
menu allows you to specify the locations which can be anywhere on the 
workstation, mapped drives or UNC paths. Within the Search Drives window, 
a list of drives and paths that have been added will be displayed. When 
ScanFile is first started, the Search Drives selection screen will be 
automatically displayed, and will list the available drives on the workstation. 
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The list of search d
a user does not ha

rives is stored centrally and shared with all workstations. If 
ve rights to access certain paths defined, then those paths 

ighlight it on 

S

 from the File Menu, and select the appropriate scanner. 
Then select Scanner Settings from the Options menu to apply default 
settings for the selected scanner. These can be for scan resolution, paper 

anning, brightness, contrast etc.  

A full description of the options for all scanners is given in the 

will appear empty. 

To add a storage location to the list, press the + button on the top right of the 
display. A window will then be displayed where you can select the drive or 
UNC path that you want to add. To remove a storage location, h
the list and press the – button on the top left of the display. 

canner Selection & Setup 
Before any scanning can be done, the scanner must be selected. Select 
Choose Scanner

size, single/double-sided sc

Scanner 
Setup chapter. 

The scanner settings are saved for every single user and folder. Please 
note: by selecting Options -> Scanner Settings the settings for the opened 
folder are changed. If no folder is open, the scanner settings are saved as a 
default for the logged in user. This default will be copied into every new 
folder that is created by the logged in user. 

N

re the documents in your selected locations. Creating 
folders is fully described in the Folders chapter. Once you have created a 

s 
available that will affect how the ScanFile main screen, ScanFile folders and 
libraries will be displayed as well as affecting the actions of keyword 

. Many other settings influencing the 

 

ext Steps 
Before you can store any documents to ScanFile you must first create 
ScanFile folders to sto

folder and stored your documents the searching and viewing options are 
described in the chapter named Searching & Viewing. 

Please also read the General Settings chapter, as this describes the option

searches and the display of hit lists
behaviour of ScanFile are described in that chapter, too. 

It is very important that you read and understand the General Settings 
chapter to ensure that you get the best from your ScanFile solution. 
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O

ith the images. If using the optional 

o

C

verview 
All documents either scanned or imported into ScanFile will be held in 
ScanFile Folders. Folders not only hold the images, but also the indexing 
information and annotations associated w
OCR module, the OCR full text tables are also held in the folder. 

Folders can be created on any rewriteable media available to the PC as a 
drive reference. This includes network drives. It is always a good idea to 
have separate drives for storing folders and for programs. When creating a 
folder, you can give it a name of up to 32 characters, and specify up to ten 
fields with a maximum length of 255 characters per field. Field functions can 
be applied to these fields providing rapid automatic indexing during scanning 
r post-indexing. 

reate Folder 
To create a folder, select Setup Folders from the File menu, and the Folder 
configuration will be displayed. 

 

From the Setup folders screen, a folder can be created or modified. First of 
all, you must choose which drive or UNC path the folder is to be created in, 
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and you can then give the folder a name. You can also specify a capacity for 
the folder. In this example, it has been set for 600Mb for a CD. 

Once this has been reached, no further scanning into the folder will be 
allowed, and you will be prompted to archive the folder to CD’s or DVD. A 
user-defined capacity can be defined in megabytes, as well as options for 
various other media types. An unlimited option is also available for network 
Drive or RAID arrays. 

The fields for the folder can then be defined. A folder can have up to 10 
fields, with a maximum length of 255 characters, and Field properties and 
Extended Field properties can be applied to them. The field names, lengths 
and functions can be modified at any time without any loss of existing data. 

Field Properties 
Each field can be set with a property value, depending upon the entry 

ailable properties are listed below. 

mended. 

The field content is automatically incremented by one (digit or character). The 
“ “ option will left fill the field with blanks, the “0” will left fill with 0’s. 

Date 
The system date will be entered into the field automatically. Please note that 
t t will 

requirements for that field. The av

None 
No auto indexing or field formatting property has been applied. 

Duplicating 
An entry typed into the field will be kept and passed on to all subsequent 
records created until the entry is a

Counting 

he date forma be taken from the operating system Short Date Format. 
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Long Date 
The system date will be entered 
f  Lon

B
A barcode will be read from the scanned docum
The type of barcode

A predefin d synonyms can be applied to a 
field. If the synonym is typed in when indexing, the word will be shown. 

Externa
nal List allows you to connect ScanFile index fields 
file. Later on you will be able to fast index your 

From the Field property combo box, select External list, and then select the 
x information. Then a window is displayed, where 

ber of fields, field separator, field delimiter and the 

 are saved. 

into the field automatically. This is taken 
g Date Format. rom the system

arcode 
ent and entered into the field. 

 must be set from the options menu. 

Checksums 
These options will check entries for errors via the use of check digits included 
in the value being entered. 

Thesaurus 
ed list of words and their associate

l List 
The field property Exter
with fields in an index 
documents with index data from this file.  

data file that holds the inde
you have to enter the num
text mode. Click on Read line to read the first line of the file. The index fields 
from the file will be displayed on the left, and the fields from the folder can be 
matched to these. It is very important that the settings are correctly set. Once 
the field assignment has been set up, click on OK and the settings

The folder field that is set to External List will be the connect field for this 
functionality. 

If you open a folder, the connect field will be equipped with a list containing 
data from the index file. If you start to enter characters into the index field, the 
list will appear below the field. Additionally the function tries to complete your 
entry with matching index data from the list. 

You can either select the new index with a double click on the list item or 
confirm the data in the index field with the return key. This will automatically 
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fill all connected folder index fields wit
The list will disappear and the focus wi

h index information from the index file. 
ll be set on the next field. 

If one of the fields in the index file contains no value (““), existing index 
information in the connected index field will remain. If one of the fields in the 
index file contains a blank (“ “), existing index information will be deleted. 

E

 Ext. 

xtended Field Properties 
Extended properties can also be applied to each field, which can dictate what 
is allowed to be entered into a particular field. These properties are 
accessible by selecting the button on the extreme right of the field to 
which you wish to apply them. 

 

Input Mask 
 in the type of character you wish to be typed in for 

Mask box. The character types are 

en typing into 
a field, the cursor will automatically jump over these characters. You can test 

box. 

To set an input mask, type
each of the field character positions in the 
listed. As can be seen in the example above, entering dashes and slashes 
within the mask will force those characters to be in the field. Wh

the format of the input mask within the Test field 
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Duplicate Index Action 
The Duplicate Index Action list offers options that will determine what action 
should be taken if the same index information as an existing record is 

e options are: entered. The availabl

Action Description 

None Duplicate Index Action is disabled 

Append The document/pages will be appended to the existing 
record 

Append with The user will be prompt
prompt 

ed whether to append the 
document/pages to an existing record. 

Reject The index information will be rejected 

Prepend The document/pages will be inserted at the beginning of 
the existing record 

Prepend with 
prompt 

The user will be prompted whether to insert the 
document/pages at the beginning of the existing record. 

Copy index This option is the same as the field property Duplicate 
Index Action. If you use the Copy Index property in the 
Extended Field Properties you are able to use another 
fie e for thld property like Barcod e index field. 

Date Validation 
d date can be performed by selecting the Check if 
ll ensure that incorrect dates are not accepted. In 

2003-06-23  YYYY-MM-DD 
06/23/2003  MM/DD/YYYY 

Mandatory Field 
If this option is selected, an entry must be made into the field when indexing. 

Validation of a user entere
Valid Date option. This wi
addition, you can set the format in which the date has to be entered by the 
user by selecting the New Date Format option, and entering the required 
format in the field provided. Some Examples: 

Date   Format 
23.06.03  DD.MM.YY 
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Field Must be Full 
This option, when selected, will force the user to enter index information in 
the field, to the full length of the field. For example, if the field length is set to 
10, then 10 characters must be entered by the user into the field. 

Right Align 
When entering numeric values, the contents of the field can be automatically 
right aligned with leading 0's or blanks by selecting the appropriate option. 

A

eparation Sheet 

tween them. The files will be automatically divided and records 
created in the ScanFile folder. 

n batch scanning documents within the 
Folder. 

Please see the Job Separation Sheets chapter for a full description on 
ration sheets. 

ocuments per 

Folders, you can set the default image 
compression format to LuraDocument or to TIFF G4/JPEG format. 

dvanced Settings 

Job S
With the optional Forms Recognition enabled, ScanFile can use job 
separation sheets during batch scanning. This enables several files to be 
placed in the scanner feeder at the same time with the job separation sheets 
placed be

From the drop down Job Separation Sheet list, you can select which 
separation sheet is to be used whe

configuring the sepa

Import Compression Format 
An optional feature of ScanFile is support for the LuraDocument compression 
format. This offers far greater levels of image compression without any 
significant loss of quality, allowing you to store many more d
megabyte than standard compression formats. 

Using this option in Setup 

Please see the chapter on LuraDocument for more details. 
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Duplicate Index Action 
This option Execute after Zone OCR reading allows you to assign whether 

Index information 
 the index fields within the toolbox 
he folders toolbox. 

Document Retention control is a setting that enables you to perform an action 

Thesaurus 
The Thesaurus field property can be used to cut out repetitive indexing, and 
to ensure that index data such as names are typed correctly. A list of words 
can be defined, and multiple synonyms - or short codes - can be set for each 
word. For example the short code 'dsp' can be applied to 'Dieter Spielberg 
DMS GmbH', and when indexing, if 'dsp’ is typed in, it will be replaced with ' 
Dieter Spielberg DMS GmbH '. 

the duplicate index action will be executed after a zone OCR. 

With the option Clear fields the contents in
will be deleted by changing the category in t

Document Retention Recording 

on the contents of a folder after an allocated amount of time. This is useful, 
for instance, if you want to clear a backlog of documents from a folder that 
are no longer needed, to save space. 
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To create or edit a Thesaurus list, from the Options menu, choose Edit 
Thesaurus. On the displayed screen, choose Thesaurus New/Open to 
open an existing Thesaurus, or to create a new one. The Thesaurus files are 

re easily identifiable. 

finished, choose Close and the changes will be 
automatically saved. 

given the extension '.THE', so a

The words are displayed in the left column, with their associated synonyms in 
the right column. Only the synonyms for the selected word are displayed. 

To add a word, choose Add Word and then type the word. To add a 
synonym for a word, select the word then choose Add Synonym, and then 
type the synonym. When 

The same Thesaurus can be applied to as many folders as you wish. They 
are not specific to a folder. 

Thesaurus Import 
A new button was added to the Thesaurus window: Import Thesaurus. This 
function allows you to automatically fill or extend a Thesaurus file. 
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After clicking on Import T
update information. Then 

hesaurus, you are asked to select a file containing 
following window is displayed: 

 

E  Start Import. 
The file will be imported. The first field of a line will be considered to be a 
word, all following fields will be interpreted as synonyms belonging to the 
word. 

created. All 

n to the Thesaurus window by clicking 
on Close. If you opened the Thesaurus from an open folder, the new entries 
w

Keywords 

yword lists have the extension '.KEY'. 

To create a keyword list, or to edit an existing one, choose Edit keyword 
l on

nter field separator, field delimiter and text mode and click on

If a word is not found in a ScanFile Thesaurus, it will be 
synonyms belonging to this word will be added, as long as they are not 
already in use. Synonyms have to be unique, so double entries are not 
allowed. 

After a successful import you can retur

ill be immediately at your disposal. 

A predefined list of keywords can be created and assigned to a folder. This is 
an extra level of indexing, and allows multiple keywords to be attached to a 
particular document. To attach a keyword list to a folder, click on the 
Keyword List button in the Setup Folders dialogue, and then select the list 
you wish to apply. All ke

ists from the Opti s menu. 
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Click on the New/open list button to open or create a keyword list. To add 
words to a list, click on the Add Word button, and type in the words you wish 
to enter. 

To make words visible/invisible, click on the column headed Visible next to 
the word, and either a red cross or a green tick will be displayed. If a keyword 
is not visible it will not be displayed when the folder is opened. 

Once you have finished, click the Close button, and the changes will be 
saved. 

Working with folders 
To open a folder, go to the File menu and select Open Folder. Only one 
folder can be open at any one time. From the displayed screen, you can 
select the drive the folder is on, and then select the folder you wish to open. 
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Whenever a folder is open the folder toolbox will be available, allowing you to 
access the majority of functions that need to be carried out within a folder 

ng and searching. such as scanning, indexing and editi

 

The structure of the folders to nd may 

Toolbox – Scan 
e available if the Scan option is selected in the folder 

age files, select manual or 

olbox depends on the folders setup a
vary from the picture above. 

The following tools will b
toolbox. These allow you to scan single or multi-p
auto feed, and to browse through the current file. 
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Toolbox – Search 
This selection allows you to specify the required search criteria for 

rch. This will result in a list of the files found documents, and perform a sea
being displayed. 

 

Toolbox – Edit 
From this the indexing information for a document can be changed. You can 
also amend the document itself by inserting, appending, revising and deleting 
pages. 

 

Toolbox – Postindex 
Post-indexing allows you to scan documents that are to be indexed at a later 
date. The images scanned are stored in a separate area of the folder, and 
are not divided into files. When going through the post-index pool, the images 
can be separated into files by using the available tools. They can also be 
appended to existing files. 
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Keyword Display 
If a keyword list has been assigned to a folder various options as to how and 
whether the keywords are displayed are available. 

In the Keywords Search Mode of the General Settings screen, the 
keyword list preferences can be set. 

You can choose not to display the keyword list at all by selecting Hide 
Keyword list. The Display keywords as Text option will display the 
keywords in a column format, but if this is not selected, the keywords will be 
displayed in a cell format. 

You can also choose whether, when doing a multiple keyword search, the 
records displayed will show records that have keyword 1 AND keyword 2, or 
that have keyword 1 OR keyword 2. 

To select multiple keywords when either indexing or searching, hold down 
the CTRL key when clicking on the words you wish to select. 

Document Retention Recording 
Document Retention control is a setting that enables you to perform an action 
on the contents of a folder after an allocated amount of time. This is useful, 
for instance, if you want to clear a backlog of documents from a folder that 
are no longer needed, to save space.  

This action can only be performed on folders created in version 6.0.0 or 
later of ScanFile. 

Setup 
Once a folder has been setup to activate the recording of the Document 
retention information you must select Document retention from the Options 
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menu and click on the Activate checkbox. You are then required to select a 
time you wish to start recording the retention information for that record, here 
you have four options: 

Setting Description 

Document Open 
Date 

Set by the user 

Document Close 
Date 

Set by the user 

Last Addition Date Set pages were last added to the Document. 

Last Retrieval Date Recorded from when the Document  was last retrieved.

 

Once you have selected the time at which the Retention Recording will start 
you must select how long the data will be held for, this is done by monthly 
periods. 

to export, destroy or 
Finally you must select what action you wish to be performed once the 
Retention Time has expired, here you have a choice 
move the documents. 
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F
ll documents held in a ScanFile system. 

l tain the index data associated with those documents. 

o ication 
32 Characters 
10 Maximum 

 32 Characters 

Thesaurus   1 per Field 

 Clears the index information within the folders 
Toolbox when changing the category 

uler Adds a folder to the Document Retention 
Scheduler 

Duplicating   Field retains previously entered value 
 Puts leading blanks in front of numeric values 
 Puts leading 0's in front of numeric values 

records 
Mod 2    Customer checksum 
Mod 10.1    Customer checksum 

 Customer checksum 
 Customer checksum 

olders Summary 
Folders are the storage location for a
Fo der can also con

F lder Specif
Folder Name   

 Fields   
Field Name  
Field Length   255 Characters Maximum 
Keyword List   1 per Folder 

Extended Settings 
Compression Format  TIFF/JPeg or LuraDocument 
Job Separation Sheet  None/Job Separation Sheet/Named Sheet 
Duplicate Index Action  Sets the action for duplicate index information 
Clear Fields 

Retention Control Sched

Field Properties 
None    No Property 

Counting " "  
Counting "0"  
Date    Current Date 
Long Date    Current date in format eg. '07 October  2003' 
Barcode    Accept barcode value while scanning 
Thesaurus   Assign Thesaurus to field 
Copy Index  Duplicates index information of existing 

Mod 11.1   
Mod 11.2   
Verify 11    Customer checksum 
ISBN    Customer checksum 
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External List  Reads index information from an external file 
for fast indexing 

Mandatory Field   Field must contain data 
 Field must contain data to maximum field 
length 

Extended Properties 
Mask    Only accept input in pre-defined format 
Duplicate Index   Allow/Not allow Duplicate index 
Check Valid Date  Checks entry for valid date & specified format 

Must be Full 

Right Align 0's   Sets leading 0's in front of numeric values 
Right Align " "'s   Sets leading blanks in front of numeric values 
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Editing Documents 
There are several options that allow you to change a document after it has 
been scanned. These are: 

• Append Pages 
• Insert Pages 
• Delete Pages 
• Revise Pages 
• Split File 
• Change the Page Order 
• Save Rotation 
 
The first four options are available in the Folder Toolbox from the Edit option. 

Append Pages 
Once you have selected the file you want to append to on the Hitlist, choose 
the Edit option in the Folder Toolbox, and press the append icon. The pages 
to be appended will then be scanned. After all the pages have been scanned, 
you will be prompted to save the pages, continue scanning, or to abandon 
the append 

Inserting Pages 
To insert pages into an existing file, select the file on the Hitlist, then go to the 
page that you want to insert pages before. Click on the Insert pages icon in 
the Edit option of the Folder Toolbox. Once the feeder is empty, you will be 
prompted to save or discard the pages just scanned. 

Delete Pages 
There are several choices when deleting pages from a document. First of all, 
display the page at which you wish to start deleting, and then select the 
Delete icon from the Folders Toolbox. You will then be prompted on what 
you want to delete. Select the appropriate option and the file will be updated. 
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Revise Pages 
An original document can be revised by clicking on the Revise Pages button 
in the Folder toolbox Edit menu. This will scan in an amended copy of the 

o browse through the revised and original pages. 

Split File 
This option enables you to break apart a single file in to two files with 
identical index information. To do this, select the file you wish to break apart 
from the Hitlist, and then display the page of the file that you wish to become 
the first page of the second file. Select Split File from the Edit menu. After 
confirming that you wish to proceed, a second file will be created. If required, 
you can then edit the index information of the files to reflect the changes. 

Change Page Order 
Once a document has been scanned, you may find that you wish to change 
the position of a page within the file. This can be achieved in one of two 
ways. 

Image Display Menu 

While displaying the page of the file that you wish to move, pressing the right 
mouse button in the image display window will show the right click menu. 

By choosing Change Image Position you will then be prompted to enter the 
number of the page you wish to move the currently displayed page to. 

document and allow you t
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FastPics Drag & Drop 

Within the FastPics window, by holding down the left mouse button on the 
g that page to the 

on for. You can then choose to 
set the rotation for the displayed page, all pages of the record, or all selected 
records. 

page of the document you wish to move, and then draggin
position within the file you wish to move the page to, the page will be moved 
and the file reordered. 

Save Rotation 
The orientation that a scanned image will be displayed can be set and saved 
so that it will always be displayed in the chosen orientation.  

To do this, set the currently displayed image to the rotation you wish to save 
and from the View menu, select Save rotati

The image rotation setting is saved in the Folder database, and does not 
affect the original scanned image. 

Annotations 

• Highlight 

display window. This will also be 
shown in the FastPics. 

These can be used to mark or highlight part of a page that is of particular 
interest. The annotations are specific to the page on which they are created. 
Different annotations can be added to different pages within the same 
document. The annotation types are: 

• Text annotation 
• Line 

• White-out Area 
• Black-Out Area 
 
If a file has annotations attached to pages, this will be signified by a pencil 
symbol in the top-left corner of the image 
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Please note: Annotations cannot be applied to native format documents. 

H  Re
A user within a default security level group of Trustee or above has the 
option of hiding records within a fo
t

To hide a record, 
press the Hide Re or select Hide Record from the Options menu. If 
a record has been marked as hidden to 
s
r elect the 

idden cords 

lder. Hidden records will not be shown on 
within the View security level group. 

highlight the record you wish to hide on the Hitlist, and then 
cord tool, 

he Hitlist to users 

View level user groups., an X will be 
es column of the Hitlist against the record. To unhide a 
record on the Hitlist, and select Hide Record. 

hown in the Not
ecord, s
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O

 library is a collection of the indexing information from ScanFile folders. 
ibraries allow you to search across all the folders that have been added to a 

library. 

Due to the construction of a ScanFile library, it is possible to have folders 
with completely different field structures within the same library. However, to 
ensure that you find the documents you want, you would have to make sure 
that a name field, or customer number field, for example, is always in the 
same position within the folder, since the library search is based on index 
field positions rather than index field names. 

Create / Edit Libraries 
Selecting the Setup Libraries option from the Libraries menu will display 
following screen: 

verview 
The Libraries feature is a purchasable option of ScanFile. 

A
L

 

A list of the libraries already created is shown on the left side of the dialogue. 
To create a new library, click on the New Library button, and then type in the 
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name you wish to give the library. You can then choose which folders you 
wish to add to the library. 

First, select the drive reference the folder(s) is on, and then highlight the 
folder name in the top list. To add that folder to the library, click on the Add 
button. 

Prior to pressing the Apply button to add the folders to the library, you can 
choose to select the Automatically Update Library option. With this option 
selected, every time a library is opened, the folders imported into the library 
will be checked for updates. If a folder has been updated, the changes will 
automatically be carried over to the library. 

The Scheduler option is used with the ScanFile Remote Services, which is 
described in the chapter Remote Services.  

Once you have added all the folders to the library, the library will be created 
by clicking on the Apply button, which will show a progress dialogue while 
importing the index information into the library. 

Please note that each drive a folder resides on will be given a media ID, so 
that ScanFile can identify the correct drive for that folder. In the case of CDs, 

 be set automatically, by 
p Libraries dialogue, or 
edia ID's manually, an 

alphanumeric reference can be given. 

Conditional Import 
Conditional Library Import is a feature that allows you to limit and specify 
which documents from a folder you wish to import into a Library. This is 
useful especially if there is information in a folder that you do not want in a 
specific Library. 

To setup a Conditional Import, click on the button of the same name on the 
Library Setup window and the Conditional Import window will be 
displayed. Here you have three options; Field, Condition and Value.  

Under Field you must select which field is to be used as the conditional field 
from the fields available in any of the selected folders. Secondly you must 
select the Condition to be applied; here you are given a number of options: 

each disk will be given an ID. The media IDs can
selecting Auto increment Media IDs on the Setu
can be entered manually. When entering the M

Option Description 

Greater This is used usually for numerical or date fields, should a 
number be entered and any numbers in that field be 
greater, the records will import. 
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Smaller This is used usually for num
number be entered and any num

erical or date fields, should a 
bers in that field be 

smaller, the records will import. 

Equals This can be used for numeric or alphabetic text, should 
any record match exactly what is entered in the value box 
then is will be imported. 

Not Equal This can be used for numeric or alphabetic text, should 
any record not match exactly what is entered in the value 
box then is will be imported 

Greater or 
Equal 

This will typically be used for numeric but can also be used 
for alphabetic text. Should any value entered be Greater 
than or Equal to the number entered then it will be 
imported. 

Smaller or This will typically be us
Equal 

ed for numeric but can also be used 
for alphabetic text. Should any value entered be Smaller 
than or Equal to the number entered then it will be 
imported. 

Like This option is used in conjunction with wildcards. If you 
type the value as part of a word but use a wildcard for the 
rest of it should import all matches E.g. Scan* will import 
Scan, Scanner, ScanFile etc. 

Finally you must enter the value that the condition must adhere to whether it 

to be valid, OR connected only either one of 
the conditions have to be valid. 

allowing 
you to select an index field that is used for access verification. This field has 
to contain the name of the user to connect the logged in user to the 

ry is performed using WebServer. 

that contains Customer Invoices, and 

be numeric or alphabetic text. 

The Conditional Import can be setup to perform the checks for import on up 
to two fields at the same time. With the option AND or OR you can determine 
the records that are to be imported by the second field should you wish. AND 
selected both conditions have 

User Dependent Search 
If you select the Setup Libraries option from the Libraries menu and click 
on the button User depended search, a window will be displayed, 

document when a search within the libra

As an example, if you have a library 
you wish to make these available to your customers using WebServer, you 
can create a ScanFile user for each customer, with the user name being the 
Customer number. When creating the Invoices Library, you can then set the 
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library filter to the field number that corresponds to the Customer Number 
field. When a customer logs in to the WebServer system using his customer 
number, it is ensured that he can only access the invoices belonging to him. 

Please note that if a user is a member of the Admin user group, the filter will 
not apply, and that user will be able to view all records within the library. 

S

he Library search screen will then be 

earch in Libraries 
Firstly, you must open a library you wish to search in. To do this, select Open 
Library from the Libraries menu, and then choose the library you wish to 
open on the selected search drive. T
displayed: 

 

The number of search fields depends on the field structure of the imported 
folders. The folder with the largest amount of index fields limits the amount of 
search fields. 

Always the he field names of the selected folder will be shown. If a selected 
folder has less index fields than others, the remaining search fields are 
unnamed. But named or not, any of the fields can be used for searching, 
irrespective of the number of fields a folder has, as other folders may have 
more fields. 

The keyword list of a library is a summary of all imported folder keyword lists, 
and can be used to search for documents in the same way as for folders. 
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Selecting Options -> General Settings -> H
displaying of keywords. 

ide Keyword List will turn off 

esults of the search. 

ent, you must double-click on the relevant document on the Hitlist. 

By pressing the Folders button, you can display or hide the names of the 
folders in the library. You can also highlight a folder name, and choose to just 
search within that folder. 

To search, specify the criteria and then press the Search button. A Hitlist will 
then be displayed showing the r

Unlike a folder, when the Hitlist is displayed and the Image Display window 
opened, the first page from the first file will not be shown, because the folder, 
in which this document is stored, may not be on-line. To show the contents of 
the docum

If the document cannot be accessed directly, ScanFile will prompt you to 
enter a medium with a specific Media ID the document is stored on. In this 
case the search drive has to be listed in the search drive list of ScanFile. 

The headings in the Hitlist show the field names of the selected archives. 
Since the possibility exists that folders with different fields are stored in the 
same library the headings of the columns changes, in order to indicate the 
selected document. 
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Overview 
New documents can be scanned into ScanFile via either the Scan mode of 
the folder toolbox, or by the Post-index mode. 

How the indexing information relating to the document will be entered is very 
much dependent upon the type of document being scanned, and how the 

een set for the folder fields. The 
most basic method is to enter the indexing information into the fields in the 

ld t the keywords required (if applicable) and then start 
a ents have barcodes, if a field has been set for auto 

ments are to be OCR'd, the index information will be 
e lly after the document has been scanned. 

S

Batch Scan will create will create a multi-page document from the pages 
being fed through the scanner. Once the feeder is empty, you will be 

to continue scanning into the same file. 
 file for each page scanned. 

parameters for the scanner prior to 
starting to scan, this must be done from the Scanner Setup screen. 

P
lity lets you scan batches of documents very quickly, and 

then divide them into files and apply indexing information to them at a later 
date. Documents scanned to this 'Pool' are kept in a special work area until 

folder was set up, and what properties have b

fo er toolbox, selec
sc nning. If the docum
increment, or if the docu
cr ated automatica

ingle & Batch Scan 
To add documents to your folder by scanning, choose the Scan option from 
the folder toolbox, select either the Batch Scan or the Single Page Scan 
button to start scanning. 

prompted to save the images or 
Single Page Scan will create a new

In both modes the Canon DR-3020, DR-5020 and DR5080c can recognise 
and act upon control sheets, allowing you to change between single & double 
sided scanning, text & photo mode, and also for file separation whilst using 
batch scan. The Job Separation Sheets in ScanFile allow the automatic file 
separation independently from the scanner model. This option needs the 
license for Forms Recognition. 

For scanners directly controlled from ScanFile, scanning can be stopped at 
any time by pressing the STOP button, which will appear in place of the Scan 
icons, while scanning is in progress. 

If you wish to change any of the default 

ostindex Pool  
The Post-index faci
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they are indexed, whereupon they are added to the main index and file 
storage location within the folder. 

To add documents to the Postindex pool, select Post-index from the Folder 
Toolbox, place pages into the scanner feeder, and then select the Scan 

pool will be displayed.  

To keep adding pages to the new file, just keep on pressing the Append 

 icon again. 

 then press the 
Append page icon. 

Pages icon. 

Once the documents are in the pool, they can be viewed by using the Next 
page & Previous page icons. 

To create a new file, select the page that is the first page of the file, type in 
the indexing information for the file, and then click on the Save Image icon. 
Once you have pressed the Save Image icon, the next page in the Postindex 

page icon for each page of the file that is displayed. When a new file needs 
to be created, just press the Save Image

The Append page feature of Postindex can also be used to append pages to 
existing files. Via the search option find the file you wish to append to, go to 
the Postindex pool, display the page you want to append, and

Instead of pressing the Append icon you can also press the + key on the 
keyboard to append pages. This will only work if the first field is in overwrite 
mode. Pressing the - key will bring the appended page back into the 
Postindex pool. Pressing CTRL and + will append all remaining images 
from the Post-Index pool. By pressing ALT and + all remaining pages will 
be imported into the folder as single page documents. 

Function Sheets 
The Canon DR-3020 and the Canon DR-5020/80c scanners support the use 

ction sheet (the sheet is not saved in ScanFile), and to 
either stop or continue scanning when the function sheet is detected. 

The use of the function sheets is selected from the scanner setup. 

of two types of function control sheets. The control sheets can be used to 
change the paper size being scanned, as well as changing from single-sided 
to double-sided scanning. 

Batch detection sheets are used to enable several files to be placed in the 
scanner feeder at the same time with the batch detection sheets placed 
between them. The files will be automatically divided and records created in 
the ScanFile folder. With each type of function sheet, you can elect to either 
keep or discard the fun
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Job Separation Sheets 
From ScanFile Release 7.3, the Forms Recognition option adds support for 
Job Separation Sheets while scanning, which enables several files to be 
placed in the scanner feeder at the same time with the job separation sheets 
placed between them. The files will be automatically divided into documents 
and stored in the ScanFile folder. Sheet templates can be assigned to a 
Folder within the Folder setup. 

Job Separation Sheets can be assigned to a folder in the Setup Folder 
window and can be used with any scanner. Further information about 
working with Job Separation Sheets are given in the chapter Job Separation 
Sheets. 
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Overview 
The correct indexing of documents is very important, as you have to rely on 
the index information to search and retrieve your documents later on. The 
more detailed your index information is, the better you will be able to narrow 
down your search results. 

The following indexing options are available: 

exing 
 Indexing 

on needs to be installed and licensed. 

Several methods can be used at the same  index fields are 
f d manually cted field properties or 
by a Zone OCR process. 

Manual Indexing 
When indexing pe in the index information. This 
an be done before documents are scanned or saved to the folder from the 
ostindex pool. The index information of documents in the folder can be 

c m 
w e 
ser can continue with the index entry. 

 as the Duplicating field property and applying a thesaurus to a 
field help to cut out repetitive indexing and to ensure that index data such as 
names are typed correctly. Please refe  to read more 
a ut these field p

A ndexin
With area indexing, for each field in
display a specific portion of the image. This is particularly useful when 
i  batches exing information in 
the same position. 

• Manual Ind
• Automatic
• Import of index files 
• OCR Indexing 
 
The first three options are standard features that are described later on in this 
chapter. Please refer to the Import chapter to read more about the import of 
index information from an external file. To index documents with Zone OCR 
recognition, the ScanFile OCR opti

time, so that some
ille  as others are filled automatically by sele

 manually, the user has to ty
c
P
hanged at any time. Enter the information into the text boxes and confir
ith Return. ScanFile will automatically jump to the next index field and th

u

Options such

r to chapter Folders
bo roperties. 

rea I g 
 the folder, ScanFile can zoom and 

ndexing of similar documents that have the ind
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T this, first 
turned on within Settings. Then select the first document you 
want to index from the Hitlist, and choose the Edit option on the Folder 

olbox. 

ingly for the next field. Repeat this for all fields. 
When you press the Enter key in the last field, ScanFile will automatically 

A
ScanFile offers various functions to auto fill index fields, depending on the 
index field and folder settings. Which settings are available and what index 

d in the Folders chapter. 

O
ScanFile’s Zone recognition allows you to read area's of a document, and 
place the result of the OCR in to the folder fields. To use this function an 

E
To edit the index information of an existing document, select the document in 
question in the Hitlist and switch to the Edit mode in the Folder Toolbox. The 
index information of the selected document are displayed and can be 

hange Index button. The index 
on is using the 

o do you must ensure that the Area/PostIndexing feature is 
the General 

to

Place the cursor in the first field, and then zoom and move the image within 
the image display window until the information relevant to the index field is 
being displayed. Type this information into the index field, and press Enter. 
The cursor will automatically move to the next field, and you can then zoom 
and move the image accord

move to the first field of the next record in the Hitlist, and display the area of 
the image relevant to that field. 

utomatic Indexing 

contents they generate can be foun

CR Indexing 

installed and licensed ScanFile OCR feature is required. How to set up zones 
and/or forms is described in the OCR & Form Recognition chapter. 

dit Index 

changed. Save changes by clicking on the C
information is saved, the Hitlist is updated. Another opti
Return key in the last index field to save index information. The index of the 
document is saved, the Hitlist will be updated, but then ScanFile will jump to 
the next document on the Hitlist and display first image and index information 
of the new document. 
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earching and Viewing 
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The standard document search tools in ScanFile are comprehensive, 
allowing you to perform range searches with AND/OR properties on more 

user-defined index fields created within a folder. 

S
olbox Search 

option, where the fields within the folder d, as well as the 
keywords if used. Just enter your search criteria, and pressing the Search 
b e a 
c  same t list will be 
displayed. 

verview 
Searching for documents within ScanFile is a straightforward and easy task. 

information than just the 

earch 
The primary search screen is available from the Folder to

are presente

utton will produc
riteria. At the

list of all the documents that matched the search 
ime, the first document in the matching 

Wildcard Description 

* Denotes a string of any length (even 0) 

? Denotes any single character 

[x,y,z] Denotes one character , x or y or z ( [list of characters] ) 

[1-5] Denotes a single character of 1,
be smalle

2,3,4 or 5 (first character must 
r than the second) 

 

With wildcards, there is no distinction between uppercase and lowercase. 

 
Examples: 

Wildcard Description 

* Puts all records into the Hitlist 

????? Shows all records with 5 characters in the field selected 

1* Show
100-1

s all records beginning with 1, for example: 1, 11-19, 
99 s.o. 

M??le Shows records with Mable, Mowle etc 
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M*le Shows records with Mable , Mayle, Mole, Mowle, Mule, 
Module etc. 

 

Use of wildcards combi
minimum and targets desired records as closely as possible. Several search 
criteria can be combined to narrow down the results. The search entries are 
l ND combined, ich can be set to produce 
and AND or an OR search. 

Once the search has been performed it will return a Hitlist of the results of 
your search. Both the Hitlist and the Image Display windows can be sized as 

ize of the display on the PC will obviously affect how these 
 shown. The fields within the Folder Toolbox will display the 

indexing information and the assigned keywords for the selected record from 

Ex S
The 
a information,  
searches on any field in the folder. 

ned with other keyword fields reduces the Hitlist to a 

ogical A  apart from keywords, wh

required. The s
windows can be

the Hitlist. The information shown in the Folder Toolbox will change to reflect 
the record selected. 

tended earch 
Extended Search option allows the user to find documents using the 

bove  as well as giving a more user-friendly display for range

 

All the user-defined folder fields can have a range search performed upon 
them, as well as the Scan date and Change date fields. When the search is 
performed, the resultant Hitlist can be displayed with or without the additional 
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f
extended hitlist show who the document was scanned by, the date it was 
scanned on, the name of any user that may have changed that document 
and the date that it was changed on. 

M
 selected index fields for the 

documents you require. To perform this type of search, select Multiple index 
search  Search menu. You can t  search criteria and 
select the folder/library fields that you want to search across. Wildcard 
c n g the 
Search
m  us

Full Text Sea
Selecting Full text search from the Search menu allows you to search the 

om full text recognition. The search screen will appear 
s to search for. Searches can include 

ields, by selecting the View extended Hitlist option. The additions in the 

ultiple Index Search 
This feature allows you to search across

 from the hen enter the

haracters, such ‘*’ a d ‘?’ can be used in the search criteria. Pressin
 button will then display a Hitlist 

atched the criteria
showing all the documents that 

ed. 

rch 

word list resulting fr
allowing you to type in the word or word
multiple words, and can be set to an AND or an OR search on the words 
entered. 

Selecting the page to view is exactly the same as previously, just highlight it 
in the Hitlist and the page will be displayed in the Image window. 
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Option Description 

Detailed Hitlist This option, when selected, will show a Hitlist record for 
each page that contains the word or words searched for. 
When not selected, the Hitlist record will correspond to 
the file the words were found in. 

Please note that a Detailed Hitlist can take a longer 
period of time to be generated due to each page having 
to be identified. 

Show number of 
matches 

With this selected, the number of times the word or words 
occur on the page or in the file will be displayed in the 
Hitlist. 

Phonetic Search With the Phonetic Search option words with a similar 
pronunciation to the searched word will be included in the 
search result. 

 

When you select a record on the Hitlist, by single clicking on it with the 
mouse, the document being displayed will automatically change to show the 
selected file. 

H

columns within the Hitlist can be 
amended. 

itlist 
The Hitlist, which shows the list of documents that matched the search 
criteria can be altered to show the information in a number of ways. The 
column width, and the order of the 
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To alter the column width, m
column, within the column hea

ove the mouse pointer to the right edge of the 
ding, and then hold the left mouse button down 

w Number and/or the Notes columns are 
displayed. This is done from the General Settings Options screen. If from 
this screen you select to save Column Settings, the changes you make will 
be saved, and each time you open a Hitlist, those settings will be used. They 
can be changed at any time, with the new settings then being saved. It is also 
possible to set Alternating Row Colours which will display the rows in 
alternate grey and blue lines instead of just grey. 

Hitlist menu 
rom the Hitlist menu, several options are available that allow you to alter the 

display of the Hitlist information, and to also print, export copy and send 
documents. The Hitlist menu is available by pressing the right mouse button 
anywhere within the Hitlist window. The available options are: 

and drag the column edge to the required width. 

To move a column, hold down the left mouse button anywhere within the 
column heading and then drag the column to the required position. 

You can also select whether the Ro

F

Option Description 

Sort Ascending / Will sort the Hitlist by the data in the column over 
Descending which the right mouse button was clicked. 

Print Hitlist Prints the Hitlist record information to the default 
printer 

Export to file Exports the Hitlist record information to a named file 

Copy to Clipboard Copies the Hitlist record information to the Windows 
Clipboard 

Font Select the font and font size the Hitlist will use. 

Move Moves all pages from a record. 

Copy  pages from a record. Copies all

Paste Pastes previously copied or moved pages into the 
selected record. 

Send to…  selected Hitlist documents to folders, users, e-
mail, route, wallet and export. See below 
Send
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Move to... Moves the selected document into a chosen folder 

Summarise column e 
selected column 
For Numeric Values: Calculates the total of th

Combine rows Either combines marked records or records with 
 the rows to 

be combined will adopt the index information in the 
row that was first selected by the mouse. 

same index information. When marked

Delete  documents Deletes selected records and

Filter image(s) Filters selected records 

OCR Performs Full Text or Zone OCR on the selected 
records and also gives option to Copy OCR text to 
the clipboard. 

Select Tool to select documents 

Close Close the Hitlist menu 

Send to… 
The Send to option from the Hitlist menu allows you to send a document or 

s, which are explained below. selected documents to a variety of destination

Option Description 

ScanFile Folder Sends selected document(s) to another ScanFile Folder. 

Choose Target Exports selected document(s) and index information. 

User Sends selected document(s) to a user’s Personal Hitlist. 

Route Sends selected document(s) to a pre-defined Route. 

Export to file Exports selected document(s) 

E-Mail Attaches selected document(s) to a new email message 

Wallet Creates a Wallet with the selected document(s). 

EMail Wallet Creates a new email and attaches the wallet to this email 
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When selecting the F s PDF ile or Email option, the images can be saved a
format documents. This is enabled within General Settings -> Send to 
email. 

Combine rows 
T bine Rows o
records within the folder or records with the same index information. When 
m e
that was first selected. 

he Com ption on the Hitlist menu either will combine selected 

arked the rows to b  combined will adopt the index information in the row 

It is not possible to undo after performing this action. Please use this option 
with caution. 

OCR 
The OCR Option from the Hitlist menu allows you to either Full text OCR, or 
Zone OCR a single document, or selected documents. If you wish to perform 
batch OCR on all or new documents added to a folder, please use the 
options available from the main OCR menu. 

Option Description 

Full text recognition Performs Full Text OCR on selected documents 

Zone recognition Performs Zone OCR on Page 1 of selected 
documents 

Copy text Copies the OCR’d text from all pages of the document 
in to the Windows clipboard 

Select Option 
When you click on a record on the Hitlist, or use the arrow keys to scroll 
through the records, the current record will be shown with a dark grey 
background. If you wish to select multiple records, to perform a specific task, 
this can be done in a number of ways. The column at the extreme left of the 
Hitlist is used to select records. 

To select a range of records, press the left mouse button in the left column of 
the Hitlist next to the first record to be selected, and then, while holding down 
the Shift key, click on the last record in the range. All records in the range 
will be highlighted in yellow. 
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To select specific records, while holding down the CTRL key, click in the left 
column next to each record you wish to select. 

The Hitlist menu Select option can also be used for record selections. 

Option Description 

All Selects all documents in the Hitlist 

Toggle Inverts selection 

Remove Deselects all documents 

Personal Hitlist 
The Personal Hitlist allows a user to build a list of documents that they may 
wish to refer to on a frequent basis, without the need to keep on searching 
folder and/or libraries for them. The Personal Hitlist is totally independent of 
folders, and therefore any document from any folder may be placed in the 
Personal Hitlist 

It is also possible for one user to send a document to another user’s Personal 
Hitlist. The Personal Hitlist can be accessed in one of two ways, by the 
Personal Hitlist option on the File menu, or by clicking on the icon in the 
bottom right of the Hitlist, it you have a folder or library open. To revert to the 

Personal Hitlist button in 
of the Hitlist. 

folder/library Hitlist, click on the button next to the 
the bottom right 

 

When you display the Personal Hitlist, the Folder toolbox will be shown, 
allowing you to perform searches within the Personal Hitlist. 

To place a document in the Personal Hitlist, highlight the document in the 
standard Hitlist, hold down the left mouse button, and drag it to the Personal 

er, the document can be sent to another user, or to 
tlist. When the Personal Hitlist is displayed, additional 

Hitlist icon. Another method is to right-click on the document and then 
choose Send To User. A list of all the users will be displayed; choose the 
name of the user, and then click OK. 

From the Send To Us
your own Personal Hi
fields to the standard Hitlist are shown, which detail the name of the source 
folder, the name of the user who put the document into the Personal Hitlist, 
and the date the document was added. 
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The additional fields shown on a personal Hitlist are From Folder, From 
U nd Sent On. W
row is shown with a yellow background to
Hitlist. The names of the folder fields  documents may have 
c ifferent fo

You can edit the documents within the Personal Hitlist. The changes do not 
h fect to th only 
saved in the Personal Hitlist. 

Documents placed in a Personal Hitlis
u hey are place nt Routing option, and the user 
selects not to keep a local copy. 

Image Display 
All Documents are shown in the Image Diplay Window. ScanFile has a 
comprehensive set of tools available to change the way displayed images are 
shown. The images can be zoomed, rotated and also fit to the height or width 
of the image window. A file can be paged through by selecting the 
next/previous icons on the toolbar. 

ser a hen the Personal Hitlist is displayed, the Field Name 
 distinguish it from the Standard 

 are not shown, as
ome from d lders with different fields. 

ave any ef e original document in the folder. All changes are 

t will remain until manually deleted, 
nless t d there by the Docume
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Image Display Menu 
Pressing the right mouse button while in the document display window will 
open the document display menu. This allows you to perform actions on the 
page currently displayed. Several options available are the same as offered 
on the Hitlist menu, but will only apply to the displayed page. Please note that 
these options only apply to scanned documents. 

Option Description 

Image information Show file information about displayed image. 

LuraDocument If the image is in Lura Document Format this will allow 
you to switch between the images layers. 

Print/copy area Select an area on the page and print or copy to 
clipboard. 

Convert to… OCR’s image and converts text to chosen file format. 

Create working 
copy 

Opens a secondary display window with the current 
page 

Fit image Sizes the page to fit within the display window 

Fit width Sizes the page to fit the width of the display window 

1:1 display Maximum zoom level 

Change image 
position 

Reorders the page within the document 

OCR Perform full text or zone OCR on the page, or copy 
the page text to the clipboard 
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Move Moves the displayed image to the clipboard ready to 
paste to another record. 

Copy Copies the displayed image to the clipboard ready to 
paste to another record. 

Send to… Send page to another folder, user, export, email and 
wallet. 

Move to… Moves the selected document into a chosen folder 

Close Closes the document display menu 

Electronic Documents 
ScanFile supports the display of over 200 different electronic document file 
formats, such as Microsoft Office documents, Adobe PDF documents, HTML 
pages and graphic format files, such as AutoCAD and CorelDraw. 

and PowerPoint 
r worksheet to 
g window. For 

Word files and text files, these can be scrolled through 
n the right of the viewing window. 

Electronic Document Display Menu 
The options displayed when you right-click on an electronic document will be 
different to those available when viewing a black & white or colour image. 

When viewing multi-page documents such as PDF files 
presentations, the tools to move from page to page, o
worksheet will be displayed at the bottom of the viewin
documents such as 
using the scroll bar o

Optionen Description 

To the clipboard Copies the selection to the Windows clipboard 

Print Prints the currently displayed document 

Display Selects to display the document in Draft. Normal or 
Preview mode 

Options Settings that affect the copying, display and printing of 
documents 

Launch application Launches the documents associated application 
(if available) 
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Viewing Multiple Documents 

 window showing the 
image currently displayed in the standard display window. 

The secondary display windows are totally independent of the standard 
f the folder, and do not relate to a particular file. It is not 
gh a document from a secondary window. 

Up to three secondary image display windows can be opened in addition to 
the standard image display window. To open a secondary display window, 
right click on the image in the standard display window and choose Create 
Working Copy. This will open a secondary display

display window, and o
possible to page throu

The secondary windows will remain open until they are manually closed, or 
ScanFile is closed. 

 

FastPics 
FastPics are thumbnail representations of the pages within a file that can be 
displayed. The page you then want to view can be selected and shown in the 
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Image window. FastPics will also show whether a page was the front or back 
of a double sided document, and you can also tag pages for printing or 
exporting by clicking when the mouse pointer turns to a tick over the FastPic 
image of the page. 

 

Electronic documents, such as word processing files, will show a page with 

t mouse button within the Thumbnail window will open the 

t that 
have been selected. 

the reference EDOC. COLD information pages will have the word COLD. 

FastPics Menu 
Pressing the righ
Thumbnail option menu, which allows you to perform actions on the selected 
pages within the document. The options available are the same as offered on 
the Hitlist menu, but will only apply to the pages within the documen

Option Description 

OCR Full text or zone recognition can be performed on the 
selected pages. The OCR’d text can also be copied to 
the clipboard 

Move Mark the selected pages for moving to another record 
within the folder 
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Copy Copies the selected pages for pasting to another record 
within the folder 

Send to… Selected pages can be sent to another folder, a user, 
exported, or emailed 

Move to... Moves the selected document into a chosen folder 

Select Selects all or no pages, or inverts the current selection 

Close Close the option menu 
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Import 
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Overview 
There are several methods for importing and sending documents to ScanFile 
folders. Documents can also be saved in their original format or alternatively 
converted to TIFF format. This chapter describes different methods of 
importing electronic documents into ScanFile folders. 

T
TIFFWriter is a Windows Printer driver that allows you to 'print' any document 
from any Windows application into a ScanFile folder. Each page will be 
analysed by TIFFWriter and will either be processed as a colour or black & 
white page. If a page has ANY colour content, it will be converted to JPEG 
format. Pages with black & white only content will be converted to 
compressed TIF format.  

TIFFWriter is an option for ScanFile and can be selected for installation 
during the installation process of ScanFile. If the option has not been 
purchased, it will report that it is not licensed. 

To 'print' a document into ScanFile using TIFFWriter, from a Windows 
application, choose the Print option and select the ScanFile TIFFWriter 
printer. From the printer Properties dialogue, the standard options such as 
paper size and orientation single or double sided and resolution can be set. 
Pressing the OK button of the Print dialogue will display the Index screen. 

IFFWriter 
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 can select which folder you want to put the document 
selected the folder, the folder fields (and keywords if 
 will be displayed. You can then type index inform

From this display, you
into. Once you have 
assigned to the folder) ation 
relevant to the document, or you can 
P

Once you have indexe
the Post Index Pool, pr  will put the document in the folder. 

Collect Mode 
TIFFWriter also has 
documents using TIFF

To activate this featur
Index screen has been displayed, press the Collect Mode button. The Index 
display will then change to just show an End Collection button. While this is 
displayed you can print using TIFFWriter from Windows applications without 
having to store each printout at once. 

choose to place the document into the 

d the document, or selected to put the document into 
essing Save

ost Index pool. 

a Collect Mode, which allows you to print multiple 
Writer before saving them to ScanFile folders.  

e, once you have printed the first document and the 
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When you h
button, and

ave finished printing your documents, press the End Collection 
 the screen will return to the standard Index display. You can 

review the documents held with the collection by pressing the Show 
Collection button, which will then open the Collecting pages screen. 

 

You can page through the collected documents using the navigation buttons 
a he p
t  to documen

You can also select to delete pages from a document by displaying the page 
and pressing the Delete image button, or you can delete a whole document 
using the Delete document button. All the documents in the collection will be 

anFile folder document, or they can be placed in the folder 

Explorer Send To 
W in
Windows Explorer pop
after the installation of
Explorer, and then cho

t the bottom of t
he Jump

review window, and select the document to view from 
t drop down list. 

saved to one Sc
Postindex pool. 

ithin Microsoft W dows, a new option will have been added to the 
-up menu: Send To->Electronic Document Support 
 ScanFile. This allows you to highlight files from within 
ose the ScanFile folder you wish to put them into. 
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A e 
r  an
Electronic Document Support 
TIFFWriter, but it handles 
a erted to T
original file format. 

MS Office Integration 
The Office integration tools, which you can select during the installation of 

d Excel 97 and 
Microsoft Word, Excel, Access, PowerPoint and Outlook 2000, XP and 2003. 
The documents will be saved with ScanFile in their original format, unlike 
TIFFWriter which converts the documents to TIFF format.  Two toolbar icons 
w he pro

fter highlighting th
ight mouse button

document(s) you wish to put into ScanFile, press the 
d choose the Send To option. Choosing the ScanFile 

option will display the same dialogue as for 
the documents in a different way. The documents 

re not conv IFF or JPEG, but saved to a ScanFile folder in their 

ScanFile, allow you to file documents to ScanFile folders from within 
Microsoft Office. The tools support Microsoft Word an

ill be added to t grams, and these are shown below. 
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S Fi
The Save to ScanFil
TIFFWriter option an
Index window is the sa

P  Save T
This option performs tw
printer and open the 
ScanFile. 

ScanFile VNP 
rver application allows you to create PCL5 

s in conjunction with the Forms Recognition. 

 

end To Scan le 
e icon will open the Index screen as detailed in the 
d Explorer Send To option. The functionality of the 
me as described in these chapters. 

rint and o ScanFile 
o functions: it will print the document to your selected 

Index screen to allow you to save the document to 

The optional ScanFile VNP se
compatible printers on servers and workstations, which will be directed to 
specific VNP ports, which then takes the printed output, converts it to Group4 
TIF format and saves it to pre-defined locations. 

These files can then be automatically imported into ScanFile using one of the 
Scheduler applications within Remote Services, such as the TIFF Spooler, 
which work
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Overview 
The General Settings screen can be found under Options -> General 
Settings. This allows you to set various options that will affect the quality of 
the displayed image, change how the Hit List is displayed, the main window 
background, and other options that change the Keywords display and image 
print.  

These can be changed at any time whilst using ScanFile, but some options 
such a additional Toolbar will only take effect when ScanFile is 
restarted. 

s Show 

 

Display Mode 
T majority of P
scanned resolution. As  at 200dpi results in 
an image 1664 pixels wide by 2532 pixels in length. This means that if the 
monitor resolution is lower than this, information from the image has to be 
'removed' to be able to display it. This can then result in a loss of quality in 

he vast C monitors are unable to display a document at its 
 an example, an A4 page scanned
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t ge. S
a  that optimum
he displayed ima
pplied so

canFile has three image display modes which can be 
 display quality can be achieved: 

Option Description 

Greyscale Applies 4 levels of greyscale to enhance the displayed 
image 

Bitonal Applies one level of grey to enhance the image 

Black / White Displays the image with no enhancement 

 

When the scanned image is displayed at 1:1 level (one screen pixel for 
each scanned pixel), the Greyscale and Bitonal enhancements are not 
applied. 

T g
t e options a

here are more settin
able lists th

s to influence the image display in ScanFile. Following 
nd gives a brief description: 

Option Description 

Skip back pages When enabled, it will stop the reverse side of a 
double-sided scanned document from being displayed 
when browsing through a file. 

Rotate Back Page If a double-sided page has been scanned, and the 
reverse side of the document is 'upside down' in 
relation to the front side, the option will display the 
reverse side of all files in the correct orientation. 

Hide Annotations Allows you to hide annotations added to a scanned 
page. A pencil symbol in the upper left corner will then 
indicate if there is a hidden annotation belonging to 
the image. 

Use Stellent Viewer Allows you to switch off the display of electronic 
documents with the Stellent Viewer, which can take 
some time if the documents are large. If this viewer is 
not used, the electronic documents will appear as an 
iconic symbol on the image window. With a double 
click on the icon the documents can be displayed in 
their corresponding applications, as long as they are 
installed. 
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Hitlist 
The Hitlist is used to display the results of a document search. Four options 
are available, to alter its appearance and functionality. 

Option Description 

Display Hitlist The records in the Hitlist will be numbered in 
ascending order. This will be in the first column of the 
Hitlist. 

Numbers 

Show Notes Adds lumn to the end of the Hitlist. The Notes 
Column 

 a co
column will show whether records have memos 
applied to them, or that the records are hidden. 
Records with a memo attached will show a 'M' in the 
Notes column. Records hidden for users of the group 
View will have an 'X'. 

Save Column 
settings 

If selected, it allows each user, for each folder they 
have access to, to customize how the Hitlist is 
displayed. The order of the columns in the Hitlist can 
be changed, as well as the column widths. These 
settings will be saved with the folder or library being 
accessed. 

Alternating Row 
Colours 

The setting changes the view of the hitlist from plain 
grey lines to alternating blue and grey lines, this can 
help when viewing similar index information. 

Printing 
Following settings change the print settings of ScanFile: 

Option Description 

Exact Scale Print When printing documents, pages will be printed at the 
exact scale at which they were scanned. This may 
mean that because a printer has a non-printable 
border, the page being printed will not fit onto one A4 
page. When this option is not enabled, ScanFile will 
ensure that an A4 page will fit on a single printed page 
by slightly reducing the size. 
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Automatic 
Orientation  

When enabled, ScanFile will test and select 
automatically which orientation will be best for the 
document to be printed in. 

Ignore Duplex mode When scanning double sided documents, ScanFile 
records whether a stored page was the front or back 
of a page. When printing these to a double-sided 
printer, if the Ignore Duplex mode is disabled, 
ScanFile will print each page as it was scanned - front 
pages will be printed on the front of a sheet, back 
pages will be printed on the back of a sheet. When 
this mode is enabled the pages will be printed in 
straight sequence. 

User, Date and 
Time 

The option will print the name of the computer, the 
user, and the date & time the document was printed at 
the top of each sheet. 

Page numbering When activated, ScanFile prints the page number and 
the total number of pages at the top of each sheet. 

Text Annotations When enabled, text annotations can be printed on a 
e when this option is separate sheet to the imag

selected. 

Print index 
information 

When enabled, index information of a document will 
be printed at the top of each sheet. 

Keyword Search Mode 
If a keyword list has been applied to a folder or library, you can choose how 
this is displayed, and how the keyword search will operate. 

Option Description 

Clear Selected 
Keywords 

If the option is enabled, when the Clear fields button is 
pressed in a folder or library, the currently highlighted 
keywords will be de-selected. If this option is disabled, 
the keywords will remain selected. 

Hide Keyword List When a folder or library is open, this option, when 
selected, will not show the keyword list next to the 
folder or library fields. 
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Display Keywords
as Text 

 Enabled, the keyword list will be shown in list format. 
Otherwise the text will be shown in the cell box. One 
of the features of the Canofile is index cells, which 
work in the same way as keywords. These cells can 
have graphic images scanned into them and can be 
displayed using cells. 

AND / OR When using keywords to search for documents, 
multiple keywords can be selected. By choosing either 
the AND or the OR option, the search will find 
documents that have had ALL the selected keywords 
applied to them, or will find documents that have had 
ANY of the keywords applied to them. 

Personal Hitlist 
st. This list is a way for each 

user to keep a list of documents together so that they do not need to search 
for them each time they wish to view them. Additionally, users can send 
documents to other users' Personal Hitlist. These options allow you to select 
whether users will be informed when another user sends a document to a 
user's list. 

Every user in ScanFile owns a Personal Hitli

Option Description 

No message If the option is selected, no action will be taken if a 
new document appears. A user will have to manually 
check for new documents in their personal hitlist 

At Login Each time a user starts ScanFile, their Personal Hitlist 
will be checked for new messages if the At login
option is selected. 

Time Interval A user's Hitlist can be checked at specific time 
intervals if the Time interval option is selected, and a 
time period entered.  

 

How a user is informed about new documents can be chosen as follows: 

Option Description 

Beep Will play a sound when a new document was found on 
the Personal Hitlist. 
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Message A message will be displayed. 

Auto open With this option selected, the Personal Hitlist will 
automatically open whenever a new document is 
added to it. 

Library Date Format 
T anFile Libraries can be set 
from this option. You can select the order in which the days, months and 

eparator to be used. The formats are: 

DD MM YY 

• MM DD YYYY 
• YY MM DD 

P

he format in which date fields are displayed in Sc

years are displayed as well as the s

• 
• DD MM YYYY 
• MM DD YY 

• YYYY MM DD 
 
Valid separators are '/', '-' and '.'. 

ostindex 
This option sets the mode and storage location for the post index pool. 

Option Description 

Normal Mode There is one post index pool for each ScanFile folder, 
which is physically stored in the subdirectory of each 
ScanFile folder. 

Customized Mode There is one central post index pool for all ScanFile 
folders. The storage location of this central pool can 
be defined by clicking on the button. 

a
simultaneously with a central pool. 

Be aware, that in a network situation this can lead to 
problems, when several people re working 
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S

document is of mixed format – it also contains colour documents or 

end to Email 
This option allows you to select how images are sent to an e-mail message. 
If a document has multiple pages, the images can be put into the new 
message as either single page TIFF files, a multi-page TIFF file or as a PDF 
File. If a 
Word/Excel files – these will be separate to the file(s). This setting also 
affects the Save to File option 

Option Description 

Normal Mode In this case all files that are sent and automatically 
appended to an Email, remain in there original format. 

Multipage TIFF In this mode the system stores single TIFF files in a 

a mixture of file formats, 
it will still collect consecutive TIFF pages and COLD 
pages in one file, all other formats remain in their 
original format. 

multipage TIFF files. In case a document contains 
only TIFF files, one multipage TIFF file is appended to 
the Email. 

In case a document contains 

Group to PDF In this mode pages in TIFF, JPEG and COLD format 
will be converted into a PDF file containing these 
pages as graphics. 

Electronic documents are appended in their original 
format. 

Other Settings 
Option Beschreibung 

Memo note – view / Automatically enters a short entry into the memo of a 
hidden creator document, noting who and when locked or unlocked 

the display of a document. 

Use Global Scanner Activated, all user related scanner settings are ignored 
 scanner settings of user ADMIN will be 
for every folder and user. 

Settings and the
applied 
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Display Inactive 
Buttons 

With this option, you can choose whether buttons on 
the toolbars are displayed or not, dependent on 
whether they are applicable to the function being 
carried out. If this option is not selected, toolbar 
buttons will be greyed out when not applicable. 

Display Additional 
Toolbar will be shown when the option is selected. 

The toolbar along the top of the main ScanFile window 

Hide Tooltips Tool tips are short descriptions of the functions of the 
toolbar buttons. They will be displayed if the mouse 
cursor is left over a toolbar button for a moment. You 
can select whether these are displayed or not by 
enabling/disabling this option. 

Automatic Date in 
Memo field 

Enabled, this will add the date and time of a memo to 
a memo applied to a document. 

Automatically Clear 
Pooldrive 

The option is used by the Prepare CD function. When 
selected, the existing contents of the pool drive will be 
deleted prior to the new information being written to it. 

Area/Post-indexing 
function 

The Are
will allow

a/Post-indexing function, when selected, 
 you to set an area of the image to move and 

zoom to for each field in the folder. This is used during 
index editing, and when indexing documents from the 
Post-Index pool. 

Check Number of When scanning bar-coded documents, the contents of 
Barcodes the barcode can be read during scanning and inserted 

into fields in the folder. You can select whether 
heck if the correct number of barcodes 
 from the document, in relation to the 

number of fields in the folder that have been set with 

ScanFile will c
has been read

the barcode property. 

Auto Index failed 
barcode read with X 

When scanning single page bar-coded documents, if 
ScanFile fails to read a barcode from a page, an 'X' 
can be placed in the folder barcode field, to identify 
the document for later indexing. The Auto Index 
failed barcode read with X option selects this. If this 
option is not selected, and ScanFile was unable to 
read a barcode, scanning will pause and you will be 
prompted to type in the index information into the 
barcode field. 
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Choose Background 
The default display for the main ScanFile window is a grey background. Each 
user can change this by selecting the Choose Background button in the 
General Settings. You can then select whether you wish to choose a colour 
for the background, or to apply an image to the main screen background. 

Colour 
To choose a colour press the Choose Colour button, and the following 
dialogue will be displayed: 

 

You can then choose the colour you wish, and press OK. You will then be 
returned to the Choose background screen shown on the previous page. 

The available colours will be dependent upon the settings of the display 
adaptor. 

Image 
Selecting the Choose Image option will allow you to apply a Bitmap (.BMP) 
file to be displayed in the main image window. The top left corner of the 
selected bitmap will be in the top left corner of the main ScanFile screen. 
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Overview 
By default, each user must log in to ScanFile with a unique user name and 
optional password. Each user created in ScanFile can also be granted or 
denied access to any area or option of ScanFile, ScanFile WebServer and 
ScanFile RemoteStation. 

Groups can also be created to manage the access rights for one or more 
users, inheriting the group’s rights. This is useful, if you have a number of 
users that you wish to assign same rights to. Two types of user groups are 
available for selection, Customised User Groups and Default User Groups, 
which are covered later in this chapter. 

Adding and Editing Users 
To manage user access to ScanFile, select Edit User from the Options 
menu, and the screen below will be displayed 

 

This window lists the currently defined users and groups, and gives 
information about the users that are logged in, what time they logged in and 
the duration they have been logged in the program. 

After the installation you will find here the pre-defined user ADMIN and the 
user groups Admin, Operator, Trustee and View. Here you can select a 
user or group for editing or deletion, or you can add a new user or group. 
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Users/Groups can 
Delete.  

be deleted by selecting the list entry and clicking to button 

The user ADMIN has administration rights. It is important to change the 
default password ADMIN once ScanFile has been set-up. 

The Use login system option allows you to disable the login requirement, so 
that when ScanFile is opened, you will not be asked for a user name and 

 logged in as the Admin user.  password, and will automatically be

Only the user ADMIN or members of the group Administrator have the right 
to enabled/disable the Use login system option. 

Adding a User 
To add a new user, click on the Add User button in the main User 
Management window and the following screen is displayed. 
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You must enter a user name, the password is optional but the use of one is 
recommended. It is also possible to add an e-mail address for the user which 
is used by the RemoteStation client, the use of which is explained later in this 
m

In ScanFile Version 8 a license time limit was added for every user. A user 
license can be freed after a certain amount of time. This prevents users not 
working with the program from blocking a user license as long as they are 

value is zero. The logged in user will only free his 
Every other value larger than zero indicates the time 

hat 

ove. 

With the Open library option, you can select whether the Open tool on the 
left toolbar of the main ScanFile window will open folders or libraries. When 
not selected, the Open Folder list (default setting) will be displayed. When 

isplayed. 

Another option in the user setup is to add an individual user to a group of 

ll available groups. To make the user you are editing a member of 
one of these groups, highlight the group and click on the >> button to add 
that user. Then click on Ok to save. ScanFile will return to the Edit User 
window. 

Also from this window you can select Extended Settings, these are 
e  this ch

Once you have finished with all options, press the OK button, and the user 
c e

Modifying a User 
To edit an existing user's rights highli
a . All o user 
w ce you ha
configuration will be save

anual. 

logged in. The default 
license by logging out. 
in minutes a user is blocking a license before others are able to obtain it. 

You can then select which Folders and Libraries the user has access to. 
Firstly you need to select the location where the Folders or Libraries reside 
and they will then be listed in the top box. To give a user access to a folder or 
library, highlight it in the top list box, and then press the Add button. T
folder or library will then be shown in the bottom list box. To give a user 
access to all the folders or libraries on the selected drive, click on the Add All 
button. 

To remove folders or libraries from the access list, press the Remove All 
button, or select the folder or library, and then press Rem

selected, the Open library list will be d

users. To do this click on the Member of button and a window will appear 
listing a

xplained later in apter.  

onfiguration will be sav d. 

ght the user on the main Users Window 
ptions that are available when creating a new nd select Modify

ill apply. On ve finished this, press the OK button, and the user 
d with any changes made. 
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User blocking 
times in a row, the ScanFile User 

anagement will block this user. The user is not able to log into any ScanFile 

Adding and Editing Groups 
It is possible in ScanFile to define User groups and assign access rights to 
them. Groups are especially useful should you have a number of users that 
you wish to assign same rights to. The administration of access rights is 
easier and more efficient this way. 

If a user is member of more than one group, the user inherits a conjunctive 
combination of all group rights. 

Default User Groups 
Four different levels of User Group have been included by default in 
ScanFile. These can be seen when entering the Edit User area of ScanFile 

at are created by default all have 
m. The levels are: 

Operator: 
rename and post-index. Operator level users cannot create, edit or delete 
folders. 

Admin: Members of ll access in the ScanFile 
system. They can create, edit and delete folders and switch off the 
login/password system.  

To setup a Default user group highlight the group required and click on 
Modify. A window will open, that you know from creating and editing users. 
You can modify the gr

If a user enters an invalid password three 
M
program from that point on. Any user with administrator rights can unblock 
this user. Go to Options-> User management and select the blocked user. 
The button Unblock will be activated. A click on this button will unblock the 
user. 

from the Options menu. The groups th
default security levels associated with the

View: Users added to this group are allowed to retrieve and view data 
records that are not hidden. The users may also view memos but not modify 
them.  

Trustee: Trustees are allowed to edit memos and to hide and reveal index 
records. 

Operators are allowed to scan, edit, and prepare for CD writing, 

the Admin group have fu

oup settings the same way. 
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User Defined Groups 
dditionally to the pre-defined groups you can create new groups and assign 

E

 of functions a user or group will have access to. The 
functions are displayed in groups which mirror the ScanFile menu options. 
Following window will be displayed after you clicked on the Extended 
Settings button: 

A
folder, libraries and menu rights matching your requirements to them. Click 
on New Group and the User Setup window will be displayed. Creating a 
new group requires the same steps as creating a new user. 

xtended Settings 
When creating or editing a user or group you need to assign the rights that 
user or group will have within ScanFile for the folders/libraries they have 
access to. The Extended Settings screen allows you to define exactly which 
functions, or groups

 

To select which options you wish to allow or prohibit for the user or group, 
click on the corresponding tab on the left hand side of the window and then 
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select the options required. A Tick in the checkbox means that option is 
allowed; a blank checkbox will mean that option is prohibited. The selected 
options are then the only options viewable when that user or group member 
logs into ScanFile. Included are three options at the top right hand side of the 
window to allow you to select all or deselect all options listed against one tab 
and to select the default options available for the whole menu listings. 

Use Select All or Deselect All to select/deselect every displayed menu 
option. 

The General Tab at the top left hand side of the window will display the 
Administrator selection next to it. When ticked it will automatically give the 
currently selected user or group full administrator rights to the ScanFile 
program which will limit no options. 

If a user is a member of more than one group, and different settings have 
been applied to these groups, the menu options available to a user will be 
inherited from the group the folder or library the user has open is a member 
of. 

account. ScanFile folder and libraries, protected with this windows user 
account are protected from unauthorized access. 

ScanFile 
To enter a windows user account, open Options -> Edit User and click und 
ScanFile Account. Following window is displayed: 

ScanFile Account 
The ScanFile Account allows you to run ScanFile with a windows user 
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Select . The fields will be enabled. Enter 

fter the restart, ScanFile will run 
under the entered windows user account. 

t -> Settings -> Control Panel -> Administrative Tools -> 
Services e. If the service has already been 
started, please stop the service. With the right mouse button, select Settings 
to display the ScanFile Remote Service Properties. Select the tab Log On 
and change from Local System account to Log On As. Enter the same 
domain account as in ScanFile. Close the settings window and start the 
service. 

 Activate „RunAs Account“
domain, user name and the password. Please enter the password a second 
time to verify your first entry and to avoid mistyping. Save the new settings, 
close all windows and restart ScanFile. A

Remote Service 
If you use the Remote Services, please note that the Windows service has to 
run under the same domain account as ScanFile. 

Display Star
. Go to ScanFile Remote Servic

ScanFile Account doesn’t work with Windows Workgroup accounts. 

Please note that the domain account has to be at least entered as a Power 
user on the machine! 
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Overview 
Further settings are available within ScanFile that allow you to select the 
language ScanFile uses, which barcode to read, and other scanning related 
functions. These are described below. 

Choose language 

e by selecting Choose Language from the 
Options menu. Available languages are: 

When installing ScanFile, you will be asked to select the language required, 
but this can be changed at any tim

Before the new language will take effect, ScanFile must be closed down and 
restarted. 

The Far East languages Japanese, Korean and Chinese are available in 
special setups. 

Choose brightness 
Select Choose brightness from the Options menu to assign predefined 
brightness levels used during scanning to the function keys F2 – F6. Where, 
for example, documents have different background colours, and the scan 
quality using the automatic mode of the scanner is insufficient, manually set 
values can be applied. By pressing the appropriate function key, that 
brightness level will be used during scanning. 

 

Obviously, the setting of these values is a matter of trial and error, but once 
the correct values are found, they need not be changed. This can be 
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overridden by using either the automatic mode or by selecting the brightness 
level using the control on the toolbar. 

A function key value of zero will, when that key is pressed, reactivate the 
scanner's automatic brightness function. 

Setup Filter 
This option enables you to enhance the quality of a scanned page by 
applying predefined filter options, or by creating your own filter settings. 
These settings can be entered when selecting Setup Filter. from the 
Options menu. The filter can be applied either after scanning by selecting 
Edit -> Use Filter, or during scanning if the Use Filter option is selected. 

Up to three user defined filter settings can be created and saved. These can 
then be applied by selecting them from the drop down lists on the right side 
of the Filter Settings wind90ow. Up to six filters (standard or user defined) 
can be applied at any time, and they will be actioned in the order – from top 
to bottom – that they are selected in the drop down lists. 

 

Pre-defined Filters 
There are six pre-defined filters that can be applied, and these are described 
below. 
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Filter Description 

Noise Removal This will remove single black & white pixels 

Horizontal line 
removal 

This will remove horizontal lines 

Vertical Line removal This removes vertical lines 

Brighten page This will brighten the page 

Darken page This darkens the page 

Complete Lines Attempts to complete horizontal & vertical lines 

Softer edge Will soften edges of words and graphics, blending 
them with their surroundings 

Harder edge More clearly defines the edges of graphics, boxes 
and text. 

 

ows the result of filtering using Noise removal. 
black areas and removes isolated white and black 

pixels. As a result the contrast and readability is improved whereas the 
storage space is reduced. 

The following example sh
This filter favours white or 

 

User Defined Filters 
The filter algorithm calculates the brightness of each pixel of an image. With 
black and white images, the brightness value of each pixel is binary: the 
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value of a black pix
allocated to a pixe

el is 1 and of a white pixel 0. The brightness value to be 
l is calculated by the weighted sum of the neighbouring 

pixels. These weighting factors give a ‘coefficient’ to a filter. Since the 
calculated brightness values have to be assigned either to black (1) or white 
(0) a threshold for the decision must be defined. 

1 1 1 

1 1 1 

1 1 1 

 

1 2 1 

2 2 2 

1 2 1 

 

The setting of these p
i.e. the image resolu
Filtering generally en
microfilm images and

Please note, it is poss

Fast Search
With the option Fast

document completely
NEVER turn the Us
settings are correct fo
scanning an example
Image from the Edit 
the filtered image. 

against specific field
substantially reduce s
of index records, wh
indexing. 

To set a binary index
that the folder or libr
menu, and the followi
 a threshold of e.g.3
an isolated white (black) pixel will be automaticall
With his filter parameters and

y
converted to black (white). 
With these parameters and a threshold of 4 thin
interrupted horizontal and vertical lines will be
closed. 
arameters depends on the quality of scanned images, 
tion, the zoom factor and the brightness of the image. 
hances the screen display readability of low contrast 
 reduces storage requirement dramatically. 

ible, with the incorrect use of the filter to turn a scanned 

e documents to be scanned. This can be done by 

 
 Search you can set what are called Binary Indexes 

ary. A binary index can 
libraries with large numbers 

 black, or completely white. When working with filters, 
e Filter function on until you are sure that the filter 
r th

, amending the filter settings, and then selecting Filter 
menu This option will ask for confirmation before saving 

s within a folder or libr
earch times on folders and 
en the search is performed on the field set for binary 

 for a field within a folder or library, first of all make sure 
ary is open. Then select Fast Search from the Edit  
ng screen will be displayed.  
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Select the field to set a binary index on, and then press OK. A binary index 
will then be created for that field. 

A field set with a binary index can adversely affect the import of new 
records. This is especially so when importing folders into libraries. It is 
therefore wise to switch the binary index OFF before importing folders into 
libraries, and then to switch the binary index back on. 
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Overview 
This chapter describes several options which provide information about the 
installed ScanFile version, image information, and information concerning the 
activity that has taken place within folders. 

ScanFile Version 
This utility is available from Help -> Info menu. A window will be displayed, 
giving you the version number of ScanFile, name of the computer and logged 
in user. Additionally you can display system information by clicking on the 
button Info. 

 

Image Information 

The location, and file number within the folder will be displayed, as well as 

When a page from a document is displayed, information about that page can 
be obtained by choosing Image Information from the Help menu.  

such information as resolution, and compressed and uncompressed size. 
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Generate Report 
This feature can be opened by selecting Options -> Generate report. An 
activity report for the actions that have taken place within a folder can be 
generated by clicking on the Generate Report button. This will create a 
summary for each user showing the number of files and pages created or 
modified for the selected date. 

 

After you entered a date and selected the Create a Detailed Report option, 
the file details for each file a user has created or modified will be displayed. 
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You are asked if you want to print the report. In this case, t
to the current default printer and looks like this. 

his will be printed 

Exception Report 
The Exception Report plug-in allows you to search through a field in a folder 
for any gaps or double entries in a numbering sequence. Select Plug-ins -> 
Exception Report to start the program. 

 

 

To select the folder to check, press the Open folder button, and then 
highlight the folder name you wish to search in, and press the OK button. 
Following window will be shown: 

*** Scanning eport (Date: 10.03.2002). #1 *** 
 
   User:                                  Admin 
   Number of files created:                  12 
   Number of Pages scanned:                  12 
   Number of modified files:                  2 
   Number of modified pages:                  2 
   Total files processed:                    14 
   Total pages processed:                    14 
   -------------------------------------------- 
   Total files created:                      12 
   Total pages scanned:                      12 
   Total files modified:                      2 
   Total pages modified:                      2 
   Total files processed:                    14 
   Total pages processed:                    14 
 
   Detailed report follows ... 
 
 
   * Detailed report (Date: 10.03.2002). #2*** 
 
   User: Admin    (Modified files) 
   1               2                    Pages    Time 
   22414           Tom Smith            2        15:00:12 
   22534           Robert Miller        5        15:00:57 
      ------------------------------------------------------ 
 
      End of detailed report 
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The screen allows you to select the start and end values of the numeric 
range to search. You can also select the folder field to search in. Once you 
have entered the information, press the Start button to perform the range 
check. 

If any numbers within the range are found to be missing or double, a file 
called Error.log will be created in the Temp directory. You will be given the 
option to view this file immediately the check has finished. The file will look 
like this: 

 

Folder EXCEPTION 2 has been tested with the following parameters:  

Start value: 1        Stop value: 30        Field #1 

 

The following numbers could not be found: 

1             2             3 

 

The following entries were not unique: 

Range check has been completed with 3 errors. 
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Overview 
Documents containing barcodes can have the value of the barcodes inserted 
into index fields in the folder either during scanning or by performing zoned 
barcode reading as a batch process after scanning. The barcode function is 
an option of ScanFile, and must be purchased to enable it. ScanFile can read 
up to 10 barcodes at a time in either reading mode. 

Barcode Formats 
Five barcode formats are supported by ScanFile. The supported formats are: 

• Code 39 
• Extended 3 of 9 
• 2 of 5 interleaved 
• Codabar 
• Code 128 
 
The barcode type can be selected from Choose Barcode from the Options 
menu. Additionally you can select settings to influence the way ScanFile 
reads barcodes. 

 

The barcode reading module can also recognize a barcode checksum, 
which checks for the validity of the barcode. The checksum number is not 
added to the index field.  
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The Enhance barcode option can improve the reliability of reading barcodes 
from poorly printed documents, such as those produced by dot-matrix 
printers. 

T
r

R
or reading bar-coded documents while scanning, as 

n each page will be inserted into the 

ew index record is created. If there are 
no barcodes on the next page being scanned, this page will be appended to 
the previously created file. The next page to be scanned that contains 
barcodes will create a new index record. 

Folder Configuration 
ScanFile can read up to ten barcodes at one time, and place the results in to 

o and Pick-Up Code 
have the Barcode property applied to them. When documents are scanned 
in to the folder, ScanFile will attempt to read barcodes from the scanned 

he Rotate Barcode 90 ° will read barcodes that are printed down a page, 
ather than across.  

eading while Scanning 
There are two ways f
follows: 

Single page Scanning will create a new index record for each page 
scanned. The contents of the barcode o
barcode fields applied to the folder. 

With Batch Scan, the barcodes can be used as file separators. If a barcode 
is found on a page being scanned, a n

the folder fields. When setting up folders, a property of Barcode can be set 
for each field. In the example below, the fields Serial N

pages, and insert the result into these fields 
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R rcodes
The location of barcodes on a form does 
m f there i
in the first barcode found  the first field in the 
folder with a barcode pr
w

In the example shown below, the data 
N  
field with a barcode proper

eading Ba  
not have to be specified for this 

s more than one barcode on a page, the data held 
on the page will be placed in

ode of reading. I

operty. The data held in the second barcode found 
ill be placed in the second barcode field, and so on. 

held in the first barcode, Project 
the Project No field in the folder, which is the first 
ty. 

umber, will be placed in

 

In General Settings, the following options can be set: 

You can select whether ScanFile will check if the correct number of barcodes 
has been read from the document, in relation to the number of fields in the 
folder that have been set with the barcode property. The Check Number of 

 bar-coded documents, if ScanFile fails to read a 

mpted 

Barcodes option controls this. 

When scanning single page
barcode from a page, an 'X' can be placed in the folder barcode field to 
identify the document for later indexing. The Auto Index failed barcode 
read with X option selects this. If this option is not selected, and ScanFile 
was unable to read a barcode, scanning will pause and you will be pro
to type in the index information into the barcode field. 
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You can also read a documents barcodes after it has been scanned by 
displaying the page, and then pressing the F12 function key or selecting 
Edit -> Recognise barcodes. 

Zone Barcode Reading 
arcodes allows you to specify the field to which the 

 to read barcodes and text from scanned pages at 

Defining Zones 
tup zones and the OCR 

This method of reading b
barcode value will be placed. Up to ten zones can be defined and linked to 
fields in the folder. Zone barcode reading can also be combined with zone 
OCR reading, allowing you
the same time. Please note the ScanFile OCR option is required for this 
feature 

To define the zones, from the OCR menu select Se
image window will be displayed, which will show the first page of the first file 
in the folder, or the currently displayed page from the folder. 

 

You can navigate through the files in the folder by using the available tools 
until the page you wish to define zones is displayed. 

Please note that the zone recognition will always be carried out on the first 
page of a file! 
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To ensure that wh
the zone, you ca

en drawing the zone the correct part of the page is within 
n zoom and rotate the image within the display window. 

Once you have displayed the area of the page you wish to create a zone for, 
right-click on the Indexfields option under All unknown forms, and choose 
Add Field. 

A crosshair cursor will then be displayed in the image window, and by moving 
the cursor to where you want the zone to start, and then holding down the left 
mouse button and moving the mouse, you can define the zone. Releasing 
the left mouse button will then fix the zone, and the Connect zone to screen 
will be displayed. 

 

On this screen, you can select which field within the folder you wish to 
associate the zone with, and you can also specify the content type of the 
zone. In this example the zone is associated with the field ‘Project No.’ with a 
content type of Barcode.’ 

The Recognize draft printing option will assist in reading faded or dot 
matrix printed documents. 

Press OK to return to the Setup Zones window. 

Once you defined a zone, it can be changed at any time. Right-click on the 
field name under Index fields you have two choices: 
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The Edit option
association and

 allows you to resize a zone and also to change the field 
 the content type setting. Zones can be deleted by selecting 

the Delete option 

Ensure that the zones are a little bigger than necessary, to compensate 
small differences between scanned pages. 

After all the zones have been created, press OK to close the Setup zones 
w

Reading Barcodes 
OCR -> Zone recognition and the 

indow. 

To perform the zone recognition, select 
Zone Recognition screen will be displayed: 

 

Selecting the Rea he recognition on all the 
files in the folder. The Read new pages option will perform the recognition 
o  ha

d all pages option will perform t

n the files that ve been added since the last recognition was performed. 

The folder you wish to perform the recognition on must be open. 

Reading Selected Documents and Pages 
The process described above will read all the records within a folder, or the 
records added to the folder since zone recognition was last run. Alternatively, 
you can read single or selected records within a folder. In order to do this, 
use the OCR menu option, which is shown when right-clicking in the Hitlist or 
Image Display window. 
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Overview 
This is an option for ScanFile, and has two methods of OCR. Full Text OCR 
and Zone Recognition. 

Full text recognition creates a searchable database, allowing to find pages of 
documents that specific words appear on. Electronic documents containing 
text and COLD documents can be read as well. Since COLD data are 
already text based, the fulltext reading is very fast and reliable. 

Zone recognition allows you to read area’s of a document, and place the 
result of the OCR in to the folder fields. 

The Forms Recognition option works in conjunction with the OCR zone 
option of ScanFile. Its purpose is to recognise a form by means of defined 
identifiers and then index records with data read from the contents of zones 
that have been created for each form. 

From ScanFile Release 7.3, the Forms Recognition option includes support 
for Job Separation Sheets. Please see the according chapter for information 
on how to configure and use these. 

Full Text Recognition 
Using this option every scanned page of a ScanFile folder is read, and 
recognised words will be saved in a database. This database is attached to 
the folder, and can be searched by anyone who has ScanFile. 

You do NOT need the OCR module to do a Full Text Search; you only 
need the OCR module to perform the recognition in the first place. 

o do a fulltext recognition, open the relevant folder and click to menu  
OCR -> Full text recognition. 

You can select whether you wish to OCR all pages in the folder or just the 
new pages – the pages added since the OCR was last run. 
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Once the recognition starts, the progress can be monitored. The information 
displayed includes a recognition ratio, showing the perceived reliability of the 
process. Obviously, the OCR recognition will have problems with bad quality 
documents, so always ensure that the documents to be OCR’d are of decent 
quality. It is also wise to have scanned them at a minimum of 300x300dpi for 
best results. 

Read Selected Documents or Pages 
The process described above will OCR all the pages within a folder, or the 
pages added to the folder since Full Text OCR was last run. Alternatively, 
you can OCR individual or selected pages of a record, or single or selected 
records within a folder. To OCR records or pages, use the OCR menu option, 
which is shown when right-clicking in the relevant window. 

Window Description 

Hitlist Window Selected record or records 

Image Window Displayed page 

FastPics Window Selected page or pages 

 

Edit Wordlist 
When performing a full text OCR, there will be some words that you would 
not wish to search on, and that just take up space within the OCR database. 
These are generally words such as 'that', 'the', 'and' etc. These can be set to 
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be ignored by adding them to the OCR wordlist, which you can open by 
selecting the Edit wordlist option on the OCR menu. Per default this wordlist 
is empty and no words are filtered from the text read. 

 

 

How to perform a full text search is described in chapter Searching and 
Viewing Documents. 

Zone Recognition 
This method allows you to specify parts of a document to be OCR’d and the 
results put into specific fields within the folder. Up to ten zones can be 
defined and linked to fields in the database. 

Setting up Zones 
To define the zones select Setup Zones from the OCR menu and the zone 
configuration screen will be displayed, showing the first page of the currently 
selected Hitlist. 
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rough the files in the folder by using the available tools, 
r is displayed. Then you define the 

You can navigate th
until the page you wish to define zones fo
z  ones and link them to the index fields of the folder. 

Please note that the zone recognition will always be carried out on the 
FIRST page of a file. 

To ensure that when in the 
zone, you can zoom and rotate the image within the display window. Once 
you have displayed the area of the page you wish to create a zone for, right 
click on Index fields on the OCR tree under the All Unknown Forms branch 
and select .

ge display window, and by 

 slight differences and 
skewing during the scanning process. 

 drawing the zone, the correct part of the page is 

Add Field  

This will then display a crosshair cursor in the ima
moving the cursor to the beginning of the zone, and then holding down the 
mouse button, you can define the zone. 

The example below shows several zones already created. Always ensure 
that there is sufficient space around the zone for
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The zone has been defined once you released the mouse button. Then you 
can relate the zone to a particular field within the folder. 

 

In addition to the Folder fields, a zone can be associated to the Memo for 
each record. From here, you can also specify the characters allowable for 
that field: 

Option Description 

All characters This is to be used if the characters are a 
combination of any keyboard character, including 
punctuation marks etc. 

Numbers & Prices This is to be used if the characters are a 
combination of numbers and currency symbols 
such as £ or $. 

Numbers Only This is to be used if the characters are numerical 
characters only. 

Characters Only This is to be used if the characters are 
alphabetical characters only. 
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Only Uppercase Letters This is to be used if the characters are Uppercase 
alphabetical characters only. 

Only Lowercase Letters This is to be used if the characters are Lowercase 
alphabetical characters only. 

Barcode This is to be used if the characters are Barcodes. 
Please note: the barcode format must be selected 
beforehand in the Options -> Choose Barcode
menu from the main ScanFile Desktop. 

For more information see chapter Barcodes 

Check Mark This is used to determine a number of values on 
forms with check boxes such as
Further information later in this chapter. 

 survey forms. 

Graphical Element (Identifier Only) This is to be used if the identif
is a graphic or picture on a form. This could be 

ier 

used if the identifier is a company logo for 
example. 

 

The selection of the characters allowed for a zone increases the reliability of 
the results of the OCR reading. If you assign Numbers only to a field, the 
amount of possible characters is significantly reduced and a zero will not be 
mistaken as an O. 

xtended 
functions. They are needed for reading barcodes and forms recognition. How 

r. 

The Recognize draft printing option will assist in reading faded or dot 
ents. 

 on the 

d sociation and the content type setting.  

n  on the field name under Index fields 

The options Barcode, Check Mark and Graphical Element are e

to configure and perform Barcode recognition is described in the chapter 
Barcodes. Forms recognition will be described later on in this chapte

matrix printed docum

After a zone is defined, it can be edited any time by right-clicking
corresponding index field and selecting Edit. This allows you to resize a zone 
an  also to change the field as

Zo es can be deleted by right-clicking
and selecting the Delete option 

Ensure that the zone is large enough to compensate size differences of 
scanned pages. 
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When all required zone
started. Just like fulltex

s have been setup, the Zone OCR reading can be 
t OCR reading you can select between Reading All 

ages 

ption will perform the recognition on all the 
n 

the files have been added since the last recognition was performed. 

Read Selected Documents or Pages 
ou

 folder. To OCR records or pages, use the OCR menu option, 
 when right-clicking in the relevant window. 

and Reading New pages. 

All & New P
To perform zone recognition, open a folder and then from the OCR menu, 
select Zone recognition. 

Selecting the Read all pages o
files in the folder. The Read new pages option will perform the recognition o

Y
records within a
which is shown

 can OCR individual or selected pages of a record, or single or selected 

Please note that the zone recognition will always be carried out on the 
FIRST page of a file. 

Forms Recognition 
This option works in conjunction with the OCR zone option of ScanFile. Its 
purpose is to recognise a form by means of defined identifiers and then index 
records with data read from the contents of zones that have been created for 
each form. 

The normal Zone OCR will apply the defined zone from All Unknown Forms 
on each page. This is not a problem if you only have one type of document 
per folder. But if you save different types of documents, you need a different 
set of zones per document. This can be achieved by using the ScanFile 
option Forms Recognition. 

The Forms Recognition allows you to specify identifiers for a document, 
giving ScanFile the opportunity to identify a document and apply the zones 
belonging to a certain document type. Identifiers can be a graphic or picture 
on a form, this could be used if the identifier is a company logo for example, 
or a unique identifier text. 
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Setup Form 
The first part of the forms recognition process is to setup zones on the 

ff  identified and indexed. To do this you must first 
sca begin 
the zone setup select from the OCR menu on the main 

a onfiguration screen will be displayed that 
you

 t click with the right hand mouse button on All 
unk new 
form a name. Once you have named the form it will appear in the OCR tree 
n the right hand side of the setup zones window. Also in this tree, under the 

form name, there will appear three additional options explained below. 

I
After creating a new form, the zones for the index fields can be setup. The 
zones are setup the same way as in the Zone Setup window. For more 

An Identifier is a part of a form that distinguishes it from other forms, so that 
on can tell the difference between two or more types of 
nned in one folder. 

e 
entifier you wish to 

 
h  

 selected to use for that form. 

xt, (in which format 
 

identifier is form number 12345 you select Numbers Only and then type in 

now possible to test the reliability of 
ion by clicking on the Test Recognition button from the 

Setup Zones window. This will give a percentage of recognition next to the 

fiers. The recognition rate of other scanned 
pages of the same form may vary. 

di erent forms that are to be
n in some good examples of the forms to a ScanFile folder. Then to 

Setup Zones 
Sc nFile Desktop and the Forms c

 already know from setting up OCR zones. 

To create a form you must firs
nown Forms and select Add Form. You will be asked to give the 

o

ndex Fields 

information see Setup Zones in this chapter. 

Identifier 

the Forms Recogniti
form that may be sca

To create an identifier, right mouse click on Identifiers and select Add 
Identifier. Similarly to the zone setup, a crosshair will appear over the imag
display, use this crosshair to draw a box around the id
use. Once you release the mouse button a window will appear asking you
w ich identifier you wish to use, the selection you make here depends on the
type of identifier you have

Should you select any of these options, with the exceptions of Barcode, 
Check Mark and Graphical Element, you must type in the Identifier Text box 
at the bottom of the Set ID-Field Properties window the te
you selected) that should be used as the Identifier. For example if the

12345 in the identifier text box.  

Once the identifiers have been setup it is 
the Forms Recognit

name of the form in the OCR tree. The recognition rate will be 100% for the 
form you used to setup the identi
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Keywords 
To speed up retrieval once a form has been recognised and indexed it is 
possible to add Keywords to a form. In order to do this, right mouse click on 
Keywords and select Add Keyword. A keyword list will then appear. Select 

om the list and then click on OK. Repeat this the keyword you wish to add fr
for every keyword you wish to add. 

A keyword list must be added to the folder you are working in before you 
attempt to add keywords to a form setup. 

Che
no his is 

use ch as 
ur s. These values can then be entered, once the Forms 
ecognition has been performed, as index information. 

T
c
h
t Add Zone. 
Draw a box using the crosshair around each checkbox on the form that you 
wish to be recognised. When you release the mouse button you will be 
prompted which field you wish to attribute that zones information to, select 
the zone you wish and then select Check Mark Recognition. To adjust the 
settings for the way the index information is entered click on the ‘...’ box. 
Here you will be given a number of default choices for indexing: 

ck Marks (OMR) 
A ther option of the Forms Recognition is Check Mark Recognition. T

d to determine a number of values on forms with check boxes su
vey forms

R

o set up Check Mark Recognition you must first scan in a form that has 
heckboxes on it to prepare the checkbox zones for recognition. Once you 
ave scanned the page, select OCR -> Setup Zones. From the OCR tree in 
he Setup zones window, right click on index field and select 

Option Description 

Mark Set This setting determines the index information that is 
entered if a checkbox is marked. 

Mark Not Set This setting determines the index information that is 
entered if a checkbox is not marked. 

Separator This setting determines the separator that is entered 
between index values on the hitlist. 

 

The Mark Set and Mark Not Set settings have a number of default entries 
that can be entered as index information: Yes & No, True & False, On & Off 
and Keywords assigned to the folder. However it is possible for you to enter 
your own information to be applied as index data. 
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With selecting a Separator, you specify the character that will separate 
multiple index entries in one index field. You can choose from predefined 
characters, but you also have the possibility to enter your own separator. 

Once this is all set up, perform a zone recognition from the OCR menu and 
the index fields will be filled. 

Properties 
At the very top of the OCR tree in the Setup Zones window you will find 
three options: 

Option Description 

Threshold The threshold is the setting that determines whether a 
forms data will be recognised by the reliability of that 
form. 

Example: 

If the threshold is set to 60 then any forms which have 
matching identifiers will return higher than 60 and be 
recognised, any forms that don’t have matching identifiers 
will score below 60 and be rejected as that form. 

Skew Correction This setting will straighten or un-straighten any images 
that have been scanned to assist with a more successful 
OCR.  

Border Removal This setting will remove or add the borders that may 
appear on a document once it has been scanned. 

 

Forms Database 
The forms with the relevant index field setup and the identifiers are stored in 
a forms database. The default forms database is stored in the ScanFile 
application path as file default.sff. The file is displayed above the OCR tree 
in the window Setup Zones. All changes to the forms database will be saved 
when clicking on OK. 
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Overview 
ScanFile can use job separation sheets during batch scanning, which 
enables several files to be placed in the scanner feeder at the same time with 
the job separation sheets placed between them. The files will be 
automatically divided into documents stored in the ScanFile folder. The job 
separation sheets are user defined. 

Only users with Administrator or Operator status are given permission to 
configure Job Separation Sheets by default. This applies to new installations. 
For upgraded installations, Operators will have to be assigned permission 
manually. Please see the Security chapter. 

Setting Up Job Separation Sheets 
 must first scan a sample of the 

paration sheet open select Setup job 
s
s
w

To create a separation sheet template, you
sheet to a ScanFile Folder. It is good practise to create a Folder to hold all 
the different separations sheets that you wish to use, and from this you can 
create the templates. The templates you create can be applied to any 
ScanFile Folder. 

With the Folder that has the sample se
eparation sheets from the Options menu. This will open the separation 
heet setup screen. You can then select the separation sheet image that you 
ant to create the template for. 
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you must first click with the right hand moTo create a sheet use button on 
J h
n . O
t ht ha
sheet name, there w
identifiers that are used later on to identify the separation sheet. 

ob separation s
ew form a name

ree on the rig

eet and select Add Form. You will be asked to give the 
nce you have named the form it will appear in the Sheet 

nd side of the setup window. Also in this tree, under the 
ill be a sub node called Identifier. This node contains all 

If you do not intend to use more than one job separation sheet, you do not 
need to create a new sheet as described above. You can create the 
Identifier within the default Job separation sheet. 

Identifiers 
An Identifier is used to distinguish the separation sheet from all the other 

ier.. A crosshair will appear over the image display, 
use this crosshair to draw a box around the identifier you wish to use. 

You can create multiple Identifiers by repeating the process described above. 

Once the identifiers  to test the reliability of 
the sheet recognition by clicking on the Test Recognition button from the 
Setup window. This will give a percentage of recognition next to the name of 
the form in the tree. 

documents being scanned. To create an identifier, right-click on Identifiers 
and select Add Identif

 have been setup it is now possible
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D can proc
separation sheets. I
job separation shee
document is closed and a new document is created. Further scanned images 
a e n

Properties 

 

uring a s ess all scanned images are compared with the saved job 
f the threshold is reached, an image is considered to be a 
t and therefore isn’t saved. At the same time the current 

re saved into th ew document. 

Additional settings can be applied to influence the recognition. These 
properties are also used in the Zone OCR setup. The following table gives a
short overview: 

Option Description 

Threshold The threshold is the setting that determines whether a 
sheet will be recognised by the reliability of that sheet. 
When you run the Test Recognition a percentage will be 
marked against the sheet. Example: If the threshold is 
set to 60 then any sheets which have matching 
identifiers will return higher than 60 and be recognised, 
any sheets that don't have matching identifiers will 
score below 60 and be rejected as that sheet. 

Skew Correction The setting will straighten or unstraighten any images 
that have been scanned to assist with a more 
successful recognition. 

Border Removal This setting will remove or add the borders that may 
appear on a document once it has been scanned. 

Using Separation Sheets 

Job separation sheet drop-down list. 

Each ScanFile Folder can have a Job Separation Sheet template associated 
with it. This is configured in the Setup Folder window by selecting the folder 
you wish to configure, go to Extended Settings and select the template to 
use within the 
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O

F

iche, the scanning process is started by 
clicking on either Batch scan or Single page scanning. Using a fiche 
carrier, the Feeder/manual button is ignored. 

(the scanned pages and the relevant data record 

F

S
Single Page scanning will create one record for each page scanned. You can 
switch between manual or automatic mode, dependent on the carrier. 

Fiche Carrier 

he frame 

verview 
The Canon microfilm scanners can be equipped either with a fiche carrier or 
a roll film retrieval FS Controller III. to allow batch scanning of the documents 
held on the film or fiche. 

iche Carrier 
After the user has entered the index information and positioned the fiche 
carrier to the relevant frame on the f

When a scan is finished 
have not yet been saved), the user must decide on the step required next. 

S Controller III 
The FS Controller II is an automatic roll film carrier that can be directly 
controlled from ScanFile. 

ingle Page Scanning – Microfilm 

Using the fiche carrier, you need to go to the page to scan manually. 

• Insert fiche to be scanned 
• Position to the relevant fic
• Set zoom and focus properly 
• Key in index for the frame to be scanned (if not created automatically by 

barcode, counting or duplicating index fields) 
• Start scanning process by clicking on the Single page scanning button 
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FS Controller III 
The FS Controller III can scan in a given number of frames automatically. It 
can be switched between automatic and manual feed. 

• Insert the film to be scanned 
 III to the frame to be scanned (with keyboard or turning 

 

In this mode a user-definable number of frames is scanned automatically and 
arate records. 

Manual Mode 

In this mode the pages are manually selected via the keyboard or knob of the 
FS III and scanned as single page records. 

• Position the FS
knob of FS III)

• Set zoom and focus properly 
• Key in index for the frame to be scanned (if not created automatically by 

barcode, counting or duplicating index fields). 
• Start scan by clicking on the Single page scanning button 
 
Feeder Mode 

saved as sep

With this option automatic indexing (barcode, counting or duplicating fields) 
should be set, as it is not possible to key in index information during the 
scanning process. The index can also be keyed in or edited later. 
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• Group pages by pages (P) 
(scans and stores images as single page records between Page blip 
numbers entered) 

• Group pages by File (F) 
 (scans and stores images as single page records between File blip 
numbers entered) 

• Group pages by File (F und B) 
(scans and stores images as single page records between File-and batch 
blip numbers entered) 

• Group pages by Batch (B) 
(scans and stores images as single page records between Batch blip 
numbers entered) 

 

Be sure that the mode of the FS Controller III for blip reading is set properly. 
For more information on the FS Controller III, see the MS300 / MS350 / 
MS400 / MS500 / MS800 Scanner Configuration manual, or the FS Carrier 
III manual. 

Batch Scanning - Microfilm 
Batch scanning will create a document containing multiple scanned pages. 

Manual Mode 
Using manual mode, the user can scan several images into a batch record 
from roll film. ScanFile will combine these single images to one document. 

• Insert the film to be scanned into the FS Controller III 
• Set roll film retrieval to the first image (by the keyboard or knob of the FS 

III) 
• Set Zoom and focus 
• Key in the index information (if not created automatically by barcode or by 

duplicating or counting fields). 
• Start scanning by clicking on the Batch Scan button. 
• Select next frame if necessary and click on Continue scanning. Repeat 

this step until end of batch 
• To end batch click on Save scanned pages 

Feeder Mode 
In this mode a user-definable number of images is scanned sequentially and 
stored as one batch (document). 
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The index is either entered manually or created automatically using barcode, 
counting or duplicating fields. The index can also be keyed in or edited later. 

The images to be scanned can be selected according to the blips (B,F,P) on 
film: 

• Group pages by pages (P) 
(scans and stores images into one batch between Page blip numbers 
entered) 

• Group pages by File (F) 
(scans and stores images between File blip numbers entered into 
batches) 

• Group pages by File (F und B) 
(scans and stores images between File blip and batch blip numbers 
entered into batches) 

• Group pages by Batch (B) 
(scans and stores images between Batch blip numbers entered into 
batches) 

 

Be sure that the mode for blip recognition on the FS Controller III is set 
properly. For more information on the FS Controller III, see the MS300 / 
MS350 / MS400 / MS500 / MS800 Scanner Configuration manual, or the FS 
Carrier III manual 
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O

routes consist of separate steps, which can vary depending 

ser’s personal hitlist. 

C
Setup can only proceed if the user wishing to setup a Document Route has 

ine a route along which to send 
documents, firstly click on Options and select Document Routing from the 
menu, this will return an Edit Process window. Here you will find a number 

outes that have been defined previously. 
rom here select New and you will be presented with the Create Route 

window. 

In the Create Route window there are a number of options that need to be 
defined to create a working Document Route. Firstly you will need to give the 
route a name and then you can continue onto the next stage. 

verview 
The ScanFile module Document Routing allows you to assign documents to 
pre-defined routes that will direct the documents to users and/or archives in 
an order that has been defined within the route. 

The Document 
on selected options. At each step the document can be assigned to a specific 
folder and/or users. Until each user at each step within a route has performed 
the required action, such as viewing or approving, the document will not 
move onto the next step in the route. 

If a document routed to a user, it will appear in the u

onfiguring Routes 

Administration rights to ScanFile. To def

of options including a list of any r
F
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Steps 
Steps are different stages that can be setup within a route. At each of these 
stages you can define a number of users and/or folders that you wish the 
sent document to go to. When sending to users you can also decide what 
those users do with the document after they view it. 

To create a step, click on the Add button on the right side of the tree view. 
Select a target for the documents. This can be a user or users of the 
ScanFile system and/or ScanFile Folders. 

If you want to select ScanFile users as step target, click on “…” in the user 
section of the target frame. A window Send to user opens. 
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All available ScanFile users are listed here. 

In version 8 a new user has been added to the user selection of the route: 
[Originator]. This user is a placeholder for the creator of a route in the 
running program. This way you can integrate the creator of a route into your 
route setup without knowing the user. 

If you display a route later on in the Remote Service Configuration Tool, you 
will never see the placeholder [Originator] As soon as the creator of a 
route is known to Document Routing, the process will work with the real 
user name. 

Choose the target user or users for the current step. Additionally assign user 
actions that the users have to perform, once a routed document arrived on 
their personal hitlist. Following user actions are available: 

Option Description 

View The View option the user that receives that document 
will only need to view it and confirm the image display 
before it continues on to the next step in the Route 
(Steps are explained above). This is confirmed by 
clicking on the eye symbol on the document. 

Page 182 • Document Routing 



ScanFile User Guide 
Configuring Routes 

Comment This option then t
will be prompted 

he user that receives that document 
to comment on it by means of a 

clipboard button that appears on the document when it is 
viewed. To comment on the document the user must 
click on this button and a text box will appear that should 
be filled out. Any comments they make are attached to 
that document and will continue onto the next step in the 
route. The following users on that Route can then view 
these comments. 

Approve/ Reject The Approve/Reject option allows the user two 
possibilities. He can approve or reject the document by 
clicking on the Approve or Reject button displayed in 
the image window. Where the document is sent to, 
depending on the choice, will be selected when setting 
up a Route. 

View (Password) This option is identical to the action View, but this will 
force the user to enter their ScanFile password to signify 
that the step has been completed. 

Comment 
(Password) 

This option is identical to the option Comment, but this 
will force the user to enter their ScanFile password to 
signify that the step has been completed. 

Approve/Reject 
(Password) 

This option is identical to the Approve/Reject 
(password) option, but this will force the user to enter 

 that the step has been their ScanFile password to signify
completed. 

 

If you select the Approve/Reject or Approve/Reject (Password) option, 
there are three actions that can be set to take place when the user either 
accepts or rejects the document. You can apply the action in the window 
Action, opening directly after you chose Approve/Reject. 
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Following options are selectable to define the action when the user approves 
or rejects a document: 

Option Description 

Continue This option will mean that the document will continue to 
the next step of the defined route. 

Jump to The document will jump to the specified step, bypassing 
steps if required. The step you wish the document to 
jump to must be selected here. 

Continue with The document will continue on a different predefined 
Route from the beginning. This route must also be 
selected here. 

Confirm your selected action by clicking on OK and ScanFile returns to the 
Send to user window. Repeat this for every user in one step, whose action is 
different than View. Return to the window Create Route by clicking on OK.  

Before a document can proceed to the next step, the user or users assigned 
t
m
c
assigned to them. This can be done by ensuring the All users must perform 
action option is not selected. If this option is selected, all users assigned to a 
step must perform their action before the document can progress. 

able Folders opens. In 
here are folders that have been previously set up on the system. Select the 

Another option of Document Routing is the Timeout Action; this option 

er on step 

his would mean that User Two does 
not get to view that document until it has eventually been viewed by User 

o a step must perform the action assigned to them. If you have assigned 
ore than one user to a step on the route, you can select that the document 

an proceed to the next step if one of the users has performed the action 

Send To Folders 

If you want to select ScanFile Folders as step target, click on “…” in the 
Folder section of the target frame. A window Avail

target folder or folders for the current step. Once you have selected one or 
more folders from the list click on OK and they will be entered as part of a 
step on the route in the window Create Route. 

Timeout Action 

determines the length of time a Document is retained within a single step of a 
Route. This can be extremely useful, for example: 

A route has been setup with one user on step one and another us
two. A document is sent to that route by a third party user however, User One 
is not available to view the document. T

One. 
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To avoid this happening  you need to define a time limit that a document can 
s the Route. By selecting the Use Timeout Action it is 

tion Time Limit, this can be done in units of Days 
nd Hours in the boxes on the Create Route window. There are 3 directions 

re ide in one step of 
possible to define a Reten
a
available, per step that a document could take should the retention time have 
elapsed: 

Option Description 

Route to Next Step Once the defined Retention Time has elapsed it will 
move the Document onto the next step of the Route. If 
there is no next step defined then the document will 
remain at that step until it is viewed. 

Route to Previous 
Step 

Once the defined Retentio
move the Document back to 

n Time has elapsed it will 
the step before it. If there 

p defined then the document will 
remain at that step until it is viewed. 
is no previous ste

Route To Sender Once the defined Retention Time has elapsed the 
cument will be moved into the personal hitlist of the 
r who originally sent that document to the Route. 

do
use

 

The Timeout Action is only valid if that particular step of the Route 
includes a user. Timeout Actions do not have any bearing on Folders as 
targets.  

After creation of one step, click on the Save button. The step will appear as a 
tree node in the tree view of the Create Route window. In this tree view you 
can see all steps and their assigned targets and user actions. If you wish to 
edit a step, select the node and edit its settings. You can discard your 
changes by clicking on Cancel. If you click on Save, your changes will be 

 of the steps 
Delete

Other Routing Options 
Selecting Options -> Document Routing opens the Edit process window. 
Apart from setting up Routes there are two settings for the general Routing 
process. 

saved and the tree view is updated. If you wish to remove any
defined, highlight the required step and click on the  button. 
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Save Job Reports 
Details of the actions performed by the Document routing can be saved to a 

x  information on all the steps for each defined route. 
u me and location for this log file in the Save job 

l ted Jobs 

File after a specified time limit 
entered in the box on the main Document Routing window. If this information 

 not cleared additional hard drive space can be taken up by this, usually 
unwanted, information. 

Setting the Clear Completed Jobs time to zero will retain that information 
until a higher value is entered. 

Active Route Log 
The Active Route Log is a report of all Document Route actions that are 
currently in progress, listed in here you will find useful information regarding 
the current stages of a document that has been sent to a Route: 

Route Name, the name of the user who sent the document to the Route, the 
Status of the document, the active user or user who currently needs to action 
that document, the time it was sent to that Route, and the time remaining 
before the next step of that route times out. 

To view any of the Route information in more detail, highlight the required 
Route and click on View. This will give a more in depth history of actions that 
have been progressed for each document, and will also show the document 
index details and any comments that were made on the document. 

Sending to a Route 
Assigning a document to a route is done by clicking with the right mouse 
button on the document(s) you wish to send in the Hitlist and select Send To 
Route. This will display a window listing all Routes that have previously been 
setup. Select the Route you wish to send the documents on and confirm you 
selection by clicking on OK. 

te t file. This will record
Yo  can specify the na
reports in field. 

C ear Comple
In addition to the Timeout Action there is another time related option. 
Database, Image and instruction information is kept within ScanFile when a 
document is sent to a Route, even when the Route has been completed and 
the document has reached its final destination. Clear Completed Jobs will 
clear all of this information from within Scan

is
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Also on this window is an option called Split Records, this is used if multiple 
documents are being sent to the Route. If selected, each document will be 
treated separately on the route. All required user actions along the route will 
be requested independently from each document. 

If Split Records is not selected then multiple documents that are being sent 
will be batched together, and treated as one route task. All required user 
actions along the route will only take effect, when all documents have been 
processed. 

Viewing Routed Documents 
Any documents sent to a route will appear in users Personal Hitlist. They can 
be identified by the name of the sender being SFROUTE'. 

Local Copy 
By default, once the action has been performed and the document 
progresses to the next step of the route, it will be deleted from the Personal 

however choose to keep a copy of the document by clicking 
cal copy checkbox before performing the action. This copy 

will not be updated with the changes done to the document while it is sent 
along the route. 

Actions 
When the document is displayed, action icons will appear corresponding to 
the actions assigned for that step of the route. The three actions are View, 
Comment and Approve/Reject. 

For Comment and Approve/Reject actions, a window will pop up to allow 
you to add comments concerning the document. The comments associated 
with a document can be view by pressing the Route icon, which is displayed 
in the top right corner of the document display window. 

Before the document can progress to the next step of the route, the action 
assigned to the user must be performed. To do this, click on the action icon. 

Hitlist. You can 
on the Keep lo
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Routing Service 
The Document Routing Service is part of the ScanFile Remote Services. Its 
main task is to monitor the current routes and to send on documents, 
depending on the settings of these routes. 

The Document Routing Service in ScanFile Remote Services must be 
running to allow the Documents to move from step to step within a Route. 
This is described in the Remote Services chapter. 

For more information, please refer to the corresponding chapter in this guide. 

 

Page 188 • Document Routing 



ScanFile User Guide 
Routing Service 

Printing, Email and Export 

Printing, Email and Export • Page 189 



ScanFile User Guide 
Overview 

Overview 
ScanFile has comprehensive facilities for the printing of scanned documents 
as well as for exporting both indexes and documents for use outside of 
ScanFile. 

Printing 
With ScanFile, you can choose from several options for printing: 

• Currently displayed page of a document 
• All pages in the selected document 
• Range of pages from the selected document 
• Selected pages from the selected document 
• Selected documents  
• Hitlist 
• Audit Trail Events 
 

ctions depending on which 

Selecting the Print Image option from the File menu allows you to print the 
currently selected file, or a range of pages from the currently selected file. It 
also gives you the opportunity to choose the printer you wish to print to. 

The Print button in the toolbar has different fun
window is active at the time it is pressed. 

Window Action 

Image Window Displayed image is printed 

Hitlist Window The selected hitlist documents are printed 

Fastpic Window The selected images from the current document are 
printed 

 

Selecting Print Hitlist from the File menu will print the Hitlist. 

 

When printing scanned images, various options are available. These can 
be selected from the General Settings dialogue. The options and their 
explanations are listed in the chapter General Settings. 
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E
enu of the hitlist to create an email with the selected 

document attached. Therefore right-click on a document in ScanFile, choose 
> E-mail option and ScanFile opens a new message window in the 
lt e-mail software, and attaches the selected document(s). 

E
It is possible to export the contents of a folder for use with other systems. An 
ASCII file will be created with the index information and references to the 
exported image files. 

Selecting Export Folder from the File menu will display the following 
dialogue: 

mail 
Use the pop-up m

Send To -
PC's defau

Scanned, multi-page documents can be converted to single page Tiff, multi-
page Tiff’s or PDF file, depending upon the option selected in General 
Settings. Electronic documents will be copied in their native format. 

xport 
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Before starting the d to 
must be selected. The number of TIFF images to be written to each directory 
c et, as 
the character withi
comma is normally used for this purpose. Multi-page documents can be 
exported as either a multi-page TIFF file, or separate TIFF files for each page 
of a document. 

I rd
document index. If a document is not connected to a keyword, the index will 
be left empty (““). If more than one keyword is assigned to a document, the 
d e
every time with a different one as additional index. 

ressing the OK button starts the Export. Subdirectories called ASCII_xx will 

 images. 

The result is shown in the example below.

 export, the directory the information will be exporte

an also be s well as the field delimiter for the data file. The delimiter is 
n a record line used to separate the index records. A 

f Export keywo s is selected, ScanFile will export keywords as additional 

ocument will be xported as many times as it has keywords assigned to, 

P
be created off the selected export directory, and these will contain the TIFF 
images. The number of TIFF images in each directory is dictated by the 
Images per Folder parameter. Each subdirectory created will also have an 
INDEX.DAT file, which holds the index information related to the
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O

ile folder and viewed from either the folder or a library. Explained 
earlier in this Guide were TIFFWriter and the Send to ScanFile options. This 
chapter describes the import features available. There are three choices for 

• Files only 

I
from the File menu, and the import screen will be 

verview 
Documents and index information can be imported or sent to a ScanFile 
folder in a number of ways and formats. Any format of document can be held 
in a ScanF

importing: 

• Files and Index information 
• Index information only 

mport Files 
Select Import -> Files 
shown. 

 

Any format file can be sel
where the files to be import

ected for import,.Select the drive and directory 
ed are, highlight the file or files to be imported, 

and then click on OK. The files will then be placed in the Postindex pool. 
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In

Document Name, Document 

be imported to the appropriate records. 
To open the Import select the File –> Import -> Index menu. 

dex Information 
The Import index function is used to fill index records in existing folder 
documents with additional information. As an example, bar-coded documents 
may have been scanned, with the barcode representing a Project Number. 
An external can have that number in it plus the 
No etc. The Project Number can be set to be the Connect field, and the 
additional index information will then 

 

The example text file shows 10 records, with the index information within the 
records being delimited by commas. The first field is the Project Number – 
the Connect field – which already exists in the folder. The Import will use this 
to search for matching records, and then fill the other folder fields with the 
additional information. 

From the File menu, select Import Index, and then select the data file that 
holds the index information, the screen above will be shown. The Folder 
fields will be displayed on the left, and the fields from the import file can be 
matched to these. It is very important that the No. of fields, parameter is 
correctly set, as well as any field separators and delimiters. Once the import 
has been set up, the import can be started by pressing the OK button. 
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F
x information can be directly imported into a 

ScanFile folder. An ASCII file may hold the index details for project 

ex records created 
automatically, and the images imported and associated with the correct index 

iles & Index Information 
Files and their associated inde

information, and will also hold references as to which TIFF files belong to a 
particular record. This can be read into ScanFile, the ind

record. 

 

This option is also used to import index information with no associated files. 
This allows you to create 0 page records in a folder to add documents to at 
a later date. 

File Format 
It is very important when importing index information from a text file that the 
index records are formatted correctly within that file. 

Firstly, each record must start on a new
e

 line within the text file. This can be 
asily verified by opening the file in a text viewer such as Notepad. When 

exporting data from other applications, most of the applications will 
automatically start a new record on a new line. They do this by adding the 
CR (Carriage Return) and LF (Line Feed) ASCII characters to the end of 
each record. 
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The format of each record within the import file is also very important. When 
importing multiple index fields into each record, ScanFile expects each field’s 
index information to be separated by a character. The most common 
character used for this is a comma (,). See the following example: 

12345,Project XY,Phase X,Customer Y 

The comma (,) separates the four fields: 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X 
• Field #4: Customer Y 
 
These four fields can be assigned to the index fields in the import folder. The 
options No. of fields and Field separator must be filled with a 4 and a 
comma (,) so that ScanFile is able to import the index information correctly. 
As a Field separator every character that is not part of the index information 
itself can be used. If the Field separator occurs in the index information a 
Field delimiter can must be added to separate the fields. The Field 
delimiter must be the first and the last character in each field. If so all 
characters between the field delimiter characters, even a character that is 

dex information. 

er Y “ 

The comma (,) separates the four fields: 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X,Y 
• Field #4: Customer Y 
 
The example uses a quote sign (“) as Field delimiter. Without the Field 
delimiter the comma (,) in field #3 would also be interpreted as Field 
separator and the field content would be divided into two different fields. 

In addition to the import of index information ScanFile is also able to import 
index information and related files from. In this case the index file must 
contain the index information and the document filenames. All files must be 
located in the same path as the index file itself, or have the path to the file 
location as part of the filename. The following example shows a line of an 
import file to import index information and their related files. 

“12345 “,“Project XY“,“Phase X,Y“,“Customer Y“,”01.tif”,”02.xls” 

used as Field separator, will be used as in

“12345 “,“Project XY“,“Phase X,Y“,“Custom
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ScanFile would find the following information: 

File #2: 02.xls 

tow related files. The file 
ed to the chosen folder. When 

p  multi-page Group 4 TIFF 

e TIFF file. 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X,Y 
• Field #4: Customer Y 
•  
• File #1: 01.tif 
• 
 
The example shows the index information and 
named 01.tif is a TIFF file that is directly import

orting TIFF files, these can be either single orim
files. The second file named 02.xls is a Excel file that will be appended to the 
document after the last page of th
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O

into ScanFile folders. This data 
n bined with scanned or other imported documentation to give a 
m rehensive document storage system. 

e ule will take the spool data, such as mainframe-generated 
utomatically create index records to the appropriate pages. 

his manual explains the setup and import procedures required by the COLD 
nd details the supported import spool data formats. 

Supported File Formats 
A spool file can contain many thousands of pages of data, which must be 
d into pages

Generally, spool 
other formats are 

•
• COM 1 Files 
•  2 Files 
• 
 
Spool files will have the 'FF' character 
the file. 

COM 1 files use the first column of the f
pecify page breaks and other formatting. 

se the first 4 columns to control page breaks. 

The ScanFile COLD module supports the above formats, although other 
format files can be imported by specifying 
p eak charac

verview 
The optional ScanFile COLD (Computer Output to Laser-Disc) module allows 
the import of computer generated spool data 
ca  be com
co plete, comp

Th  COLD mod
invoices, and a

T
module, a

ivided  and have index data associated with those pages. 

data can be divided into the following formats, although 
in use: 

 Spool Files 

 COM
Text Files 

(Hex OC) to signify page breaks within 

ile (the first character in each line) to 
s

COM 2 files u

Text files generally should have a fixed number of lines allocated for each 
page. 

other data within the file to act as 
age br ters. 

Page 200 • COLD 



ScanFile User Guide 
The Import Template 

Th or
or each spool data format, an import template must be created. The 

pe, the indexing information location and 
y formatting such as overlays and font, font size and line and 

 Import template, choose the COLD -> Open/Import and the 
Template list will be displayed. 

e Imp t Template 
F
template specifies the import file ty
the displa
character spacing. 

Once a template has been created, it can be used to import spool data from 
any file that has the same format as the file the template was created from. 

Creating a Template 
To create an

 

From this screen, select New Template, and you will then be asked to give a 
name to the template. This name should be associated with the data format 
being imported. Type in the name you wish to give to the template, press the 
OK button, and you will then be asked to choose the spool file to be used to 
design the template. 

By default any file with the extensions *.TXT, *.DAT and *.ASC will be listed, 
although if the file has a different extension, choose the ALL Files option 
from the List of File Types drop-down list. Select the spool file you wish to 
use from the list and then click on the OK button. 

Once the spool file has been chosen, the data will be displayed within an 
Edit Template window within ScanFile. This window is where all the 
parameters associated with the template can be set. 

COLD • Page 201 



ScanFile User Guide 
The Import Template 

 

If the spool file has no page break character (Hex 0c) within it, a message 
stating this will be displayed. If this is the case, the file must contain a fixed 
number of lines per page, or must have a unique value within it other than 
Hex 0c that can be used to signify a page break. 

 
Pag

Also, the Hex 0c filters must be removed. See the section on Filters for 
information on this. 

Spool File Type 
To ensure that the COLD module pages the file correctly, choose Edit ->

e Settings within the Edit templates window, and the Setup screen will 
be displayed. 
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From this screen you can attempt to automatically detect the file type by 
pressing the Auto Detect button. This option will detect whether the file is a 

and show the file type accordingly. If it is not one of 
ill attempt to find a non-standard page break within 

the file. If it cannot do this, the parameters must be set manually. In the 
Lines per page field, specify the number of fixed lines allocated to each 
page within the spool file. 

To set the options chosen, either manually or by the Auto Detect function, 
click the Apply button, and then choose OK. You will then return to the Edit 
template window. 

Filters 
Filters are used to specify the actions to be carried out, when a certain 
character or sequence of characters within the spool file is encountered. By 
default, a page break filter is created for each new template. For spool files 
with no page break characters, these must be removed. To do this, choose 
Edit -> Edit Filter within the Edit templates window. 

The Filter parameters screen will be displayed, showing the pre defined 
page break filters. 

COM1 or COM2 format, 
those, the Auto Detect w
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Highlighting a filter and pressing the Delete button will remove it.  

ssed by clicking in the CharOption column in 
the row of the sequence you wish to set an option for. A drop down list will 
become available, allowing you to select the required option. 

The options that can be performed against a sequence of characters are 
shown below, and can be acce

Option Description 

Cut Out This option will remove the selected sequence, and 
move any text to the right of the sequence, to the left 

Blank Out This will replace the selected sequence with spaces 

Page Start This action can be set to identify the selected sequence 
of characters as the start of a new page. This is useful if 
the import file has no identifiable page break character, 
and does not have a fixed number of lines per page 

0 line feeds This option is normally used with COM1 and COM2 
format files. The sequence selected will not evoke any 
line feed. 

One line feed The sequence selected will be replaced by one line feed 

Two line feeds The sequence selected will be replaced by two line 
feeds 

Three line feeds The sequence sele
feeds 

cted will be replaced by three line 
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Additionally to the CharOption the Valid Range drop down list is used to 
identify the area of the import file that the filter should look and act upon the 
selected sequence. The options available are described below. 

Option Description 

This Position Will only perform the action upon the sequence at the 
position in the import file where the text was highlighted 

Start to Here Will perform the Action from the start of the import file, to 
the selected sequences position in the file 

Here to End Will perform the action from the location of the selected 
sequence to the end of the file 

Entire Text Will perform the action upon the entire file 

 

Once the Filter Parameters have been set, the spool data should be 
displayed, and you should be able to page through the file correctly. 

Some spool files may contain other information such as printer control codes 
that are used to specify whether text should be in bold or underlined. These 
codes will be shown in different ways in the spool file, but they should not be 
shown when the file is imported into ScanFile. 

n the spool file at the start and end 

w, and 
then choosing New Filter from the displayed menu. From the CharOption 
column within the Filter Parameters window, the Cut out option can be 

Repeat this for every control code. 

To add an index field record, highlight the text to be used for indexing in the 
Edit Template window, and a pop-up menu will be displayed. Choosing the 

As an example, the code '#BLD' is shown i
of a piece of text. This signifies that when printed, that text should be printed 
in Bold. This code needs to be hidden or removed when the file is imported, 
and the filter can be used for this purpose. 

This can be done by highlighting the code in the Edit template windo

chosen. Select Entire Text from the Valid Range drop down list to filter the 
code from the text. 

Index Fields 
The COLD module, when importing the spool data into a ScanFile folder will 
not only import the page information, but will also create the index records 
associated with the pages. To do this, the location of the index information on 
the spool data page must be specified. 
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New Index Field option then allows you to enter the index field name. This 
can be repeated for each index field you wish to create. 

A very important point is that the location of the index data MUST be 
consistent across each page of the spool data file, the location of the index 
data cannot be varied from page to page. 

The index fields MUST be created in the same order as the fields within the 
folder the data is to be imported to. 

 

To view the fields created, choose the Edit -> Edit Field option from the 
menu. From this screen, you can see exactly what has been specified for 
each index field, and this information can be edited. For example, you may 
not have highlighted sufficient characters for a name field, and that can be 
adjusted from this window. 

Some spool data files may contain multi-page records, such as an invoice 
being continued over several pages. These pages can be grouped into one 
index record in the ScanFile folder, by setting the Group Pages if option. 
This will be displayed if the page grouping data in the Edit Template window 
is highlighted, and the Connect pages option is selected from the pop-up 
menu.  

Any relevant data can be used to group pages together, such as an 
increasing page number, or the same data on following pages as on the first 
page. The required option can be selected by choosing from the drop down 
list, and the available options are: 

• No grouping 
• Increasing Number 
• Empty on next page 
• Not empty on next page 
• As preceding page 
 
Once these options have been set, the raw data is ready to be imported into 
ScanFile. 

Importing Spool Data 
Before you can import spool file data into ScanFile, the folder the data is to 
be imported into must be open. It is also important that the fields specified in 
the import template are the same as in the folder, and in the same order. If 
this is the case, choose COLD -> Open/Import, and the Open Template 
dialogue will be displayed. Select the template to be used for the import, 
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ensuring that it is the correct template for the open folder, and then press the 
Start Import button. You will then be asked to select the spool data file to be 
imported into the folder. 

Select the correct spool file for the template and the import screen will 
appear. 

 

During the import the screen displays all index fields defined for the current 
template and their processed contents, the amount of imported records and 
the total amount of imported pages. Pressing the Start Import button will start 
the import. 

Viewing COLD Data 
Searching for and viewing COLD data is achieved in the same way as for any 
other document stored in a ScanFile folder. A folder may be opened, the 
search criteria entered, the Search button pressed. A Hitlist will then be 
displayed, and the first document shown in the image window. 

All the standard image rotate and zoom controls will function with COLD 
data. 
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Page Settings 
It may be that the default paper size, font and font size and line and character 
spacing are incorrect for the spool data being imported. These can be 
amended in one of two locations. 

After the spool data has been imported, choosing General Settings from the 
COLD menu will display the Settings dialogue. 

When creating or editing a template, choosing the Graphic option from the 
View menu will display the spool data in graphic format. This will then allow 
you to edit the page settings for the spool data. 

In the Edit Template window, select Page Settings from the Edit menu, and 
the Settings screen will be displayed 

If the Graphic option is not selected, all options apart from the file type 
selection options will be greyed out. Whilst the Graphic option is selected, 
the correct paper size can be set, as well as the font and font size to be used 
for displaying the data. 

Please note that although any font can be selected, even TrueType fonts, 
t. 

OEM Chartable, this, when checked, ignores generally foreign characters 
from a COLD template, E.g. ã,é,ì,ö,û. If you wish these characters to be 
recognized then uncheck this option. 

Overlays 
When spool data - such as invoices - are printed, they are usually printed 
onto prepared forms with named columns and data headings. Without these 
forms, the data can be quite hard to read, and can easily mislead. For this 
type of spool data, the ScanFile COLD module allows a scanned image of 
the form to be specified for a template, and when the imported data is 
displayed, it will be overlaid on the image of the form. Two separate overlays 
can be specified, for the first page of a record, and for any subsequent pages 
of a record. If it is the same form for every page the Following pages field 
can be left blank. 

When using overlays, it is critical that the text will line up in the correct 
position relative to the overlay form. It is therefore important that an original 
form is scanned to be used for the overlay, and that this is not scaled in any 
way. The form can be scanned using ScanFile or any other program. The 
image file of the scanned page can be used in ScanFile as an overlay.  

most spool data is printed in a fixed width fon

Also in the pages settings dialogue you will find a checkbox option called 

Page 208 • COLD 



ScanFile User Guide 
Imported Files 

The other options 
Firstly, adjust the linefeed 

that can affect the alignment are the Overlay Settings. 
setting, and this will normally ensure that – if the 

zontal and Vertical settings move the page of text x number of 

n overlaid on a scanned image is shown 
below. 

correct font and font size have been selected - the data will fit the overlay. If 
any other adjustments need to be done, the horizontal and vertical 
adjustment options can be used for minute changes to the character 
positions. 

The Linefeed setting adjusts the number of pixels between each line of text. 

The Hori
pixels left, right, up or down. 

After changing any of these settings, by pressing the Apply button, you 
should immediately see the effect the settings have had. 

An example of COLD informatio

 

I
For each folder, a list of the files imported into that folder, and the name of 

mported Files 

the template used to import the data can be displayed by choosing the List 
Imported files from the COLD menu while the folder is open. 
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Overview 
LuraDocument®, an option of ScanFile, is a document compression 
procedure which preserves text legibility together with high visual and colour 
quality. The basis of the LuraDocument procedure is the analysis and 
segmentation of documents. 

Mixed documents are segmented to generate the following three images: 

• a binary image containing text 
• a foreground image preserving the text colour  
• a background image with the text removed 
 
The three images are then individually compressed using the most 
appropriate efficient techniques. 

LuraDocument is particularly suited to documents scanned at a resolution of 
300 dpi or higher, containing large image regions together with text. 

The separation stage uses the segmentation to separate the document into 
three images of different resolutions:  

The text is removed from the original document to generate a colour or 
greyscale image containing the image regions and text background. This 
image is compressed using a specially adapted version of the "LuraWave" 
wavelet based image coder. The removal of text regions - extremely difficult 
structures for image coders to compress - enables a significantly higher 
compression performance to be achieved. 

The removal of image regions from the Bitonal text image makes high 
compression rates possible. The Bitonal text image is compressed with a 
LuraTech developed context-based coder, generating compressed data 
10%-40% smaller than that achieved by CCITT Fax Group 4. 

A third image, containing colour for text regions, is generated and 
compressed using the "LuraWave" wavelet coder. The Bitonal text image is 
compressed with the original document resolution while the background and 
text colour images are coded with a reduced resolution. 

Selecting LuraDocument 
LuraDocument can be made the default image compression format for a 
folder when creating or editing a folder. Select File -> Setup Folders and go 
to the Extended settings tab. On the tab you find the Import compression 
format field, which represents the default image compression format of the 
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folder. You can choose between LuraDocument or TIFF G4/JTIF format. 
This can be changed any time. 

Additionally you can use the LuraDocument compression within the scanner 
setup for the DR-5020/5080c, DR-3060/3080c, DR-5060F and MS-800. 

LuraDocument Settings 
The settings can be viewed and amended from two places in ScanFile. In 
Scanner Setup for the Canon DR-5020/5080c, DR-3060/3080c, DR-5060F 
and MS-800 when you select LuraDocument as the compression format, a 
tool icon will be displayed. Clicking on that will display the settings screen. In 
addition, you can select it from the Options -> Compression menu. With 
either option, the configuration screen will be displayed. 

 

Predefined Settings 
There are three pre-defined settings that can be used that for differing types 
of documents to be scanned. Additionally, these formats can be optimised for 
Internet retrieval using ScanFile WebServer. 

Option Description 

 

This will set the compression to the optimum settings for 
graphic only images 

LuraDocument • Page 213 



ScanFile User Guide 
LuraDocument Settings 

T
m

 

he compression will be optimised for images that are 
ixed text and graphics 

 

The compression will be set for text only images 

 

There are also 5 quality levels that will affect the compression levels of the 
foreg u grou  will n  affect the text compression. 

he Internet optimised storage will change the storage mode to 

 but full-size image 

und 

ro nd and back nd images, but ot

T
Embedded. The image can then be displayed progressively. The quality 
becomes continuously better during loading over telephone lines. An interrupt 
of the transmission results in a smoothed

Expert Settings 
The Expert mode allows you to alter the compression and quality levels of 
the image segments. These are divided into: 

• Bi-tonal 
• Foreground 
• Backgro
• Thumbnail 
• Miscellaneous 
 
Bi-tonal 

The Bi-tonal settings are for the text part of the image and can determine 
how the text is segmented and stored, and the compression level. Following 
options are available: 

Option Description 

Mode This sets the compression format in which the text is 
raDocument) LDF, TIFF G4 or no saved. This can be (Lu

compression 

Segmentation This defines whether the image is all text, a mix of text and 
graphics, or all graphics. An auto mode is also available 
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Mask The mask sets how LuraDocument processes the image 
text. It can adapt it's processes dependant upon specific 
parts of the image, or process the whole image using the 
Constant setting 

Quality The quality can be set from 1 to 100 

 

Foreground 

ge saves the text colour information, and can be set for The foreground ima
differing levels of compression and quality thresholds. 

Option Description 

Mode This sets the foreground image to Baseline or Embedded. 
You can also select no (None) settings. 

Sample The value is the down-sample rate. The higher the value, 
the higher the compression and lower the image quality 

Min. Quality This sets the threshold for the minimum image quality, 
which if not achieved , can override the compression level 

 

Baseline 

This mode does not consume as much working memory as the embedded 
mode. It is the only available mode if you compress very large images. The 

 compressed image in your 

uously better during loading 
ults in a smoothed 

nail is generated and stored. 

resulting image is partly embedded. The compression is a little bit faster than 
in embedded mode. If you display a baseline
homepage and you have a bad transmission capacity the image will be 
displayed in top-down mode. 

Embedded 

This allows the image to be displayed progressively, and is optimised for 
internet delivery. The quality becomes contin
over telephone lines. An interrupt of the transmission res
but full-size image. 

Thumbnail 

These settings affect how the thumb
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Option Description 

Mode This sets the thumbnail image to Baseline or Embedded 

Min. Quality This sets the threshold for the minimum image quality, 
which if not achieved, will affect the thumbnail generation. 

 

Miscellaneous 

You can set a compression factor that LuraDocument will attempt to achieve. 

gh compression is very difficult as the 
text layer is always compressed lossless. For the background image and the 
text colour image the quality or compression ratio can be chosen. 

d via the size of the text layer 
(dependent on the settings of quantization and segmentation) and the quality 

to guarantee the minimal requested image quality the actual 
rate may be higher. 

be obtained by lowering the minimum 

 

The factor can be set from 1 to 100. 

The compression that can be achieved using LuraDocument depends on 
many factors. In general are documents with higher resolutions (high dpi 
number) easier to compress. The complexity of the document has a major 
influence. If the amount of text is very hi

So the total compression ratio can be controlle

of the fore- and background images. 

If a compression factor set during compression, the system will try to achieve 
this compression exactly. However it is possible that the text layer is too huge 
or that in order 

To reach maximum compression two things should be observed: 

• As the text layer is compressed lossless, the text layer has to be kept as 
small as possible: 

• Automatic text detection will always result in smaller text sizes that the 
setting "everything is text". However if the text sensitivity levels is too low 
some letters may not be detected. 

 
High compression ratios may also 
image qualities. Another way to increase compression is to lower the 
resolutions for text colour image and the background image. This can be 
done if the document has a simple structure. 
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Overview 
The Audit Trail option in ScanFile tracks and records any event performed in 
t on. T rs and can be 
customised to track a number of different events.  

The Audit Trail optio d event information in an event 
viewer format, which n

In addition to reco in , WebServer events are also 
recorded within the A

Audit Confi u
To create the requ rmine which 
events are to be re port from the Options menu 
to open the follow

he applicati his is used primarily by system administrato

n will display the recorde
 ca  also be printed. 

rd g ScanFile events
udit system.  

g ration 
ired report, options have to be selected to dete
corded. Select Audit Trail Re

ing window: 

 

n Audit Trail Configuration Click on the butto  from the main Audit 
ow and this will display the configuration window. Trail Report wind
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The option Activa
or off. If the option

In the configuratio
various areas of S
is the Folder tab, f events that 
can be recorded w
that a folder is o
options must be s

Once the required
settings and you w

Displaying
Once any of the e
ScanFile program yed. To do this 
click on the Filter
enough there are
events that are cu

The first option is
events from; these
Trail Report wind
actions recorded d to the selected folders and 
libraries. 

te audit trail allows you to switch the auditing of events on 
 is checked, the events selected are recorded. 

n window there are a number of tabs, each headed for 
canFile where events can be recorded. An example of this 

 where it is possible to select from a number o
hen working with Folders. If you wish to record the event 

pened, closed, modified or deleted and so on then these 
elected by means of the checkboxes. 

 event settings have been defined click on OK to save the 
ill be returned to the main Audit Trail configuration window.  

 events 
vents selected have been activated or modified in the main 
, a list of up to 100 events can now be displa
 List button. If the event list that is returned is not specific 
 three ways to narrow down the results so that only the 
rrently required are displayed. 

 to select which folders and libraries you wish to display 
 are selected by means of checkboxes on the main Audit 
ow. Click again on Filter List. The new list contains event 
from all users that are relate
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The second opt
displayed; this is

ion to select is the user/s whose event actions are to be 
 also done by means of checkboxes in the main Audit Trail 

 in the 
main Audit Trail Report window. Another option here is the ability to define 

periods by weeks and months; these are also listed in the 
fter selecting a time period, click again on Filter List. The 

P

 prompted if you wish to continue and selecting Yes will 
print the report directly to the default printer installed on your system. 

S

Report window. 

Thirdly, should you require events to be displayed for a certain date or time 
period this period should be defined by selecting Customized in the 
Duration list and by amending the date boxes labelled From and To

pre-determined 
Duration list. A
new list contains event actions recorded in the given period. 

To view an event in more detail double click on it and an Audit Trail Details 
window will be displayed. 

rinting Events Lists 
Once a satisfactory event list has been returned it is possible to print the list 
by clicking on the Print button from the main Audit Trail Report window. At 
this point you will be

earching in archived Audit Trail data 

Click on Create Search Pool  and the window below will open. It 
displays all databases that have been previously exported to ScanFile 
Path\Saveaudit. Select the exported Audit Trail data required for your 
research and click on Create Search Pool. The program will merge all 
selected databases to one temporary database. Return to the Audit Trail 
window by clicking on Close. All Audit Trail functions will now work on the 
temporary database. You can research as usual. 
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If you wish to end your research, click on . The temporarily created 
database will be deleted terwards is the 
current Audit Trail database. 

. The data you are working on af

If you close the Audit Trail window, the temporary Audit Trail database is 
also deleted. If you reop  t en the Audit Trail window again, the current Audi
Trail data will be displayed. 
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O
e updated, 

option to put a 
tr er or folders so that 

 is to specify within the CD writing 
p  the information to be written to CD and then choose the write to 

in the application. 

verview 
Once a folder has been completed, and is no longer required to

so an 
 b

it can be archived to other media such as CD. There is al
ieval only version of ScanFile on to a CD with the foldre

the information can be retrieved on any PC running MS Windows, even if that 
PC does not have ScanFile installed on it. A CD Ticker is required for 
preparing such an executable. Ticker will be described later on in this 
chapter. 

ScanFile does not itself have built-in CD Writing software, and therefore a 
third party application is required. Normally, this will be supplied with the CD 
writer. The normal method of CD writing
ap lication
CD option with

Form Windows XP on it is possible to burn data on a CD without third party 
software. For more information refer to your Windows Help. 

CD Preparation 
To select CD Preparation, choose that option from the File menu, or click on 
the toolbar button and the CD Preparation screen will be displayed. 
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There are two ways to prepare ScanFile Folders for archiving. Either you 
choose Standard Preparation or Fast Preparation. 

Standard Preparation 
By dropping down the CD Pool Drive option in the CD Preparation window, 
the drive to which the folders will be copied can be selected. Next, select the 
drive(s) containing the folders to be copied. Select the folders you wish to 
add to the CD Pool individually, by highlighting the folder name and then 
clicking Add, or by clicking Add All, which will add all the folders from that 
drive to the CD Pool. 

Ensure that the maximum capacity of the CD pool doesn’t exceed the 
capacity of your storage media. When writing to CDs, it is advisable to 
reserve 5% of the disk space for the CD writing program for creating and 
closing the writing session. 

The only other option to select at this stage is the Bundle TIFF Files option. 
If this is selected, all the separate TIFF files within a folder will be combined 
into one large ‘Container’ file, which has advantages when it is intended to 
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place the CDs into a jukebox. If this is not selected, the TIFF files will be 
copied individually. 

After the folders and options have been selected, click the OK button to start 
. A pro of the retrieval 

software is to be copied. If Yes is selected, the application will be copied to 
the CD_TRANS.CD e n be used in any PC for retrieval. 
The amount of the he hardware dongle will be 
decreased by one. S ithout retrieval program. In this 
case the amount of C  

If Yes was selected h cured with a password to stop 
unauthorised access d asking whether a password 
should be applied. T v word has to be entered twice. 

When Ok is pressed, the CD_TRANS.CD will be created on the Pool Drive, 
the folders will be c e  retrieval version of ScanFile 
will also be copied. 

The preparation starts. If missing, the folder CD_TRANS.CD on the CD Pool 
Drive is created, are will be 
copied. Each folder receives an additional file, validating the folder for the 
use with the Retrie

After the CD pr
directory can be c

Fast Prepara
With Fast Prepa er is not copied into a CD_TRANS.CD 
directory, but is left in its original 
archive file added
ScanFile. Also, th
directory of the po

 for s
start the Fast Pre he Fast Preparation button in the CD 

and the re
the pool drive. A
folders and retriev

the process mpt will then appear asking whether a copy 

dir ctory. Such a CD ca
 CD Tickers stored in t
elect No to create a CD w
D Ticker isn’t reduced. 

, t e folders can be se
. A prompt will be displaye

sso a oid mistyping, the pa

opi d, and, if selected, the

 and the selected folders and retrieval softw

val Software. 

eparation finished, the contents of the CD_TRANS.CD 
opied to CD. 

tion 
ration, the fold

location. The folder will have a special 
 to it to enable it to be used with the retrieval version of 
e retrieval software will be copied to the CD_TRANS.CD 
ol drive. 

The process electing the folder is the same as described above, but to 
paration, click on t

Preparation dialogue. The folder will be 
added, 

checked, the archive drive will be 
trieval software copied to the CD_TRANS.CD directory of 

 window pops up giving you the location of the selected 
al software. 
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CD Tickers 
If you wish to create  
of ScanFile, this will require a CD Ticker. These can be purchased in groups 
from your supplie
These are licence
on a CD. You can

Each time you pu ust give your dongle serial 
number to your su
code has to entere
described in chap
clicking Options -

Writing to
How this is achieved, and what facilities are available will be dependent upon 
the software being

If you have chose
selected folders w
the CD_TRANS.C

With Fast Prepar
software will be c
be selected and c

Please refer to the
instructions on usi

 a ScanFile Executable CD with a retrieval only version 

r. Each executable CD preparation will use one CD ticker. 
s allowing you to put the retrieval only version of ScanFile 
 create as many copies of that CD as you wish. 

rchase a group of tickers, you m
pplier, who will then send you a PickUp Code. This PickUp 
d clicking Internet licence or be loaded via file transfer as 

ter Licensing. The number of Tickers can be displayed by 
 Display ticker status. 

 CD 

 used to write the data to a recordable CD. 

n the standard preparation, the retrieval software and all 
ere copied to CD_TRANS.CD directory. The contents of 

D directory can be written to CD. 

ation, the folders are left in their original location and the 
opied to CD_TRANS.CD directory, and they can therefore 
opied directly. 

 manual supplied with the CD writing application for exact 
ng the application. 
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O
ning devices: 

• DR-5020 • DR-6080 • MS800 

d rts the Panasonic KV-S2026C directly, and also 
p fax device. 

SCSI Connected Scanners 

The correct SCSI ID for the scanner can be selected by using the second 
drop-down list in Select Scanner SCSI ID. For any SCSI device attached to 
the selected adaptor card, a description of what the device is will be 
displayed next to the SCSI ID 

Scanning Resolution 
Any scanning device has the ability to scan documents at different 
resolutions. These are measured in Dots per Inch (Dpi). In the majority of 
scanners, vertical and horizontal resolutions will be the same, although 
certain Canon DR scanners can scan at split resolutions. 

The resolution that a document is scanned at will have two effects. The 
higher the scan resolution, the better the quality of the image that will be 

verview 
ScanFile has built-in support for the following Canon scan

• DR-3020 • DR-2050C • DR-7080C 
• DR-3060 • DR-2080C • MS300 
• DR-3080C • DR-2580C • MS350 
• DR-3080CII • DR-5010C • MS400 

• DR-5060F • DR-7580 • CR-180 
• DR-5080C • DR-9080C • CF510 

 

Ad itionally, ScanFile suppo
su ports any TWAIN and Ko

With some of the built-in drivers, if the scanner is using a SCSI connection, 
the SCSI adaptor the scanner is attached to must be specified. This can be 
done by selecting from the top drop-down list in Select Scanner SCSI ID. If 
there is only one SCSI adaptor card installed in the PC, this will be selected 
by default. 

The scanner itself then has to be selected. A SCSI Adaptor can have up to 7 
SCSI devices attached to it. They are each identified by a SCSI ID in the 
range 0-7. Normally, the SCSI adaptor itself will be set to SCSI ID 7. This 
leaves 0-6 for other devices.  
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produced. Higher scan resolutions will produce larger file sizes for a scanned 
image. With file compression which ScanFile utilises, the file size can be 
reduced. 

The resolution chosen to scan particular documents will very much depend 
upon the type of document being scanned, its quality, whether it is to be 'live' 
or 'archive' filing, and user preference. 

Test Scan 
The Test scan function is available within the inbuilt Canon scanner drivers, 
and allows you to scan a document with your selected settings, to see 
whether these settings are correct. 

Place a document in the scanner feeder and then press the Test Scan 
button. The document will then be displayed in the Test Scan Display 
window. 

(+) and Minus 
m left and right of the Test scan window allow you to 

enlarge and reduce the size of the image. Pressing the O allows a box zoom 

S
020, DR5020 and DR05080c are delivered with two types of 

 of control sheet, four options are available 

• • Detect & Skip, Continue Scanning 
• • Detect & Scan, Stop Scanning 
• • Detect & Skip, Stop Scanning 
 

The image quality can be checked from this window. The Plus 
(-) signs in the botto

- draw a box around the area you wish to enlarge. The # will display the 
complete image in the Test scan window. The image can be moved around 
within the window by pressing and holding the right mouse button, while the 
cursor is over the Test Scan window, then dragging the mouse around the 
window. 

canner Control Sheets 
The Canon DR-3
control sheets. The first type can change the scanner settings, whilst the 
second will affect how the documents are stored. The Control sheets can be 
inserted between pages/files and, during scanning, will affect either how the 
documents are scanned or how they are filed. 

For each type

• • Detect & Scan, Continue Scanning 
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If the Detect & Scan option is chosen, the control sheet is stored in the 
ScanFile folder. If the Detect & Skip option is selected, the control sheet is 
not stored in the ScanFile folder. 

J ion c  placed in the 
scanner feeder into separate files when scanned. Place a Job Separation 
sheet between each le  Batch Detection mode, and 
then scan the docum t

When a control she h scanning can either continue or 
stop. You may wish to stop scanning so as to enter additional indexing 
information. Alternat l can everything and then index it. 
In this case, choose the n. 

The Function Contro h of the scanner. With these 
sheets, during scann  changed from Text Mode 
to Photo Mode, o  v  appropriate control sheet. 
Using The Simplex and Duplex contro
either single or do

Scanner C
There are many o
split over several 
used options are
Scanner Setup is selected. The options of the different scanners are 
detailed below. 

Canon DR-6080, 7580 & 9080c 
The DR-6080, DR
with a maximum scanning throughput of up to180 images per minute . They 
are double-sided
detection. Addition
document feed. 

The DR-6080 and
whilst the DR-908
The maximum sca

ob Separat ontrol sheets are used to divide documents

 fi , choose the required
en s. 

et as been detected, 

ive y, you may wish to s
Continue Scanning optio

l s eets affect the operation 
ing, the scanning mode can be

r
l sheets changes the scanning mode to 

uble-sided scanning. 

ice versa, by the use of the

onfiguration 
ptions that can be selected for the scanners, and these are 
screens which are selected from Scanner Setup. The most 
 collected together on the first screen displayed when 

-7580 and DR-9080c are high performance A3 scanners 

 scanners with automatic paper size and thickness 
ally, document skew is automatically corrected during the 

 DR-7580 support black & white and greyscale scanning 
0c supports several modes up to a maximum 24 bit colour. 
nning resolution is for all scanners 600 dpi. 
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S er Con
The following screen shows the first screen displayed when choosing 
Scanner Setup fo

cann figuration 

r the Canon DR-6080, DR-7580 or DR-9080C. 

 

Page Settings 
All three scanners r ing single or double sided 
documents, and diff n r each side of a double 
sided document. The r  to scan single or double 
sided. Selecting Fro or  scanning from the option on the 
screen above can do i

The Fit Image op
each page scann
document. When 

If scanning double-sided documents, different settings can be applied for 
each side of the d
documents, click 
different settings  side 
option, and then choose from the drop down list which side you wish to 
choose to set the 

For each side, or b

 a e capable of scann
ere t settings can be applied fo
 fi st option to select is whether

nt, Back, Front/back
 th s. 

tion sets the scanner to automatically detect the size of 
ed, and will adjust the page size to the actual size of the 
this is set, the Page Size option is disabled  

ocuments. To use the same settings for both sides of the 
on the Same settings for back side option. To use 

for each side, uncheck the Same settings for back

scanning preferences.  

oth sides of a document, the following options can be set. 
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Setting Description 

Page Size 

• B4 - 250 x 353 mm 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 

rea of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 

• B5 - 176 x 250 mm 
• B6 - 125 x 176 mm 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the a

Resolution You can select one of the following: 100, 150, 200, 240, 
300, 400 & 600dpi 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Mode This option is used to set the number of colours to be 
scanned. Please note that DR-6080 and DR-7580 support 
black & White and greyscale mode scanning. All other 
settings are applicable to the DR-9080c. The DR-9080c 
supports 24 bit colour scanning. The larger the bit value 
selected, the more colour shades will be scanned. Please 
be aware that greyscale and colour scanning, especially at 
high resolutions, can result in extremely large file sizes. 

Page 234 • Scanner Setup 



ScanFile User Guide 
Canon DR-6080, 7580 & 9080c 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

: This format will perform no 
ion on the image data produced from the 

scanned document, and will result in large file sizes. 

data, normally by a factor of 10 to 15. This
is only used for black & white scanned images. This is a 

ation is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
ssion mechanism, which is designed for 

 or grey-scale images of 

radically affect the size of the file produced. 

Lura Document: Lura Document is a standardised image 
ion ratio which is designed essentially for 

compressing either full colour or greyscale images to 

extensive options for determining levels of quality for Lura 
Document scanned images. 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF
compress

Group 4 Compressed TIFF: This format will compress the 
scanned image 

'lossless' compression format which means that none of 
the original scanned inform

compre
compressing either full-colour
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 

compress

dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
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Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 

ghtness setting can be adjusted. All three 
canners have an automatic brightness function built-in, but this can be 

anually set if necessary. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
b ual
a r va
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and 
three scanners have automatic brightness and contrast functions built-in, but 
t

W tting
brightness and/or the c

The brightness and contrast settings
with 1 being the darkest s in e of 0 will select 
auto brightness or contra  e, 
untick the Auto checkbox n he 
slide bar or typing in a valu  

Extended Settin
The Extended Setting
of the scanners. Many
explained on the follow

Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Bri
s
overridden and m

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

rightness. To man
nd select any othe

ly set a brightness value, untick the Auto checkbox 
lue as Auto by using the slide bar or typing in a value 

Contrast settings can be adjusted. All 

hese can be overridden and manually set if necessary. 

hen the Auto se  is selected, the scanner will automatically sense the 
ontrast setting required for each page as it is scanned. 

 can be any value between 1 and 255, 
ett g, 255 being the lightest. A valu
st. To manually set a brightness or contrast valu

sing t a d select any other value as Auto by u
e between 1 and 255. 

gs 
s option allows you access to the advanced functions 
 settings are available from this option, and these are 
ing pages. 

Several of these setti e quality of the scanned image and ngs can affect th
they should therefore be used with caution! 
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D

There are two methods
of two or more sheets
thickness and/or leng tion tick either the 
Detect by ultrasonic or Detect by Length checkbox or both. When you next 
s ocum
its thickness and/or le
Subsequent document
value and if the scanne
an error will be displaye

Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 

ouble Feed Detection 

 to set the scanner to detect the simultaneous feeding 
 of paper. The scanner can be calibrated for paper 
th. To set Double Feed Detec

can a batch of d ents, the first page fed through the scanner will have 
ngth measured and the measurement then stored. 

s’ measurements will be compared against the stored 
d document is thicker or longer than the stored value, 
d. 

 

and to set colour dropout areas where the document will not be scanned. 

Option Description 

Dropout Colour 

• None: Disables Colour dropout 

This function is only available with the DR-9080. It is 
available separately for the front and back page. It will 
disable the scanning of areas of the document of a 
particular colour. The settings are: 

• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 
 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 9 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

 

Other Options 

Other settings are available and these are detailed below: 
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Option Description 

Verify Count This can be used to ensure that a known number of 
pages are being fed correctly through the scanner. 
Before scanning, the number of pages to be scanned 
can be set, and if that number of pages is not fed 

 scanner, an error will be displayed. through the

Simple Staple The scanner 
Detection document feedin

has a simple staple detection for 
g. When the sensor detects a staple 

in either upper corner, the scanning process is 
automatically stopped. 

Deskew by roll This function activates a hardware based deskew of 
sheets to ensure the correct feeding of pages. 

 

Imprinter Option 

If the Imprinter option has been installed in the scanner, this can be 
configured by selecting the Imprinter option from the Extended Settings 
screen. 

 allows you to print specified alphanumeric and symbol 
ck page as it is being scanned. You can 

The Imprinter option
characters at any position on a ba
also embed the characters to be printed in the scanned image. 

To set the Imprinter to print text on a page as it is being scanned, tick the 
Print checkbox. To embed the text as part of a scanned image, tick the 
Embed to image checkbox. 
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ted can be specified in the Text field. If the The text to be prin counters are to 
be used, these must be specified within 
u alues m

The Horizontal o
scanned image. You can specify the offset
the page. When p
refer to the scanne

The Vertical offs he top edge of 
the paper to start printing the text. 

You can select to
as indicated by t
Every or Next pag

You can set the di
down list. The available values are None, 90, 180 and 270 degrees. 

The Right to left option will set the Imprinter to add characters from right to 
left. 

The default font size the Imprinter uses is 12x12 dots. You can select to use 
a smaller 8x7 font size by ticking the Use small fonts checkbox. 

square brackets. If both counters are 
ust be separated by a decimal point (full stop). 

ffset only applies if the text is to be embedded in the 
 in millimetres from the left edge of 

rinting text, the horizontal offset is applied manually, please 
r manual for instructions on how this is done. 

et specifies the distance in millimetres from t

sed, the v

 print the text on every page, on the first page of a new file 
he New file key, by setting the Pages drop down list to 
e. 

rection in which the text will print from the Orientation drop 
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T  of Emb

• Black on White will print black text on to a white background. 
• White on Blac
• Black on imag
 
There are two counters that can be configured, and these options apply to 
both. The Start value of the counter 
i t the valu

The following valu
Reset If will reset the counter to its start value. Increment If will add the 
specified increment value to the counter. 

• Never 
 Separator 

arator 

C
der and a flatbed 

with documents up to A3. Therefore it is suitable to scan pages automatically 

ximum resolution is 600 dpi. 

 Setup.  

he Style edment can be set from one of three options: 

k will print white text on a black background. 
e will print black text on to the image. 

can be set as well as the value to 
e for each page.  

es can be set for the Reset if and Increment if options. 

ncremen

•
• New File or Sep
• New File 
• Each Document 

anon DR-7080C 
The Canon DR-7080C can be used with a document fee

from the document feeder and to scan single pages for example from books. 
In feeder mode the scanner can scan black and white, greyscale and full 
colour up to A3 size. The ma

Scanner Configuration 
There are many options that can be selected for the scanners, and these are 
split over several option screens which are selected from Scanner

The following screen is displayed when choosing Scanner Setup for the 
Canon DR-7080C. 
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Page Settings 
Th  scanner ise  able to scan single or double sided documents, and different 

t r each side of a double sided document. The first 
t r to scan single or double sided or to scan from 
t er. Selecting Front, Flatbed or Front/back scanning 
m e screen above can do this. 

atically detect the size of 
ed, and will adjust the page size to the actual size of the 

ame settings for both sides of the documents, 

the drop down list which side you wish to choose to set the 
scanning preferences. 

For each side, or both sides of a document, the following options can be set: 

se tings can be applied fo
ect is whetheop ion to sel

fla bed without feed
fro  the option on th

The Fit Image option sets the scanner to autom
each page scann
document. When this is set, the Page Size option is disabled if scanning 
double-sided documents, different settings can be applied for each side of 
the documents. To use the s
click on the Same settings for back side option. To use different settings for 
each side, uncheck the Same settings for back side option, and then 
choose from 
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Setting Description 

Page Size Select one of the following document sizes: 

• A4-R - 297 x 210 mm 

 is enabled, this setting is disabled 

age Size Setting: 

 can specify 
an area of the document to be saved. To do this, select 

page size, then perform a Test Scan on a 
nt. A sizeable box will be overlaid on the 

t when this option is used, only the area of 

• Letter - 8.5 x 11 In 
• Ledger-R -  17 x 11 In 
• Letter-R - 11 x 8,5 In 
• Legal-R – 14 x 8.5 In 
• A3-R - 420 x 297 mm 
• A4 - 210 x 297 mm 

• A5 - 148 x 210 mm 
• A5-R - 210 x 148 mm 
• B4-R – 353 x 250 mm 
• B5 - 176 x 250 mm 
• B5-R - 250 x 176 mm 

 
If Fit Image

Window P

If you select the Window page size option, you

Window as the 
sample docume
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note tha
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select one of the following: 100, 150, 200, 240, 
300, 400 & 600dpi 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Mode This option is used to set the number of colours to be 
scanned. 

Black & White: The black & white mode scans only in 
black & white. 
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Greyscale: Greyscale mode creates images with 256
greyscale levels. 

Colour: The DR-7080C supports 24 bit colour scanning. 
The larger the bit value selected, the more colour shades 
will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in extremely large 
file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
 type of compression and file format you select is 
endent upon several factors including the type of 

 

the original scanned information is discarded. 

 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

The
dep
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes.

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 

JPEG (JTIFF): JPEG is a standardised image
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Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files sizes. Lura document is also a 

nFile includes 
extensive options for determining levels of quality for Lura 
Document scanned images. 

‘lossy’ compression format, however, Sca

Sensitivity 
These settings allow o  and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon xt mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, onl
7080c has an a
overridden and ma

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness se
darkest setting, 2 ill select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
a y oth alue 
between 1 and 255. 

Photo Mode 
In this mode, the
The DR-7080c ha t functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto s
brightness and/or it is scanned. 

T htness an
with 1 being the d
auto brightness o
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

 y u to adjust the brightness

whether the document is to be scanned in Te

y the Text Brightness setting can be adjusted. The DR-
utomatic brightness function built-in, but this can be 
nually set if necessary. 

tting can be any value between 1 and 255, with 1 being the 
55 being the brightest. A value of 0 w

nd select an er value as Auto by using the slide bar or typing in a v

 Photo Brightness and Contrast settings can be adjusted. 
s automatic brightness and contras

etting is selected, the scanner will automatically sense the 
the contrast setting required for each page as 

he brig d contrast settings can be any value between 1 and 255, 
arkest setting, 255 being the lightest. A value of 0 will select 
r contrast. To manually set a brightness or contrast value, 
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E ed Se
The Extended Settings to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the f

xtend ttings 
 option allows you access 

ollowing pages. 

Several of these settings can affect the quality of the scanned image and 
they should there  with caution! fore be used

 
Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 
and to set colour dropout areas where the document will not be scanned. 

Option Description 

Dropout Colour 

Red: Will not scan red parts of the document 
he 

document 
n blue parts of the document 

This function is available separately for the front and 
back page. It will disable the scanning of areas of the 
document of a particular colour. The settings are: 

• None: Disables Colour dropout 
• 
• Green: Will not scan green parts of t

• Blue: Will not sca
 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 9 and can be set by 

 

moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis 

 

hasis contour lettering, as 
well as softening scanned images such as photos. 
This can be used to emp

This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Canon DR
The DR-5020, 5080c and 5060F are high 
maximum scannin
double-sided scan

-5020, 5080C & 5060F 
performance A3 scanners with a 

g throughput of 80 A4 pages per minute. They are all 
ners with automatic paper size and thickness detection. 
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Additionally, docu
feed process from

The DR-5060F inc

The DR-5020 sup
several modes u
resolution for bot
black & white scanning only with a maximum scanning resolution of 300dpi. 

Pre and post doc
scanners. A Barco

Document specific

• Width 55mm to
• Length 70mm 
• Thickness 0.06mm to 0.15mm (0.05 to 0.2mm Manual Feed) 

ation 

The following screen shows the first screen displayed when choosing 
 for the Canon DR-5060F. This has an additional option to 
 for the DR5020/80c, allowing the film position to be saved 

ment skew is automatically corrected during the document 
 the 500 sheet paper feed tray. 

orporates an inbuilt microfilm camera. 

ports black & white scanning whilst the DR-5080c supports 
p to a maximum 24 bit colour. The maximum scanning 
h of these scanners is 400dpi. The DR-5060F supports 

ument endorsers are options which can be added to the 
de decoder can also be included as an option. 

ations are: 

 297mm 
to 432mm 

Scanner Configur
There are many options that can be selected for the scanners, and these are 
split over several option screens which are selected from Scanner Setup. 
The most used options are collected together on the first screen displayed 
when Scanner Setup is selected. 

Scanner Setup
the setup screen
to a folder field, but apart from that the screen has the same options. 
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Page Settings 

can be applied for each side of a double 
sided document. The first option to select is whether to scan single or double 
s
s

The Fit option sets the scanner to  detect the size of 
each page scanned, and will adjust the page size to the actual size of the 
d this 
d ocumen
the documents. 

To use the same settin
settings for back si
uncheck the Same set
drop down list which side you wish to choose to set the scanning 
preferences. 

For each side, or both sides of a document, the following options can be set: 

All three scanners are capable of scanning single or double sided 
documents, and different settings 

ided. Selecting Front, Back, or Front/back scanning from the option on the 
creen above can do this. 

 Image  automatically

ocument. When 
ouble-sided d

is set, the Page Size option is disabled if scanning 
ts, different settings can be applied for each side of 

gs for both sides of the documents, click on the Same 
de option. To use different settings for each side, 
tings for back side option, and then choose from the 
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Setting Description 

Page Size Select one of the following document sizes: 

• L e
• Legal - 8.5 x 14 Inch 
• A  
• A4 - 210 x 297 mm 
• 
• 
• 
• 
• 
• mm (JIS) 

 
If Fit

Wind

If you tion, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 

x over the area 
nd location will 

ett r - 8.5 x 11 Inch 

3 - 297 x 420 mm 

A5 - 148 x 210 mm 
A6 - 105 x 148 mm 
B4 - 250 x 353 mm (ISO) 
B4 – 257 x 364 mm (JIS) 
B5 - 176 x 250 mm (ISO) 
B5 - 182 x 257 

 Image is enabled, this setting is disabled 

ow Page Size Setting: 

 select the Window page size op

image in the Test Scan window. Size the bo
of the sample document, and the box size a
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select up to one of the following resolutions : 200, 

With the above settings the horizontal scan resolution is 
the same as the vertical resolution. There are also 2 high 
speed scanning settings, which have split resolutions. The 
first figure is the horizontal setting, the second refers to the 

210, 220, 230, 240, 250, 260, 270, 280, 290, 300 and 400 
dpi (Dots per Inch) 

vertical setting. These are marked in the Resolution list 
with asterisks (*): 200 x100 and 300x150 dpi. 

Dither in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Use this setting when scanning 
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Modus This option is used to set the number of colours to be 
scanned. 

Please note that the DR-5020 and DR-5060F only support 
Bl r settings are 
ap c

Black & White 

The black & white mode scans only in black & white. 

Greyscale 

The DR-5080c supports 4, 16 & 256 levels of Greyscale 

Colour 

The DR-5080c supports 3, 6, 12 and 24 bit colour 
scanning. The larger the bit value selected, the more 
colour shades will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in extremely large 
file sizes. 

ack & White mode scanning. All othe
pli able to the DR-5080c. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 
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JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
ompression possible. It is possible to vary the amount of 

scanned image, and will 
radically affect the size of the file produced. 

y for 
compressing either full colour or greyscale images to 

c
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original 

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentiall

dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 
Document scanned images. 

Sensitivity 
These settings al
each side of a 
dependent upon 
Photo Mode. Phot

Text Mode 
In this mode, onl sted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and ma

When the Auto 
brightness setting

The Brightness se
darkest setting, 2 value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
a  any oth
between 1 and 25

low you to adjust the brightness and contrast settings for 
document to be scanned. Different settings will apply 
whether the document is to be scanned in Text mode or 
o mode applies error diffusion to simulate rescaling. 

y the Text Brightness setting can be adju

nually set if necessary. 

is selected, the scanner will automatically sense the 
 required for each page as it is scanned. 

tting can be any value between 1 and 255, with 1 being the 
55 being the brightest. A 

nd select er value as Auto by using the slide bar or typing in a value 
5. 
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Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be over

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness an 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto c
slide bar or typing

Extended Se
The Extended Se
of the scanners. Many settings are available from this option, and these are 
e d on the f

ridden and manually set if necessary. 

d contrast settings can be any value between 

heckbox and select any other value as Auto by using the 
 in a value between 1 and 255. 

ttings 
ttings option allows you access to the advanced functions 

xplaine ollowing pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

 
Double Feed Detection 

There are two methods to set the scanner to detect the simultaneous feeding 
of two or more sheets of paper. The scanner can be calibrated for paper 
thickness and/or length. To set Double Feed Detection, tick either the 
Thickness or Length checkboxes, or both. When you next scan a batch of 
documents, the first page fed through the scanner will have its thickness 

easured and the measurement then stored. Subsequent 
ed against the stored value and if 

The thickness setting can be manually adjusted when the automatic 

s setting, he Activate checkbox, and then use the 
arrow keys at either end of the slider bar to increase or decrease the value. 

and/or length m
documents’ measurements will be compar
the scanned document is thicker or longer than the stored value, an error will 
be displayed. 

 
Manual Thickness Adjust 

thickness detection is not used or when there are frequent double feeds of 
paper. 

The setting ranges from 1 to 13, with 1 being the thinnest, and 13 the thickest 
setting. To adjust thi  tick t
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Border Removal 

You can set a margin around the scanning area. The value ranged from – 
10mm to +10mm. 

To use this function, tick the Activate checkbox. To adjust the values, use 
the arrow keys or the slider bar to increase or decrease the value. To enlarge 
the scanning area, to ensure the document edges are not clipped, set a plus 
value. To reduce the scanning area, so that the image is not framed by a 
black border, set a minus value. 

 
Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 
and to set colour dropout areas where the document will not be scanned. 

Option Description 

Erase Black Dots This will automatically erase isolated black dots on a 
white background from the scanned image. 

Erase White Dots This will automatically erase isolated white dots on a 
black background from the scanned image. 

Erase Notch This will automatically remove areas that are caused 
by contours 

Complete Thin Lines This will automatically fill in broken or thin faint lines. 

Drop Out Colour This function is only available for the DR-5080c and 
will disable the scanning of areas of the document of 
a particular colour. The settings are: 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 

 
Colour Dropout can be disabled for a part of the 
document by setting values in the Disable Dropout 
option. This is measured in millimetres, and is applied 
x mm from the top edge of the scanned image to x 
mm from the top edge of the image, where x is the 
value required. 
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Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 13 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

 

Other Options 

Several other settings options are available and these are detailed below: 

Option Description 

Verify Count This can be used to ensure that a known number of 
pages are being fed correctly through the scanner. 
Before scanning, the number of pages to be scanned 
can be set, and if that number of pages is not fed 
through the scanner, an error will be displayed. 

Auto New File This setting can be used when batch scanning to 
new file when the feeder 
continue scanning will be

displayed and when this is pressed, a new file will be 
created. 

automatically create a 
empties. An option to 

U e Front Panes l When this is enabled, the front panel of the scanner 
can be used to override certain settings set in the 
scanner driver. In the case of the DR- 5060F the front 
panel enables the user to also control the microfilm 
scanning functions. 

 

DR-5060F Additions 

ature of the Canon DR-5060F is the Save Film Position To 
option on the driver screen. This calculates the position of the film from the 
An additional fe

‘blips’ recorded on the microfilm by the built in camera unit on the scanner. 
When the position of the film has been calculated it can populate an index 
field in folders that have this option set. 
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Function Keys 

This settings screen can be used to set the functions available on the four 
keys on the front panel of the DR-5020, DR-5060F and DR-5080c. The 
available functions are: 

• Manual Thickness Adjustment 
• Scanner Calibration 
• Auto Thickness Detection On/Off 
• Auto Double Feed Detection On/Off 
• Imprinter On/Off 
• Save Settings 

To select a file, choose the colour from the dropdown list and then press 
Open File. This will allow you to select the Gamma settings file to associate 

ilable from the Extended 
Settings screen. From this screen you can set which barcode types are to be 
searched for, and you can also specify an area of the document to search for 

 front or back of a scanned page. 

 

des of differing types can be searched for and read from a 

 

Gamma 

This option is used to download to the scanner Gamma data settings used to 
express colours and tones. These can be set for each of the colours shown. 

with that colour. 

 
Barcode Decoder 

If the Barcode decoder option has been installed in the DR-5020, DR-5080c 
or DR-5060F, the Barcode Setup option will be ava

barcodes, which can be on the

The scanners will recognise the following barcode types: 

• EAN 
• Code 39  
• Codabar 
• Code 25  
• UPC 
 UPC-A •

• UPC-E 
• Code 128 

Up to four barco
document. The number to read can be set in the Barcodes per page option. 
To select the side of the page that the barcodes are on, choose the 
appropriate option from the Side drop down list. 
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To activate the barcode recognition, tick the Use barcode recognition 
checkbox. The Activate buzzer option will set the scanner to buzz each time 
a barcode is found and read. 

lly you can set a specific an area on a page to search for barcodes. 
Activate checkbox under Search Area.  

 the top left of the 
search area is set by putting the appropr

Additiona
To select this option tick the 

The area to be read must be specified in millimetres, and
iate values in the Horizontal and 

Vertical offset value fields. You can then specify the width and height of the 
search area in the Width and Height value fields. 

To set the scanner to read a particular barcode format or formats, tick the 
Activate checkbox in each of the barcode formats. 

Barcode Option 

EAN To read the Extended EAN format, tick the Extended
checkbox. 

Code 39 If the barcode has a checksum, this can be recognised by 

so select to 
include the start and stop characters in the barcode read 

eturn start/stop checkbox. 

ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. You can al

by ticking the R

Codabar If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. There are two checksum 
options for Codabar, Mod 16 and DR7, which can be 

/stop checkbox. 

selected from the drop down list. You can also select to 
include the start and stop characters in the barcode read 
by ticking the Return start

Code 25 If the barcode has a checksum, this can be recognised by 

an then also select UPC-A and/or 
UPC-E. 

ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. 

By selecting UPC, you c
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UPC-A Extended UPC-A can be read by ticking the Extended
checkbox. 

If the barcode has a checksum, this can be recognised by 
ing the Recognise checksum checkbox. The header 

Return Header
tick
can also be returned by selecting the 
checkbox. 

UPC-E If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. The header 
can also be returned by selecting the Return Header
checkbox. 

Code 128 Code 128 has no options.  

 

Imprinter Option 

I ter op
5060F, this can 
Extended Settings

The Imprinter option allows you to print specified alphanumeric and symbol 
c t any
embed the charac

To set the Imprinter to print text 
Print checkbox. To embed the text as part of a scanned image, tick the 
E o image c

f the Imprin tion has been installed in the DR-5020, DR-5080c or DR-
be configured by selecting the Imprinter option from the 
 screen. 

haracters a  position on a page as it is being scanned. You can also 
ters to be printed in the scanned image. 

on a page as it is being scanned, tick the 

mbed t heckbox. 
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ted can be specified in the Text field. If the counters are to 
st be specified within square brackets. If both counters are 
ust be separated by a decimal point (full stop). 

ffset only applies if the text is to be embedded in the 
ou can specify the offset in millimetres from the left edge of 
rinting text, the horizontal offset is applied manually, please 
r manual for instructions on how this is done. 

et specifies the distance in millimetres from t

The text to be prin
be used, these mu
used, the values m

The Horizontal o
scanned image. Y
the page. When p
refer to the scanne

The Vertical offs he top edge of 
the paper to start 

You can select to
as indicated by t
Every or Next pag

You can set the di
down list. The available values are None, 90, 180 and 270 degrees. 

The Right to left option will set the Imprinter to add characters from right to 

printing the text. 

 print the text on every page, on the first page of a new file 
he New file key, by setting the Pages drop down list to 
e. 

rection in which the text will print from the Orientation drop 

left. 

The default font size the Imprinter uses is 12x12 dots. You can select to use 
a smaller 8x7 font size by ticking the Use small fonts checkbox. 
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The Style of Embedment can be set from one of three options: 

• Black on White will print black text on to a white background. 
• White on Black will print white text on a black background. 

 will print black text on to the image. 

There are two counters that can be configured, and these options apply to 

ptions. 
Reset If will reset the counter to its start value. Increment If will add the 
specified increment value to the counter. 

Options Screen 

tion and will show the attached scanner's 

• Black on image
 

both. The Start value of the counter can be set as well as the value to 
increment the value for each page.  

The following values can be set for the Reset if and Increment if o

• Never 
• Separator 
• New File or Separator 
• New File 
• Each Document 
 

The Options screen is for informa
installed or available options. 

The Barcode, Imprinter and Endorser checkboxes will be ticked if the options 
are installed. 

Option Description 

CC CC is a special filter option 

YG-LED Will be ticked if the attached scanner is a DR-5020 
or DR-5060F 

Red/Green/Blue-LED Will be ticked if the DR-5080c is attached 

 

The View options are values returned by the scanner. The DR-5080c will tick 
all three checkboxes. The DR-5020 and DR-5060F will return only Black & 
White and Bi-tonal. 
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Canon DR-3060, 3080C & 3080CII 

omatic paper size and thickness detection. 

The supports black & white and yscale scanning whilst 
the D  supports several modes u um 24 bit colour. The 
m annin

Post document endo n be added to the scanners. 

Document specificat s

• Width 55mm to 2 m
• Length 70mm to 
• Thickness 0.06mm to 0.15mm (0.05 to 0.2mm Manual Feed) 

Scanner Confi
There are many options that can be selected for the scanners, and these are 
split over differen ner Setup. 
The most used options are collected together on the first screen displayed 
when Scanner Se

The following screen shows the first screen displayed when choosing 
Scanner Setup fo

The DR-3060, DR-3080c and DR-3080cII  are high performance A4 scanners 
with a maximum scanning throughput of 40 pages per minute. They are all 
double-sided scanners with aut
Both scanners incorporate a 100 sheet paper tray. 

DR-3060 
R-3080c

 256 level gre
p to a maxim

aximum sc g resolution for both scanners is 300dpi. 

rsers are options which ca

ion  are: 

57 m 
364mm 

guration 

t option screens which are selected from Scan

tup is selected. 

r the Canon DR-3060, DR-3080C or DR-3080CII. 
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Page Setting
All three scanners are capable of scanning single or double sided 
documents, and different settings can be applied for each side of a double 
sided document. The first option to select is whether to scan single or double 
sided. Selecting Front, Back, or Front/back scanning from the option on the 
screen above can do this. 

Please note that greyscale and colour scanning is only available for single 
sided, front page scanning on DR-3060 and DR-3080C. 

The Adjust option sets the scanner to automatically detect the size of each 
page scanned, and will adjust the page size to the actual size of the 
document. 

For each side, or both sides of a document, the following options can be set: 

s 

Page 260 • Scanner Setup 



ScanFile User Guide 
Canon DR-3060, 3080C & 3080CII 

 

Option Description 

Page Size Select one of the following document sizes: 

• B4 - 250 x 353 mm (ISO) 

t Scan on a 
sample document. A sizeable box will be overlaid on the 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 

• B5 - 176 x 250 mm (ISO) 
 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Tes

image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution 

• 300 dpi (Dots per Inch) 

etting: 300x150 

You can select up to one of the following resolutions  

• 200 dpi 
• 240 dpi 

 
With the above settings the horizontal scan resolution is 
the same as the vertical resolution. 

There is also a high speed scanning setting, which has a 
split resolution. The first figure is the horizontal setting, the 
second refers to the vertical s

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 
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Modus This option is used to set the number of colours to be 
scanned. 

Black & White  

The black & white mode scans only in black & white. 

-3080c support 256 levels of 

ase be aware that greyscale and colour scanning, 
especially at high resolutions, can result in large file sizes. 

Greyscale 

The DR-3060 and DR
Greyscale 

Colour 

Only the DR-3080c supports 3, 6, 12 and 24 bit colour 
scanning. The larger the bit value selected, the more 
colour shades will be scanned. 

Ple

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncom
compre

pressed TIFF: This format will perform no 
ssion on the image data produced from the 

ally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 

 compression format which means that none of 
al scanned information is discarded. 

natural, real-world scenes. J

scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, norm

'lossless'
the origin

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 

peg is a 'lossy' compression 
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format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded re the quality of the 
remaining image. ScanFile has various quality levels for 

 how much data is 

e file produced. 

io which is designed essentially for 
compressing either full colour or greyscale images to 

, and therefo

Jpeg images which will determine
'dropped' form the original scanned image, and will 
radically affect the size of th

Lura Document: Lura Document is a standardised image 
compression rat

dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 
Document scanned images. 

Skew Correction 
ed skew correction facility that can be 

ns such as OCR. 

t upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

hen the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightes  A value of  will se o 
brightness. To manually set a brightness value, untick the Auto checkbox 

This function is a software driver bas
selected by a checkbox on the main Scanner Setup window. Should pages 
be scanned at an angle through the scanner, and not appear straight when 
viewing, this option will straighten the page and justify it which will help when 
performing other actio

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependen

W

t. 0 lect Aut
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and select any other value as Auto by u the slide b  typing e 
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and C rast setting n be adjusted. All 
three scanners have automatic brightness 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
w he darkest s g, 255 bein e lightest. A ue of 0 t 
a ss or contr o manual  a brightn r contra , 
u to checkbo  select a er value to by using the 
slide bar or typing in a value between 1 and 255. 

E etting
The  option allows you access to the advanced functions 
of the scanners. Many settings are avai  from this n, and e 
explained on the following pages. 

sing ar or in a valu

ont s ca
and contrast functions built-in, but 

ith 1 being t ettin g th  val will selec
uto brightne
ntick the Au

ast. T
x and

ly set
ny oth

ess o
as Au

st value

xtended S s 
Extended Settings

lable optio these ar

Several of these settings can affect the quality of the scanned image and 
they should therefore be  with cau used tion! 

Option Description 

Automatic Page 
Suppression 

This function allows both scanners to ignore 
unwanted blank pages being scanned. This can be 
performed for the front and back of a scanned page. 
To switch this option on click on the relevant activate 
checkboxes. The levels at which a blank page can be 
identified can be adjusted by the blackness threshold 
slide bar, t dentify pages e 
surface coverage on the page and depending on the 
levels set w

his will help to i with littl

ill ignore those pages. 
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Drop Out Colour This function is only available for the DR-3080c and 
cument of 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the doc
• Green: Will not scan green parts of the 

• Blue: Will not scan blue parts of the document 
 
Colour Dropout can be disabled for a part of the 
document by setting values in the Disable Dropout 
o . This is measured i
x mm from the top edge of the scanned image to x 
mm from the top edge of the image, where x is the 
value required. 

will disable the scanning of areas of the do
a particular colour. The settings are: 

 ument 

document 

ption n millimetres, and is applied 

Edge Emphasis This can be used to emphasise contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

1 to 5 and can be adjusted 

Canon DR-2050C & DR-2080C 
The DR-2050C and the DR-2080C are compact A4 workgroup scanner with 
a maximum scanning throughput of 20 pages per minute, or 39 images per 
minute when scanning double sided documents. They support black & white 
and 256 level greyscale scanning, and 24 bit colour. The maximum scanning 
resolution is 600dpi. 

The following picture shows the DR-2050C and DR-2080C Scanner setup 
screen. 
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Setting Description 

Page Size The ScanFile driver will automatically detect the size of the 
page being scanned if the Adjust option is selected. If it is 
not selected, the maximum scan size will be used, and the 
image may have a black border. 

Resolution The DR-2080C supports resolutions from 100dpi to 
600dpi. The resolutions available will be dependent upon 
the scanning mode selected. 

• Black & White/Greyscale 200-600dpi 
• 24bit Colour 100-400dpi single/double sided 
• 600dpi single sided 
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Compression ScanFile will store images in one of four ways: 

 
The type of compression and file format you select is 

dent upon several factors including the type of 
document to be scanned, and the type of output required 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 

 for black & white scanned images. This is a 
'lossless' compression format which means that none of 

 information is discarded. 

FF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes.
form ich t i d from the 

ompre sion poss le. It is p sible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Lura Document a Docu t is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files si
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 
Docu  scann ages

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

depen

of that document once stored. 

Group

is only used

the original scanned

JPEG (JTI

Jpeg is a 'lossy' compression 
hat data at, wh  means s discarde

original scanned image data to achieve the levels of 
c s ib os

: Lur men

zes. Lura document is also a 

ment ed im . 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 
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Mode This option is used to set the number of colours to be 
scanned. 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

Both scanners support 256 levels of Greyscale 

Colour 

Both scanner support 24 bit colour scanning. The larger 
the bit value selected, the more colour shades will be 
scanned. 

Please be aware that greyscale and colour scanning, 
espe sult in very large file 
sizes. 

cially at high resolutions, can re

Pages You can select whether to scan single or double sided 
documents. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. Both scanners 
have an automatic brightness function built-in, but this can be overridden and 
manually set if necessary. 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 
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Photo Mode 
In this mode, the Pho gs can be adjusted. 
Both scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

 can be any value between 1 and 255, 
ith 1 being the darkest setting, 255 being the lightest. A value of 0 will select 

auto brightness or contrast. To manually set a brightness or contrast value, 
untick the heckbox and select any oth uto by using the 
s a value

Canon DR-3020 
The Canon DR-3020 is a 40 page per minute black & white scanner with 

maximum paper size of 

utton. The 

to Brightness and Contrast settin

The brightness and contrast settings
w

Auto c er value as A
lide bar or typing in  between 1 and 255. 

automatic paper thickness and size detection, with a 
B4. Its automatic document feeder can take up to 100 sheets at a time, and 
these can be either single or double-sided documents. It has an industry 
standard SCSI-2 interface. The DR-3020 has a maximum resolution of 
300dpi. 

To configure the DR-3020 scanning options, ensure that the DR-3020 is set 
as the default scanner and then click on the Scanner Setup b
following window will then be displayed 
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Scan Resolution 
Th  Canon DR-30e 20 has three scan resolutions 

• 200x200dpi 

ments will slow the scanner to 11 sheets per 

• 300x300dpi 
• 300x150dpi 
 

The selected scan resolution will affect the quality of the image, and also the 
scan speed. At a resolution of 300 x 150dpi, scanning single sided 
documents, the DR-3020 will scan at 40 pages per minute. At 300 x300dpi, 
scanning double-sided docu
minute. 

Page Size 
The DR-3020 can scan up to A4 size pages. The paper size can be selected 
from the drop down list. By selecting Maximum, and clicking on the Adjust 
option, the DR-3020 will auto detect the paper size. 
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View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Text Mode. Photo Mode 
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Please note that the Photo mode option will result in 
larger scanned file sizes. 

y default, are displayed using black text on a white background. 
rsed, so that the document is 

ntation. 

 Auto option, and then selecting the 

 

C
ScanFile support several check scanners, which can read MICR Coded 
checks. The following check scanners are supported: 

can TS200 
• TellerScan TS300/350 

Some of the described settings may only apply to certain scanner models. 

Resolution 
The resolution can be 200x100 dpi or 200x200 dpi. Using 200x100 dpi 
scanning speed is bigger, but quality is less. The minor quality image is 

Documents, b
The Inverted option allows this to be reve
displayed with white text on a black background. 

The DR-3020 scans documents in 'portrait' format. For landscape 
documents, select the Rotate 90° option so that they will be displayed in the 
correct orie

When selected, the Front/Back scanning option will scan and store both 
sides of the scanned document. When not selected, only the front side of the 
document is scanned. 

Brightness Controls 
The Canon DR-3020 has an automatic brightness function, which should 
work with most documents. Unticking the
required brightness setting by using the slider bar, or by typing in the 
brightness value, between 1-255, can override this.

heck Scanner 

• • TellerS
• 
• • TellerScan TS400ES 
• • BUIC 1500 
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interpolated to a 200x200 dpi image. Select the resolution which serves your 
application best. 

MICR 
The MICR code can be read and stored to index fields of ScanFile folders. 
Select the relevant MICR type between CMC7 and E13B. 

In order to store the MICR information to ScanFile index fields you have to 
perform a test scan first. Afterwards the check will be displayed in the test 
scan display window and the adjoining MICR information will be displayed in 
the text fields below. For each of the different MICR information parts, you 
can select a ScanFile index field from a drop down list. When scanning 
checks, the relevant information will then be stored automatically in these 
fields. 

Axis 7000 
The Axis 7000 is a network scan server box that will allow across network 
scanning with any scanner that is attached and supported by it. 

Scanner Configuration 
There are many options that can be selected for any scanners attached to 
the Axis 7000, and these are defined in the Scanner Setup. The most used 
options are collected together on the first screen displayed when Scanner 
Setup is selected. 

The following screen dialogue shows the first screen displayed when 
choosing Scanner Setup for the Axis 7000. 
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Please note that any settings tha
dependant on the scanner that is at

t are defined for the Axis 7000 are 
tached to it. It is not possible to define 

which scanner is attached to it so the Axis 7000 must only be setup with the 
settings that are specific to that scanner.  

Scanner SCSI ID 
To be able to recognise the Axis 7000 Scan Server you must enter its IP 
Address and the User Name and Password that have previously been 
configured on the Axis 7000. The correct configuration of the Axis 7000 can 
be verified using your web browser, please refer to the Axis user manual for 
details on how to do this. 

Page Settings 
Any scanners attached that are capable of scanning single or double sided 
documents can have different settings applied for each side of a double sided 
document. The first option to select is whether to scan single or double sided, 
by selecting Front or Front/back scanning from the Pages drop down. 

The Adjust option sets the scanner to automatically detect the size of each 
page scanned, and will adjust the page size to the actual size of the 
document. 
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For each side, or both sides of a document, the following options can be set: 

Setting Description 

Page Size You can select any Page Size that is supported by the 
scanner attached, please check the relevant sections of 
this manual to verify which Page Sizes are available for 
each scanner. 

Resolution You can select any Resolution that is supported by the 
scanner attached, please check the relevant sections of 
this manual to verify which resolutions are available for 
each scanner. 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and halftones 
on the scanned document. This is useful when scanning 
photos.  

The Inverted option allows you to change from black on a 
white background, to white on a black background. 

Mode This option is used to set the number of colours to be 
scanned. You can select any colour mode that is 
supported by the scanner attached, please check the 

e be aware that greyscale and colour scanning, 

relevant sections of this manual to verify which colour 
modes are available for each scanner.  

Pleas
especially at high resolutions, can result in large file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are Portrait and Landscape 
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Compression ScanFile will store images in one of four ways: 

f output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 
Document scanned images. 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type o

Skew Correction 
This function is a software driver based skew correction facility that can be 
selected by a checkbox on the main scanner setup window. Should pages be 
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scanned at an angle through the scanner, and not appear straight when 
viewing, this option will straighten the page and justify it which will help when 
performing other actions such as OCR. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Canon MS-300, 350 & 800 
The Canon MS300, 350 and 800 microfilm scanners offers high speed and 
high resolution scanning and provide easy conversion and integration into 
existing digital environments. Full automatic search and retrieval/scanning 
functions are available via the optional FS Controller III, where the scanner 
supports it. 

Scanner Configuration 
The following screen shows the main settings screen displayed when 
choosing Scanner Setup for the MS-300, MS-350 or MS-800: 

 

Page 276 • Scanner Setup 



ScanFile User Guide 
Canon MS-300, 350 & 800 

Page Settings 
A number of options can be set which will affect the size, quality and 
orientation of the documents being scanned. These are in the View section 
on the Scanner Setup screen.  

The tables below and on the following pages show the available settings. 

Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm (ISO) 
• B4 - 257 x 364 mm (JIS) 
• B5 - 176 x 250 mm (ISO) 

 

tting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

• B5 - 182 x 257 mm (JIS)
 
If Fit Image is enabled, this se

Resolution You can select one of the following resolutions 200, 300, 
400 and 600 dpi (Dots per Inch) 

With the above settings the horizontal scan resolution is 
the same as the vertical resolution. 
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Mode The scanners support bla
scanning 

ck & white and greyscale 

The scanners support 4, 16 & 256 levels of 

le scanning, especially at 
t in extremely large file sizes. 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

Greyscale 

Please be aware that greysca
high resolutions, can resul

Dither hen scanning in black and white mode. 
r diffusion to simulate greys and half-
anned document. This is useful when 

hotos. 

Use this setting w
This applies erro
tones on the sc
scanning p

Rotation A document can be scanned and then rotated and saved. 
otation options are 0°, 90°, 180° or 270°. The available r
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Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 

scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 

sless' compression format which means that none of 
 original scanned information is discarded. 

 for 
Jpeg images which will determine how much data is 

opped' form the original scanned image, and will 
ically affect the size of the file produced. 

s to 

Document scanned images. 

• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 

'los
the

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels

'dr
rad

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale image
dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
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dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

he 

ing the slide bar or typing in a value 
between 1 and 255. 

e Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

st settings can be any value between 1 and 255, 
tting, 255 being the lightest. A value of 0 will select 

The microfilm scanners MS300/350/800 can use the Canon FS Controller III 

The MS300 and 350 have an A4 Portrait screen and the MS800 an A3 
Landscape screen. On the MS800, the screen can also be separated into two 
A4 portrait zones or a centred A4 portrait zone. This setting will affect how 

Text Mode 

When the Auto is selected, the scanner will automatically sense t
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by us

Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When th

The brightness and contra
with 1 being the darkest se
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Feeder Selection 

for automatic film advancement while scanning. Additionally, an automatic 
fiche carrier is available in some countries. 

Scan Area Setting 

Page 280 • Scanner Setup 



ScanFile User Guide 
Canon MS-300, 350 & 800 

the docum
follows: 

ents being displayed are scanned. There are four settings as 

Setting Description 

Left This will scan the left A4 portrait zone 

Centred Scans the Centred A4 zone 

Separated Scans the left and right A4 portrait zones, and stores the two 
pages separately. 

Overlaid This mode can scan two A4 portrait halves and combines 
m in to one A4 portrait. Each half on the A4 Portrait is 

centred within the left and right A4 portrait zones. The scan 
the

from the right zone will be the top half of the page and the 
bottom half will be from the left zone. 

Extended Settings 
This option can be used to set whether to use the front panel of the scanner 

ther than ScanFile itself. E.g. if you selected the option, 
pressing the green button on the front 

to control scanning, ra
you have to start the scan process by 
panel of the MS-800. 

FS Controller III 
This section describes the setup and initialisation of the scanner with the FS 
Carrier III. A full description of this will be available in the FS Carrier III 
manual. 

Blip Level Description 

1 Pageblip 

2 File – Pageblip 

3 Batch - File- Pageblip 

 

 1 Blip 2 Blip 3 Blip  

Shift + F +  Store    Return 
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Password    149 149 149 Return 

1 Search Mode    Return 

Mode # 5 2 3 Return 

Canon Meth No No No Return 

Ser Progr. 8 13 13 Return 

Std Blip Yes Yes Yes Return 

Neg. Blip Yes Yes Yes Return 

N/P Key on No No No Return 

Stand Slice Yes Yes Yes Return 

Count No No No Return Splice 

(Set)=#1 DOC Yes Yes Yes Return 

Enable (Auto) No No No Return 

Indexing --- No No Return 

Send Address No No No Return 

Input OK Yes Yes Yes Return 

8 X   Plus Key     

Exit    Return 

 

Mode Setting  

Film adjust vertical SHIFT +  or  Return 

Film adjust horizontal SHIFT + 4 then Yes or No Return 
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FS Controller III – Scanning with Batch- + File 
    

Shift + F  + Store   Return 

Password 149  Return 

1 Search Mode   Plus Key 

2 Machine setup   Return 

Trailer stop No  Return 

Mod F&C nstd No  Return 

E/M detect Yes  Return 

Key buffer No  Return 

Face U/D set No  Return 

Face down Yes Scan in ascending order Return 

Face down No Scan in descending order Return 

Adrs prt set No  Return 

Address prt No  Return 

Japanese MSG No  Return 

Input OK Yes  Return 

7 X Plus Key    

Exit   Return 

Canon MS400 & 500 
film reader printers have an optional SCSI kit to enable Canon’s digital micro

them to be used as PC scanning devices. Two modes are supported – 
manual or automatic feed scanning. With automatic feed scanning, an FS 
Carrier III will be required, as well as blipped films. 

The maximum resolution of the MS scanners is 400dpi. 
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Scan Resolution 
The MS400 & 500 have three scan resolutions 

View Options 
These options will affect how the images are stored and displayed. Standard 

oto Mode 

The scanned documents can be rotated 90 degrees clockwise by selecting 
the Rotate 90° option so that they will be displayed in their correct 
orientation. 

• 200x200dpi 
• 300x300dpi 
• 400x400dpi 

documents will normally be scanned using the Text Mode. Ph
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Please note that the Photo Mode option will result 
in larger scanned file sizes. 

Documents, by default, are displayed using black text on a white background. 
The Inverted option allows this to be reversed, so that the document is 
displayed with white text on a black background. 
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Film Type 
Use this option to set the type of film loaded into the microfilm scanner. The 
Auto option will automatically detect the type of film loaded. 

Feeder 
t the type of feeder used on the microfilm 

scanner. It can be set for the Canon FS Carrier III, or Auto Fiche Carrier. For 

Please note that these feeder options may not be available in all countries. 

ity 
These settings allow you to adjust the brightness and contrast settings for 

in the FS Carrier III 
manual. 

This option allows you to se

the Auto Fiche Carrier, the Communication port and baud rate being used 
must also be set. 

Please check with the supplier of the microfilm scanner for availability. 

Sensitiv

each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

FS Controller III 
This section describes the setup and initialisation of the MS400/500 with the 
FS Carrier III. A full description of this will be available 

Mode Description 

I Page 

II File - Page 

III Batch – File - Page 

VII File – Page 

 

 Mode I Mode II Mode III Mode VII  

Shift + F +  Store     Return 

Password    149 149 149 149 Return 
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1 Search Mode     Return 

Mode # 1 2 3 7 Return 

Canon Meth Yes No No No Return 

Serge Progr. 31 13 13 10 Return 

Ser. Level 1 --- --- --- Return 

Std Blip Yes Yes Yes Yes Return 

Neg. Blip Yes Yes Yes Yes Return 

N/P Key on No No No No Return 

Stand Slice Yes Yes Yes Yes Return 

Count Splice No No No No Return 

(Set)=#1 DOC Yes Yes Yes Yes Return 

Enable (Auto) Yes No No No Return 

Indexing --- No No No Return 

Send Address No No No No Return 

Input OK Yes Yes Yes Yes Return 

8 X   Plus  Key      

Exit     Return 

 

SW103 – with FS Controller III 

1 2 3 4 5 6 7 8  

x x x • x x x x On  

• • • x • • • • Off 
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SW103 – Without FilePrint 300 

1 2 3 4 5 6 7 8  

• x x x x x x x On 

x • • • • • • • Off 

 

Mode Description 

Film adjust vertical SHIFT +  or  then + or - 

Film adjust horizontal SHIFT + 4 then Yes or No then Return 

Canon Canofile 510/510S 

setup for the Canofile CF510 and 
Canofile CF510S. 

The Canofile 510 is a standalone electronic filing system with a built-in 50 
page per minute double-sided scanner. This has been discontinued by 
Canon. However, the CF510 has a SCSI connection which enables it to be 
attached to a PC and used as a scanner. Only certain CF510s can be used 
as scanners, so please check with Canon to ensure compatibility. 

The screen below shows the scanner 
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Scan Resolution 
The CF510 has two scan resolutions 

• 200 x 100 dpi 
• 200 x 200 dpi 

ocument during scanning, and result in better 
quality scans of pictures. Please note that the Photo Mode option will result 

es. 

 the front of a 
document only or both sides of a document. For double-sided scanning there 
are two options. Front/Back scanning will place each side of the document 
into a separate page. Choosing Front/Back One Page will result in both 
sides of the document being stored as one image. 

View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Standard Mode. Photo mode 
scanning will enhance the d

in larger scanned file siz

Each document scanned by the CF510 will have a Black border up to the 
maximum paper size of the CF510 scanner. Choosing the Crop Border 
option removes this border. 

The CF510 has a double-sided scanner, this can be set to scan
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Brightness Controls 

T

river should work with software applications supporting the TWAIN 

AIN 
device driver itself. The TWAIN interface will be displayed when scanning is 

upon the scanner settings can be applied. 

ning. 

ression capabilities to 

 Transmission option. 

Kofax 
st image processing boards for PCs to allow them 

The scan brightness settings can be adjusted manually to suit the documents 
being scanned. Alternatively, the Auto option can be used to allow the 
scanner itself to determine the optimum setting. 

WAIN 
ScanFile has support for TWAIN compliant devices. TWAIN is an open 
standard device driver for scanners, and any scanner supplied with a TWAIN 
device d
standard. 

The scanner settings for TWAIN devices are set directly within the TW

started from ScanFile, where

When selecting Scanner Setup from the Options menu, the TWAIN setup 
screen will be displayed. From this screen you can select whether the TWAIN 
device driver interface will be displayed, and therefore whether you can 
change the current settings. If you choose not to display the screen the 
scanner will immediately start scan

If the scanner is a double-sided device, choosing the Use duplex mode will 
set the scanner to double sided scanning. 

Some TWAIN scanners have built-in image comp
reduce the amount of information sent between the scanner and the PC. If 
the scanner has this capability, it can be selected by choosing the Use 
Compressed

Kofax manufacture speciali
to support high-speed scanners from companies such as Bell & Howell and 
Kodak. A TWAIN driver is available for the KOFAX scanner. 
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Overview 
Built in to ScanFile are utilities that will assist you if you experience problems 
with any of your folders or libraries. For this case ScanFile offers following 
functions to maintain and repair folder and libraries.  

The functions do not replace a regular backup. You should always take 
regular backups of all your ScanFile folders and libraries to prevent loss of 
data. 

M

ords or records pointing to missing document 

s such as these can occur if the PC was switched off during 

atically correct such problems, and 
therefore the concerned index records will have to be deleted, and the 

 rescanned. 

aintain Folder 
This utility is available from File -> Maintain Folder. ScanFile will check a 
folder for any errors within the database and for missing or corrupt document 
files. If any incorrect index rec
files are found, a record of these will be written to the file Error.log, which is 
created in the PC’s TEMP directory. 

Problem
scanning or deleting, if the hard disk became full or corrupt, or if document 
files have been deleted from the ScanFile folder from outside of ScanFile. 

Unfortunately, there is not a way to autom

documents

The Maintain folder utility may take some time to run but it is strongly 
recommended before writing a folder to archive write-once devices. 

R

this option from the 
File -> Repair Folder menu. This will attempt to repair and compact the 

abase may become fragmented on the 
 performance. Compacting the database will 

rewrite it to a single area of the hard disk, and will also free any unused 

epair Folder 
If you experience a problem when trying to open a folder, you will be 
prompted to run the Repair folder utility. You can select 

folder database. Over time, the dat
hard disk, which will affect its

space in the database caused by deleted records. In most cases, running this 
utility should resolve problems with the folder. 
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Repair Library 

 compact the library. The 

Just like ScanFile folders, it may happen that you experience a problem 
when you are trying to open a library. You will be prompted to run the Repair 
library utility. This option can be selected from the Libraries -> Repair 
library menu. This will attempt to repair and
database will be rewritten to a single area of the hard disk, and will also free 
any unused space in the database caused by deleted records. In most cases, 
running this utility should resolve problems with the library. 

Maintenance • Page 293 



ScanFile User Guide 
Repair Library 

 

Page 294 • Maintenance 



ScanFile User Guide 
Repair Library 

Remote Services 

Remote Services • Page 295 



ScanFile User Guide 
Overview 

O

ool, which is used to 
configure the service. Once the Remote service has been configured the 

ion Tool doesn’t need to be running for the Remote Service to be 

verview 
Included in the ScanFile setup is a server-based application called Remote 
Services. In version 7 this application was a configuration tool and executing 
program in one. In Version 8 the Remote Services is in two parts: the 
Remote Service and the Remote Service Configuration T

Configurat
active. 

The modules available, subject to the options that have been purchased, are: 

 
Import of Electronic Documents 

 
Import of Files & Index 

 
Import of Indexes Only 

Library Update
 

 * 

 
Import of COLD data * 

 
Document Routing * 

 
Audit Trail * 

 
TIFF Spooler ** 

 
Fulltext OCR reading * 

 
Zone OCR reading * 

 
Retention Control 

ScanFile VNP * 
 

 

* Features marked with an asterisk are additional purchases to the ScanFile 
core application 

** depending on the tasks you want to carry out, you may need an OCR and 
Forms Recognition licence 
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Remote Services (Windows Service) 
The Remote Service carries out the scheduled tasks. This application has 

lly designed to be run on Microsoft Windows NT4 and 2000 
ons that may act as a workgroup 

the system process must continue to run for the duration of the required 
son it is intended to be run only on 
r.  

P menu option. ScanFile VNP is described later in this 

stalled with the start type “Manually”. 
Therefore it is inactive after installation and is not automatically started after a 
reboot. If you want to use the functionalities of the Remote Service, go to 
Start -> Settings -> Control Panel -> Administrative Tools -> Services. 
Select ScanFile Remote Service. With the right mouse button, select 
Settings to display the ScanFile Remote Service Properties. The tab 
General contains the start type. Change it from ‘manually’ to ‘automatically’. 
This way the service will be started right after a reboot. Close the Service 
Control Panel. With right Mouse -> Start you can now start the service. 

User Account 
The Remote Service utilises the local system account to access its 
resources. The access rights of the local system account are limited. You 
should assign a user account that provides the necessary access rights. 

We recommend to create a new user account for the Remote Service. If the 
Remote Service has to access network resources, this should be a domain 
account.  

been specifica
Servers or NT4, 2000 and XP workstati
server. The Remote Services application will be installed and automatically 
started during the installation of ScanFile.  

When the Remote Services are installed, the Remote Service will be added 
to the list of server services. By default, this will be configured to use the local 
system account for its permissions. The Remote Service will require full 
access to the ScanFile program directory and to the ScanFile folders 

If stopped, the Remote Services application will not perform its purpose, as 

times and dates scheduled. For this rea
servers, or workstations acting as a serve

In addition to the services mentioned above, if the optional ScanFile VNP has 
been installed, the configuration and monitoring application for this can be 
started and stopped from within Remote Services Configuration Tool, from 
the ScanFile VN
Guide. 

Configuration 
The Remote Service is per default in
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In case you are working with the ScanFile Account, please ensure that 
ScanFile and the Remote Service work with the same user account. 

Permissions 

The user you create must have Logon Locally rights and have permissions to 
change data on the following locations: 

• ScanFile program directory 
• ScanFile folders drive(s)/directories 
• ScanFile library drive(s)/Directories 

Remote Services Configuration Tool 
The Remote Services Configuration Tool is used to setup and schedule the 
modules to run at set times and dates for their individual purpose. The 
program runs as a separate application to the main body of ScanFile but still 
requires information from folders and libraries created and maintained by 
ScanFile to be able to operate correctly. 

Electronic Document Service  
The Electronic Document Scheduler gives you the facility to automatically 
save documents to specific ScanFile folders. Any document saved or copied 
to a named directory will be archived into that directory’s designated ScanFile 
folder. In contrary to version 7, the amount of monitored directories is not 
limited. 

Update Schedule  
The days, time period and frequency of the Scheduler can be set by 
choosing the Scheduler option at the left of the main screen. The values set 
determine when the directories will be searched for new documents to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day for which the update will 
be performed by entering the start time and end time in the From and To 
fields.  
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You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

Folder 
To select a ScanFile Folder to import documents from the Search directory, 
click on the Add button below the folder list. You can then select the folder 
from the available storage locations. Once you have selected the folder, it will 
be shown in the folder list. To specify the search and backup drive and the 
indexing options, the folder must be selected in the folder list, by clicking on 
the folder name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Search Drive 
The Search Drive should point to the location where documents are going to 
be saved or copied to. This can be a directory on a drive or a UNC path. After 
selecting the Folder you can specify the location by clicking on the three dots 

 then display a directory find screen. 
click on the OK button, and the name 
.  

Backup Drive  
When the scheduler imports the files from the Search location to the 
specified ScanFile folder, the file(s) will be deleted from the Search location. 
To enable you to keep a copy of the file(s) outside of ScanFile, you can 
select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately after 
the field, which will then display a directory find screen. Once you have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field. 

Indexing Options  
Documents can be imported into a ScanFile Folder in one of two ways, and 
the file name can be used for automatic indexing of the documents.  

1) Postindex  

When the Postindex option is selected, all documents found to be archived 
will be placed in the selected ScanFile Folder’s Postindex pool for later filing.  

immediately after the field, which will
Once you have selected the location, 
of the location will be shown in the field
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2) Using the File Name  

The option together with the 

, comma  ; semi-colon   . full stop 

 _ underscore   ‘ quote 

ocument’s file name can be used to fill selected index fields 

K

Direct Index Use filename as default index 
will save the documents directly to the folder, creating index records for each 
document saved, and placing the name of the file into the FIRST folder field.  

Separator 

If you also select a Separator, the name of the file can be delimited so that it 
can be placed into separate consecutive Folder fields. Valid separators are:  

- dash 

 

Selective Indexing & Keywords 

When Direct Indexing is selected and Use filename as default index is not 
selected, the d
and to assign keywords. This is achieved by prefixing the index data in the 
file name with &I and the Folder field Number. 

 

&

Example: - using a semi-colon as the separator 

D Smith Ltd;Quotation;01/06/2000.doc 

Field 1 = D Smith Ltd  
Field 2 = Quotation  
Field 3 = 01/06/2003 

Pag
Example: 

&i1D Smith Ltd&i2Quotation&i401/06/2000.doc  

Note that there is no entry for Field 3  
eywords can be assigned to the documents by prefixing each keyword with 
K  
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Example: 

&i1D Smith Ltd&i201/06/2003&kQuotation&ksoftware.doc  

Field 1 = D Smith Ltd  
Field 2 = 01/06/2003 
Keyword = Quotation, Software 

Separators and Prefixes are replaced by an underscore in the filename 
during the import. 

Update Now  
Th s functionality gives you the opportunity to import documenti s from the 

 
u

C
Thi
Scheduler gives the facility to automatic

t
fold  

, 

 frequency of the document scheduler can be set 
r option at the left of the main screen. The values 

required.  

search drives fast and out of schedule. Pressing the Update Now button will
ca se the Remote Services to perform an update with the next update loop. 

OLD Import Service  
s scheduler only works, if the option is licensed. The COLD Import 

ally save COLD data information to 
specific ScanFile folders using a pre-defined indexing template. Any COLD 
da a saved or copied to a named location will be archived into the ScanFile 

er that the location is associated with. An unlimited amount of ScanFile
Folders can be specified, with each Folder pointing to a different location
and using a different COLD template.  

Update Schedule  
The days, time period and
by choosing the Schedule
set determine when the directories will be searched for new COLD files to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days 
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You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
g a value in minutes in the Update every… field.  

lick on the Add 
button below the folder list. You can then select the folder from the available 
storage locations. Once you have selected the folder, it will be shown in the 
folder list. To specify the search and backup drive and the import template, 

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Search Drive  
The Search Drive should point to the location where the COLD files to be 
imported are saved or copied to. This can be a location on a drive or a UNC 
path. You can specify the location by clicking on the three dots immediately 
after the field, which will then display a directory find screen. Once you have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field.  

Backup Drive  
When the scheduler imports the files from the Search location to the 
specified ScanFile folder, the file(s) will be deleted from the Search location. 

you have 

be performed, by puttin

Folder 
To select a ScanFile Folder to import the COLD data to, c

the folder must be selected in the folder list, by clicking on the folder name. 
The name will then be highlighted.  

To enable you to keep a copy of the file(s) outside of ScanFile, you can 
select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately after 
the field, which will then display a directory find screen. Once 
selected the location, click on the OK button, and the name of the location 
will be shown in the field. 

Import Template  
You must specify the pre-defined COLD import template to be used with the 
ScanFile Folder. The template will have been created in ScanFile previously.  
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You can specify the import template by clicking on the three dots immediately 
after the field, which will then display a template list. Once you have selected 
the template, click on the OK button, and the name of the template will be 
shown in the field. 

F

ot limited. 

U
The days, time period and frequency of the document scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 
set determine when the directories will be searched for new documents to be 

ders.  

and end time in the From and To 

 field.  

Folder 
T can the search directory, 
c  button below the folder list. You can then select the folder 
f e available lected the folder, it will 
b wn in the backup drive and the 

Update Now  
This functionality gives you the opportunity to import COLD files from the 
search drives fast and out of schedule. Pressing the Update Now button will 
cause the Remote Services to perform an update with the next update loop. 

iles and Index Import Service  
The Files and Index Scheduler gives the facility to automatically save files 
and ASCII or ANSI data files to specific ScanFile Folders. Any files and 
indexes saved together, and copied to a named directory, will be archived 
into that directory’s designated ScanFile folder, providing the information is in 
the correct format. In contrary to version 7, the amount of monitored 
directories is n

pdate Schedule  

added to the specified fol

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day during which the update 
will be performed by entering the start time 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every…

o select a S
lick on the Add

File Folder to import documents from 

rom th
e sho

 storage locations. Once you have se
folder list. To specify the search and 
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f folder m  on the folder 
name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
nd then click on the Delete button below the folder list.  

can be a location on a drive or a UNC path. You can 

t a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately after 
the field, which will then display a directory find screen. Once you have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field. 

Fields 
Enter the number of fields the index information contains along with the field 
separator and delimiter. Then select whether the index information is 
contained in an ASCII or ANSI format. 

Update Now  
This functionality gives you the opportunity to import files and index 
information from the search drives fast and out of schedule. Pressing the 
Update Now button will cause the Remote Services to perform an update 
with the next update loop. 

ield, the ust be selected in the folder list, by clicking

a

Search Drive  
The Search Drive should point to the location where data to be imported is 
saved or copied to. This 
specify the location by clicking on the three dots immediately after the field, 
which will then display a directory find screen. Once you have selected the 
location, click on the OK button, and the name of the location will be shown 
in the field.  

Backup Drive  
When the scheduler imports the files from the Search location to the 
specified ScanFile folder, the file(s) will be deleted from the Search location. 
To enable you to keep a copy of the file(s) outside of ScanFile, you can 
selec

Page 304 • Remote Services 



ScanFile User Guide 
Index Import Service 

Index Import Service  
The Index Scheduler gives the facility to automatically save ASCII or ANSI 
data files to specific ScanFile Folders as index information. Any indexes 
saved and copied to a named directory, will be archived into that directory’s 
designated ScanFile Folder, providing the information is in the correct format. 
In contrary to version 7, the amount of monitored directories is not limited. 

With the index only scheduler the folder that the index is being imported to 
must already have the correct information saved in one of the ten connect 
fields, this allows the information in the data file to be imported into the 
correct fields. You must select which format the data is in ASCII or ANSI and 
the number of fields, field separator and field delimiter.  

Update Schedule  
The days, time period and frequency of the document scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 
set determine when the directories will be searched for new documents to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day during which the update 

will 
be performed, by putting a value in minutes in the field.  

To select a ScanFile Folder to import index information into, click on the Add 
button below the folder list. You can then select the folder from the available 

ve selected the folder, it will be shown in the 
ch drive, the connected field and the linked 

index fields, the folder must be selected in the folder list, by clicking on the 

will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update 
Update every… 

Folder 

storage locations. Once you ha
folder list. To specify the sear

folder name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  
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Search Drive  
The Search Drive should point to the location where the index data file is 

index records in existing folder 
ocuments with additional information. As an example, bar-coded documents 
ay have been scanned, with the barcode representing a Project Number. 

An external file – MS Access or ASCII format – can have that number in it 
plus the Document Name, Document No etc. The Project Number can be set 
to be the Connect field, and the additional index information will then be 
imported to the appropriate records.  

located. This can be a location on a drive or a UNC path. You can specify the 
location by clicking on the three dots immediately after the field, which will 
then display a directory find screen. Once you have selected the location and 
data file name, click on the OK button, and the name of the location will be 
shown in the field.  

Fields  
The Import Index function is used to fill 
d
m

 

The example text file shows 10 records, with the index information within the 
records being delimited by commas. The first field is the Project Number – 
the Connect field – which will already exist in the folder. The Import will use 
this to search for matching records, and then fill the other folder fields with 
the additional information.  

The Folder fields will be displayed on the left, and the fields from the import 
file can be matched to these. It is very important that the No. of fields, 
parameter is correctly set, as well as any field separators and delimiters  

Update Now  
This functionality gives you the opportunity to import index information from 
the search drives fast and out of schedule. Pressing the Update Now button 
will cause the Remote Services to perform an index update with the next 
update loop. 
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Library Update Service  
This scheduler only works, if the option is licensed. On the contrary to version 
7, an unlimited amount of locations can be selected to check for libraries that 
are set to scheduled update. 

Setup Libraries  
The Scheduler will update only libraries that have been set for scheduled 
updating. To do this, open Setup library in ScanFile, select the library from 
the list on the left of the screen, and then ensure that the Scheduler 
checkbox is ticked. Once this is done, press the Apply button.  

Update Schedule  
The days, time period and frequency of the library update scheduler can be 
set by choosing the Scheduler option at the left of the main screen. The 
values set determine when the directories will be searched for libraries to be 
updated.  

k the checkboxes 

You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

Library Directories 
To select a directory or path where libraries can be found on, click on the 
Add button below the folder list. You can then select the directory from the 
available storage locations. Once you have selected the directory, it will be 
shown in the library directory list. 

The scheduler will update any library with the Scheduler setting in the 
selected drives/paths. The system will check, if any of the imported folders 
has been updated since being imported into the library. In this case the data 
in the library is updated according to the folder data.  

Repeat this step for every directory or path you want to automatically update 
libraries on. 

To select the days for the update to be performed, tic
alongside the days required.  
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To remove a ScanF
and then click on th

ile Folder from the list, highlight the name by clicking on it 
e Delete button below the folder list.  

d the directory, it will be shown in the folder directory list. 

This functionality gives you the opportunity to update libraries located in the 
search drives fast and out of schedule. Pressing the Update Now button will 

e Services to perform a library update with the next update 

D
nt Routing 

nts specific 
route. Every 5 minutes the service will check all routed documents, and if all 

 particular document, 
the document will be progressed to the next step within the route. Therefore 
the scheduler timer settings are disabled. 

 

splayed, such as the index 

Folder Directories 
To select a directory or path where folders that were added to libraries can 
be found on, click on the Add button below the folder directory list. You can 
then select the directory from the available storage locations. Once you have 
selecte

Repeat this step for every directory or path folders needed for the automatic 
update are located on. 

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Update Now  

cause the Remot
loop. 

ocument Routing 
This scheduler only works, if the option is licensed. The Docume
Scheduler progresses documents through each step of a docume

the actions within a routing step have taken place for a

In Progress Documents 
Documents that are currently In Progress within a route will be listed in the 
service window and by double-clicking on one of the documents, further 
information about the document will be di
information, and it's routing history to date. This will include the date and time 
of a routing action, the type of action and the name of the user.  
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Update Now  
This functionality gives you the opportunity to route fast and out of schedule. 
Pressing the Update Now button will cause the Remote Services to perform 
an update with the next update loop. 

Audit Trail 

ty within 
and you may 

iod. The 
 service 

This scheduler only works, if the option is licensed. The Audit Trail service 
allows authorised users to maintain the audit database. Dependent upon 
what events you have decided to audit, and the level of activi
ScanFile, the audit database can become extremely large, 
therefore decide that certain events can be deleted after a time per

ce every 24 hours from the time thestandard schedule, which is on
was started. Therefore the scheduler timer settings are disabled. 

If you do not wish to delete any audit  events, do not run the Audit Trail 
service.  

Never Delete Automatically  
You can select which types of events will not be deleted automatically when 
the service is operating. When the event types are ticked, they will NOT be 
deleted.  

Audit Trail Exportpath 

th should point to the location where the export 
database should be saved to. This can be a location on a drive or a UNC 

E

Deletion Period  
The number of days, after which events can be deleted, is in the range of 1 to 
999.  

Export Audit Trail Data  

The Audit Trail Exportpa

path. You can specify the location by clicking on the three dots immediately 
after the field, which will then display a directory find screen. Once you have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field.  

xport audit trail data 
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If you wish to 
the opportuni

export data, click on Export audit trail data. You will be given 
ty to add a description to your export. Then the program 

ase  
dea to periodically run the Compact database option, as this will 
tabase for any errors and compact it, removing deleted records.  

 schedule. Pressing the Update Now button will 
cause the Remote Services to perform an update with the next update loop. 

T
ervice allows the automatic import and recognition of forms, and works 

in conjunction with the form templates created and configured within 

Update Schedule  
y of the document scheduler can be set 

ys required.  

 end period during the day during which the update 
ring the start time and end time in the From and To 

the Update every… 
field. The valid range is 1-9999 minutes.  

automatically exports all records to a newly created database in the Audit 
Trail Export Path, named with the current date and time. 

In the ScanFile Audit Trail Report window you can then select from the 
exported databases and create a temporary Audit trail database to search in. 

Compact Datab
It is a good i
check the da

Update Now  
This functionality gives you the opportunity to delete events from 
SFAudit.mdb fast and out of

IFF Spooler Service  
This s

ScanFile. The forms to be imported must be Group 4 compressed TIFF 
format files or JPEG files.  

The days, time period and frequenc
by choosing the Scheduler option at the left of the main screen. The values 
set determine when the directories will be searched for new documents to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the da

You can set the start and
will be performed by ente
fields.  

Specify how often, in minutes, that the service will check the image storage 
path for new documents, by putting a value in minutes in 
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Folder 
To select a ScanFile Folder the forms will be imported and indexed to, click 
on the Add button below the folder list. You can then select the folder from 
the available storage locations. Once you have selected the folder, it will be 
shown in the folder list. To specify the image storage path, backup directory 

th  
Select the location that the service will check for documents to import from. 

ou have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field. 

Form Database  

Create batch  

 one page are stored as one document.  

and the form database, the folder must be selected in the folder list, by 
clicking on the folder name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Image Storage Pa

The service will check only this location for forms to import. Documents, 
which should be automatically imported and indexed must be placed here.  

Backup drive  
When the scheduler imports the files from the Image Storage path to the 
specified ScanFile folder, the file(s) will be deleted from the storage location. 
To enable you to keep a copy of the file(s) outside of ScanFile, you can 
select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately after 
the field, which will then display a directory find screen. Once y

Select the database that contains the form templates. The default forms 
database is default.sff, which is in the ScanFile program directory, although 
this can be changed.  

This setting is for documents created by ScanFile VNP archive printing. In 
this case documents with more than
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Update Now  
This functionality gives you the opportunity to import forms from the search 
drives fast and out of schedule. Pressing the Update Now button will cause 
t

Fulltext OCR Scheduler  

talled and licensed. This 
service will automatically perform full text recognition on selected folders. Any 

ave not been OCR'd in the folders will be processed on the 
 and time.  

To select a ScanFile Folder to have the full text OCR performed upon, click 
on the Add button below the folder list. You can then select the folder from 

Delete button below the folder list.  

the left of the main screen. The values 
set determine when the folders will be searched for new documents to be 
OCR'd.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

he Remote Services to perform an import with the next update loop. 

Overview  
This scheduler only works, if option OCR is ins

pages that h
selected days

Folder 

the available storage locations. Once you have selected the folder, it will be 
shown in the folder list. 

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the 

Update Schedule  
The days, time period and frequency of the fulltext OCR scheduler can be set 
by choosing the Scheduler option at 

Page 312 • Remote Services 



ScanFile User Guide 
Zone OCR Scheduler 

Update Now  
This functionality gives you the opportunity to perform a fulltext OCR fast and 
o . P
S orm

Zone OCR Scheduler  

Overview  
This scheduler onl
service will automa gnition on selected folders. Any 
documents that have not been zone OCR'd in the folders will be processed 
o ay

Folder 
To select a ScanFil
the Add button belo
available storage lo
shown in the folder 

T
and then click on th

U ed
The days, time period and frequency of the zone OCR scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 
et determine when the folders will be searched for new documents to be 

zone OCR'd.  

To select the days for the update to be performed, tick the checkboxes 
.  

ut of schedule
ervices to perf

ressing the Update Now button will cause the Remote 
 an OCR reading with the next update loop. 

y works, if option OCR is installed and licensed. This 
tically perform zone reco

n the selected d s and time.  

e Folder to have the zone OCR performed upon, click on 
w the folder list. You can then select the folder from the 
cations. Once you have selected the folder, it will be 

list. 

o remove a ScanFile Folder from the list, highlight the name by clicking on it 
e Delete button below the folder list.  

pdate Sch ule  

s

alongside the days required

You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  
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Update Now  
This functionality gives you the opportunity to perform a zone OCR fast and 
out of schedule. Pressing the Update Now button will cause the Remote 
Services to perform an OCR reading with the next update loop. 

Retention Control 

Overview  
A retention period can be set for each document. This is specified in months 
and will apply either from original creation or from the date of last updating. 
At the expiry of the forward period each document may be selectively moved, 
exported “off-line” or destroyed. 

Add a Folder to the Retention -Control 
The retention control will only monitor folders that are set for it. To add a 
folder to the retention control, select File – Setup folder in ScanFile. Select 
the folder in the folder list and switch to the tab Extended Settings. Select 
Retention control scheduler - Add Folder checkbox. 

 

Update Schedule  
T rio
be set by choosing the Schedul
v etermi
processed according canFile. 

o select the days for the update to be performed, tick the checkboxes 

Folder 
To select a ScanFile Folder to be monitored for retention action, click on the 
Add button below the folder list. You can then select the folder from the 
available storage locations. Once you have selected the folder, it will be
shown in the folder list.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

he days, time pe d and frequency of the Retention Control scheduler can 
er option at the left of the main screen. The 

alues set d ne when the documents in the selected folders will 
 to their retention settings assigned to them in S

T
alongside the days required.  
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You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

This functionality gives you the opportunity to perform the defined retention 
Update 

ices to perform an update with the 

ScanFile VNP Service 

NP, a licensed option of ScanFile, allows you to create up to 8 
virtual network printers which can be used to ‘print’ documents to specified 
locations on either local or network storage media. These documents, which 

t can then be imported automatically 
g the Electronic Document Scheduler 

service, or if the documents being printed are standard forms, by using the 

Activation and Deactivation 
If ScanFile VNP has been installed, the configuration and monitoring 
application for this can be started and stopped from within Remote Services 
Configuration Tool. ScanFile VNP settings are described later in chapter 
ScanFile VNP.  

Select the ScanFile VNP button in the toolbar. To activate ScanFile VNP 
Service click on the displayed Start button. To deactivate ScanFile VNP 
Service click on the displayed Stop button. 

 

Update Now  

actions for the documents fast and out of schedule. Pressing the 
Now button will cause the Remote Serv
next update loop. 

Overview 
ScanFile V

are converted to Group 4 TIFF forma
into specific ScanFile folders by usin

TIFF Spooler service which can then recognise the forms and perform zone 
OCR on them to automatically index the documents. 
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ScanFile VNP 
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Overview 
ScanFile VNP, an option of ScanFile, allows you to create up to 8 virtual 
network printers which can be used to ‘print’ documents to specified locations 
on either local or network storage media. These documents, which are 
converted to Group 4 TIFF format can then be imported automatically into 
specific ScanFile folders by using the Electronic Document Scheduler 
service, or if the documents being printed are standard forms, by using the 
TIFF Spooler service which can then recognise the forms and perform zone 
OCR on them to automatically index the documents. 

ScanFile VNP accepts documents in PCL5 format for conversion to TIFF G4 
format. 

A new feature in Release 7 is the addition of the Rapid32 printer driver which, 
when associated with a VNP printer port, generates Full text OCR 
information from the source data which can then be imported into ScanFile 
along with the TIFF files. 

Installation 

VNP is totally automatic apart from asking you for the 
use. Once VNP is installed, it is ready to be configured. 

C
The configuration of  VNP to enable documents to be automatically imported 

ScanFile VNP can be installed in one of two ways; as an option when 
installing ScanFile, or independently by running SETUPVNP.EXE from the 
ScanFile CD. 

The installation of 
language VNP will 

During the installation process, VNP will have installed the VNP application 
and also created 8 new printer ports called Printplex 1, Printplex2, etc 

onfiguration 

into ScanFile is in 4 parts: 

• Create the virtual printers using the Printplex printer ports 
• Configure the VNP 
• Set up the TIFF Spooler service or the Electronic Document service to 

import the documents into specific ScanFile folders. 
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Virtual Printers 
The virtual printers can be created on a standalone workstation or on a 
network server, which will then allow all authorised network users access to 
the VNP option. Creating 'standard' printers using a PCL 5 compatible printer 

ult in TIFF files being created for the pages printed. Printers 
 the Rapid 32 printer driver will create Full text OCR data files in 

Standard Printer: 

will create a virtual printer that will convert the printed output to 
TIFF format files in the location specified. 

press Next 
• Select the port you wish the printer to use. Choose one of the 8 available 

Next. 
P LaserJet 5 from the list of available printers, and press 

ter. Once you have done 

 the virtual printer on a server, you can share the printer 

Finish on the next screen will then create the printer. 
 
Repeat the above process for as many printers as you wish to create, using a 
different PrintPlex port for each printer. 

Rapid 32 Printer driver: 

This option uses the Rapid 32 printer driver supplied with VNP, and will 
convert printed output to TIFF files and create data files containing the text of 
the printed output, which can then be imported to allow for Full text searching 
of the documents. 

The installation is the same like installing a ‘standard’ printer. Instead of using 
the HP LaserJet 5 click on the Have Disk… button open the Rapid folder 

driver will res
created using
addition to the TIFF files. 

To create a virtual printer, select Printers from the Settings option on the 
Windows Start menu, and then select Add Printer. Within the Add Printer 
Wizard. 

This option 

• Press the Next button 
• Choose Local printer, but do not choose to detect the printer 

automatically, and then 

PrintPlex ports and then press 
• Select the H

Next. If there is already an HP LaserJet 5 printer configured, choose to 
keep the existing driver. 

• You can then give the printer a meaningful name that will identify it as a 
virtual printer used by ScanFile for importing documents. You can also 
choose whether the printer will be the default prin
this press Next. 

• If you are creating
to network users. Once you have chosen whether to share the printer or 
not, press Next. 

• You do not need to print a test page, so select No, and then press Next 
• Pressing 
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that is located in the ScanFile directory. Select the INF file and when the 
printer list is displayed, select Rapid 32, and press Next. Go on with the 
installation like you would install a standard printer. 

Configure VNP 
The VNP application is used to monitor the activity as well as to configure the 
virtual printers. To open the VNP application, start ScanFile Remote 
Services and select ScanFile VNP from the TIFF spooler option on the 
Services menu. The following screen will then be displayed. 

 

When you first start VNP, before any documents have been printed to the 
virtual printers, no jobs will be listed. 
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From th lect Master-Configura reen, you 
can select the location which all documents to be converted will be saved to 
prior to conversion. By default, this will be <ScanFile folder>\vnp\spool. To 
select another location, type it in the Path to Spo

You can choose how many Jobs will be listed in the VNP window at any one 

All other options should be left at their default values. Once you have 
selected the spool directory and the number of jobs to be displayed, press 
OK to save the settings. 

n the Configuration-Archive settings screen from the File menu. 

e File menu, se tion. From this sc

ol directory field. 

time by entering the required value in the Max Jobs field. The Auto convert 
to TIFF option will be selected by default, and this should be left selected, as 
should the Auto remove job after Archive option, which removes 
documents from the spool directory after they have been converted to TIFF. 

To set the location for each PrintPlex port to save the converted documents 
to, ope
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By default, all PrintPlex ports will be set to save the converted documents to 
<ScanFile folder>\vnp\archive, which will be shown in the Tiff path field. 
This can be changed if you wish them to be saved to a different location. 

If you want the documents that are printed using different PrintPlex ports to 
be saved to different locations, as outlined earlier in this section, you must 
first select Archive path depends on input. This will enable the dropdown 
list which will allow you to choose which PrintPlex port to configure. Select a 
PrintPlex port from the list and type the import path for this port into the Tiff 
Path field. In this way you can choose a different location for every PrintPlex 
port. 

Select the Force Multipage TIFF option if you wish multi-page prints to be 
saved as one document. Do not select it if you wish all pages printed in one 
job to be treated as separate documents. 

Once you have configured the ports press the OK button, and the changes 
will be saved. 

To configure the TIFF Spooler or Electronic Document service, to 
automatically import the converted documents into specific ScanFile folders, 
please see the Remote Services chapter. 

VNP Activity 
The VNP application window is also used to monitor the activity of the virtual 
printers. Please note that the VNP application must be open for it to convert 
print jobs to TIFF. Until the application is opened, the documents printed will 
be queued in the specified spool directory. 

Each document printed to a virtual printer will be listed in the Job window. 
Each document will have a Job name, which will be the printer name plus a 
job number, and a job status. The status will be one of 5 values: 

Value Description 

Spooling The document is currently being printed 

Tiff waiting The job is waiting conversion to TIFF 

TIFF The job has been converted to TIFF 

Archive The job is being written to the save location 

Delete Wait The job is awaiting deletion 
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The Start and End time o
well as a comments field, 

f the processing of each job will also be shown, as 
which will normally contain ‘No comment’. 

Job Information 

You can select to remove a job from the list by right-clicking on the Job ID 
and selecting Remove. 

If you chose not to have documents automatically converted to TIFF on the 
Master-Configuration settings screen, you can manually do this by right-
clicking on the Job ID and selecting Convert to TIF. 

Additional information concerning a particular job in the list can be seen by 
double-clicking on the Job ID. The Info tab on the displayed screen will allow 
you to change the name of the job, and to add a comment concerning the 
job. 

 

Selecting ou to see the document as it has been 
processed. Information concerning the conversion such as resolution and 
paper size will be shown as well as small images of each page of the job. 

the Preview tab will allow y
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If he job is a multi-page dot cument, you can page through it by using the 
buttons at can also view a copy of the current 
page in Imaging by pressing the VNP button in the middle of the page 
controls. 

If there are files in text, PCL5, Diablo 630 or IBM ProPrinter format that have 

rting a Job from a file will be taken 
from those set using the Configuration bar just below the menu bar in the 
VNP application window. This works much like a printer menu system. 

ress the Online button so that the status 

Within a menu option, use the Previous/Next buttons to choose the available 
 the Enter button to set a value. 

 the bottom of the screen. You 

Importing Jobs 

been saved previously and you want to import these into ScanFile, you can 
do this by selecting the Create Job from File option on the VNP File menu. 
This option will import, convert the data, and then save the TIFF files to the 
Default location as specified in the Configuration –> Archives screen. 

The settings that will be used when impo

To access the menu options p
screen shows Menu Level 1. Use the Previous/Next buttons to select the 
menu and then press the Enter button to select a menu. Use the 
Previous/Next button to choose the menu options, and press the Enter 
button to select a menu option. The Escape key can be used to return to the 
previous level. 

values, and
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O

 partners, are demanding 
I anFile WebServer is 
u ternet technology to 
u

 WebServer, you can give anyone, anywhere in the world 
r document libraries. ScanFile WebServer is an Internet server 

Features 

•

B
ScanFile WebServer requires that the person installing and configuring 

h both Microsoft Windows NT4/2000/XP 
Server. 

verview 
Companies are rapidly embracing Internet technologies, supporting remote 
and mobile users and implementing corporate intranets using the web 
browser as the universal desktop client application. As this trend continues, 
internal and external users, such as customers and
nternet access to corporate document repositories. Sc
niquely positioned to deliver the vast benefits of In
sers. 

With ScanFile
access to you
based application that allows the retrieval of documents using just a web 
browser. Whether you wish to make documents available over the Internet or 
an intranet, ScanFile WebServer is the fast, secure, reliable and easy way to 
do it.  

Used together with ScanFile, you have everything to store and reference 
your documents, and then retrieve them no matter your location. 

• Full search, display and download options on ScanFile document 
libraries, including full text search 

• Users only have access to authorized libraries 
• Fully automatic update of libraries 
• No additional client software required - just use a web browser 
• Any type of document stored in ScanFile can be displayed or 

downloaded. 
 Complete audit trail report on accessed documents 

efore Installing 

WebServer is fully conversant wit
and Microsoft Internet Information 

As the majority of internet/intranet servers are separate to a company’s main 
server, links between the servers will have to be established with the 
appropriate rights given to those links to allow users of WebServer access to 
libraries and documents. The default user account created for Internet 
Information Server (IIS) – IUSR_<machine name> - will have insufficient 
permissions to allow ScanFile WebServer to function correctly. As changing 

Page 326 • ScanFile WebServer 



ScanFile User Guide 
Installation 

the permissions for the default user could cause security problems for other 
applications you may be running via IIS, or the server running IIS is not the 
same server as that running ScanFile or where the folders/libraries reside, 
the best course of action is to create a new user specifically for use with 
ScanFile WebServer. 

drive(s)/directories 
• ScanFile libraries drive(s)/directories 

f 
the programs and data, and what format of partition they reside on. You 

ser account and permissions for the ScanFile program 
ocations prior to installing WebServer. After WebServer 

has been installed, the permissions to the WebServer program directory can 

In

must have access to a Licensed installed copy of 
 to enable it to use the User security information when 

Permissions 
The user you create should be a Local User, not a Domain user. If the 
ScanFile location, or the folders/libraries are on a separate server then you 
will need to create a local user on each server, using the same name and 
password. This user requires permissions to the following locations: 

• ScanFile WebServer program directory and subdirectories 
• WebServer image cache directories (if different from the default) 
• ScanFile program directory 
• ScanFile folders 

 
The type of permissions you can apply will be dependant upon the location o

should create the u
directory and data l

be applied. 

stallation 
To install WebServer, select Run… from the Windows Start menu and then 
choose SetupSWS.exe from the Software directory on the ScanFile CD. 
Press the OK button. 

The first step is to choose the language that you wish WebServer to be in. 
Choose the desired language and press OK. 

ScanFile Location 
ScanFile WebServer 
ScanFile. It needs this
users access libraries via WebServer. Select the ScanFile program directory 
and then press the Next button.  

The ScanFile path can also be entered as a UNC path 
Example: \\<machinename>\path. 

ScanFile WebServer • Page 327 



ScanFile User Guide 
IIS Configuration 

Location 
You must then choose where ScanFile WebServer is to be installed. The 
default directory, can be used, but this assumes that WebServer is not being 
installed on the same server as ScanFile. Please ensure that WebServer is 
not installed as a sub directory of the ScanFile program directory, as no 

version if necessary. If 

WebServer API 
n API that allows you to integrate it's functionality into your 

II
t be configured 

to allow users access to WebServer. The following installation instructions 

Services Manager, you must create a new 

users require direct access to the WebServer directory. Once you have 
chosen the location to install WebServer, press the Next button to carry on 
with the installation. 

Backup 
If you are updating an existing copy of WebServer, you can choose to 
backup any files that are replaced during the installation. If you select Yes, it 
will be possible to perform a Rollback to the previous 
you choose No, the previously installed copy will be overwritten, and a 
rollback will not be possible. 

WebServer has a
own web sites. You can select whether you want to install the API or not. 
Contact your supplier on how to obtain a full description of the WebServer 
API. 

ScanFile WebServer is now ready to be installed. Pressing the Next button 
on the screen shown right will install WebServer into the selected directory. 
After this has completed, the Internet Server must be configured. 

S Configuration 
After installing ScanFile WebServer your Internet Server mus

are for Microsoft Internet Information Services supplied with Microsoft 
Windows 2000. 

Virtual Directory 
After you have started Internet 
Virtual Directory for WebServer in your web site. To do this, right-click on 
your web site and then select New -> Virtual Directory. 
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A welcome screen will then be displayed. Click on Next and you will then be 
prompted for the name that you wish to give to the ScanFile WebServer part 
of your site. This can be anything, but a short name is more useable. After 

Next, you must then enter the path to the 
Server Directory for the content of the site. You can either type 

in the location or use the Browse button to locate the directory. 

default 
permissions. Once you have set the permissions, the WebServer setup is 

ctory Security tab. You must then edit 
the Anonymous access and authentication control properties. Click on 

 the Authentication Methods screen will open. 

You must then edit the Account used for anonymous access property. This 

he Allow IIS to control password option. Once you 
have done this, the WebServer configuration within IIS is complete. 

C

Example: 

SFWeb, and the site is called 
scanfile.com, entering http://www.scanfile.com/sfweb will display the 

typing in a name and pressing 
ScanFile Web

The next part to configure is the Access Permissions. This will determine 
what rights users will have when they access the WebServer site. For 
standard access, you do not normally need to change from the 

complete. 

WebServer user 
If you have created a user account for WebServer to use in IIS, this must 
also be configured. To do this open the Properties screen for the WebServer 
virtual directory, and select the Dire

the Edit button, and

can be done by clicking Edit. This will then open the Anonymous User 
Account screen, which allows you to select the user account that you 
previously created from WebServer to allow access to ScanFile libraries. 

You must also disable t

onfiguring WebServer 
Once you have created and configured the Virtual Directory, you can then log 
on to the WebServer site you have just created by opening your browser 
software and typing in the name of the site together with the alias you 
selected for the WebServer Virtual Directory.  

If the Virtual directory has been called 

ScanFile WebServer login screen. 

To access ScanFile libraries via WebServer, each user must log in. The user 
names, passwords, and the libraries the users are allowed access to is 
defined within the Security setup of ScanFile.  
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The first time you use WebServer, it will report that it is unlicensed. Please 
see the WebServer section in the Licensing chapter on how to license 
WebServer. 

To licence and configure WebServer, you must login as using the ADMIN 
user. 

Library Drives 
The first time you load WebServer, no libraries will be displayed in the Open 
Library list box. This is because WebServer does not yet know where to look 
for the ScanFile libraries. To configure WebServer, press the Settings 
button. The different settings are described below. 

Settings 
Only Administrator users will get this Settings screen displayed. All other 
users are only able to set their language and JPEG quality threshold, along 
with a download password. 
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The WebServer application can search up to 8 drives for ScanFile libraries. 

n a separate server and no drive mappings exist, the 
Universal Naming Convention (UNC) can be used. The format for this is: 

ame>\<sharename> 

These can be specified in the Library Drives section of the Settings screen. 
The drive references must correspond to the drives the WebServer is able to 
manage. 

If the libraries are held o

\\<servern

The Settings page used to configure the Library Drives also includes other 
settings, which are described below: 
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Option Description 

JPEG Quality This is a user specific setting that determines the quality 
images that WebS lay. The lower 

This can be useful for viewing large JPEG’s over a slow 
. 

of JPEG 
the setting, the lower the qualit

erver will disp
y of the displayed image. 

modem link

Language This is another user specific setting, which allows you to 
select the language that the page text will be displayed 

le languages a man, French 
and Japanese. Please note that you will have to be 
running a Japanese version of Windows to view 
Japanese text correctly. 

in. The availab re English, Ger

LuraDocument The LuraDocument setti gs allow you to specify how 
documents saved in the LuraDocument format are 

nd d wnloaded. o display Lura format 
documents in Lura format, you will need the Browser 
plug-in loaded. This is available for download from 
www.scanfile.com, on the Updates page. Alternatively, 
you can select to have them converted to GIF/JPEG form 
before display or downloaded, in which case, your 

 browser will be able to display the documents. 

n

displayed a o T

standard

Session Timeout This allows you to specify the period of inactivity after 
which a user will be required to log in again. This also 
frees the user license. 

Logout Page You can set a URL that WebServer will go to when a 
user logs out of ScanFile. You must specify a page 
location. 

 

Im
Each time a user views a document using ScanFile WebServer, a copy of 

 made in the Image Cache. This can significantly enhance 
al times. 

age Cache 

that document is
document retriev

The location of the image cache will, by default, be set as a subdirectory off 
the WebServer program directory. You can however choose a different drive 
and directory by typing the location into the Cache path setting box.  
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The Cache URL is the name of the directory you have selected to set for the 
cache, following by a forward slash. 

deleted are selected. The Delete Mode 
has two options: 

The maximum size that the image cache will be allowed to reach can be 
dictated by entering a value in Megabytes into the Cache Size settings box.  

When the Cache reaches its predefined size, it will make room for new 
documents by deleting documents held in the cache. You can choose the 
criteria by which the documents to be 

Option Description 

Least Accessed 
Out 

The documents that have been accessed least will be 
removed from the cache 

Oldest Out The documents that have not been accessed for the 
longest period will be removed from the cache 
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Each time a 
cached, a re

user retrieves a page of a document, not only is the page 
cord of the retrieval is also written into a log file, called 

 number of days it is to be kept in the Hold log data (days) field. 
The default value is 90 days. 

ll cached documents, selecting Purge cache images 
K button will do this. 

Opening WebServer 
r, the address of the WebServer site needs to be 

h will then display the WebServer login 

CACHE.MDB, which will be in the IMGCACHE directory of the selected 
Image Cache location. The time that a retrieval record is kept can be set by 
typing in the

If you wish to remove a
now and pressing the O

To access WebServe
entered in the browser software, whic
page. 

 

En er a valid St canFile user name and password and then press the Login 
t  details are correct, the Open Library page will then be 

displayed. 
bu ton. If the
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O
lect the ScanFile Library you wish to 

open by highlighting the Library name in the list, which only shows the 
at the ScanFile user is allowed access to. 

pen Library Page 
From the Open Library Page, you can se

Libraries th

 

You can also choose to set your user preferences by clicking on the Settings 
button, which will then display the Settings page. 

Settings 
The screenshot below shows the setting page with the options a normal user. 
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Option Description 

JPEG Quality The JPEG Quality setting will affect the time taken to 
view colour images, and can be set from 1 to 100 with 
100 being the best quality. 

Page 336 • ScanFile WebServer 



ScanFile User Guide 
Open Library Page 

Language This i
to se

s another user specific setting, which allows you 
lect the language that the page text will be 

displayed in. The available languages are English, 
German, French and Japanese. Please note that you 
will have to be running a Japanese version of Windows 
to view Japanese text correctly. 

LuraDocument The LuraDocument settings allow you to specify how 
documents saved in the LuraDocument format are 
displayed and downloaded. To display Lura format 
documents in Lura format, you will need the Browser 

you can select to have them converted to GIF/JPEG 
form before display or downloaded, in which case, your 

plug-in loaded. This is available for download from 
www.scanfile.com, on the Updates page. Alternatively, 

standard browser will be able to display the documents.

 

Library Search 

When you open a Library, the Library Search page will open. This allows you 
 the search criteria for the documents you wish to retrieve. The fields 

associated with the library will be displayed as well as the keyword list, if any. 

e performed, and you can also choose to 
search across all folders in the library, or just a specific folder. Multiple 

ed. When you have entered your search 
k on the Search button, which will then produce a Hitlist of 

matching documents. 

to enter

The list of folders imported into the library will also be displayed. 

Wildcard and range searches can b

keyword selections are also support
criteria, clic
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The Clear Fields
You can retu

 button will clear any search information previously entered. 
rn to the Open Library page by press the Library button, or 

logout by pressing the Logout button. 

 
the Full text search/Index search button at the top of the Search page will 
display the search page. 

 or a phrase, and this can be an AND or 

l be displayed on the Hitlist page, with up to 13 hits 
displayed on a page. For a standard search, each hit will refer to a complete 
document whereas for a full text search, each hit refers to a page within a 
document, so there may be several hits that reference the same document. 
The Hitlist can be sorted by any of the fields, by clicking on the Field name at 
the top of the Hitlist. 

OCR Search 
You can also perform full text searches on the library, if full text OCR 
recognition has been performed on the folders within the library. Clicking on

You can search on multiple words,
an OR search. 

Search Results Page 
The results of a search wil
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If more than 13 hits are found, you ca
navigation buttons at the bottom of the H

n page though the hits by using the 
itlist. 

 

FastPics 
By default, the Search results page will display thumbnail representations of 
the pages of a record at the bottom of the page. You can choose whether 
these are displayed or not by pressing the FastPics on/off button at the top 
of the page. If there are more pages in the document that can be displayed in 
the FastPics frame, a scrollbar will appear on the right of the frame. 

Memos 
If a document has had a memo attached to it from within ScanFile, this will be 
indicated in the memo column by a tick. Clicking on the tick will then show 
the contents of the memo. You can return to the Search Results page by 
pressing the Back button. 

Download 
Clicking on the Disk icon at the end of each record, will allow you to 
download the document to your PC. As complete documents can consist of a 
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mix of file types, such as scanned images, MS Word and Excel documents 
etc, these will be bundled together within a ZIP file. 

Viewing Documents 

When you select a document for viewing, the first page of the document 
selected will be displayed, or the page selected from the FastPics or Full text 
search. 

 

How a document is viewed will be dependent upon the type of document 
being viewed, and which browser software you are using. All black & white 
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and scanned documents 
page.  

can be viewed directly within the Document View 

Rotate Page 180° Rotate Page 270° 

educe Page Size 

Electronic format documents such as MS Word & Excel documents require 
that the source application be present. Applications such as Microsoft Word 
and Excel can be opened within Internet Explorer, and therefore these format 
documents will be viewed with the Document View page. For Netscape, 
these applications will be opened independently of the browser. 

Document Viewing Tools 
On the left of the Document View page are a number of tools that allow you 
to alter how a document is viewed, and to select the document, or page of a 
document to be viewed. 

Rotate Page 0° Rotate Page 90° 

Enlarge Page Size R

View Next Page View Previous Page 

Go to 1st Page Go to Last Page 

Go to Previous 
Document on the Go to Next Document 

Hitlist  

In addition to the tools above, you can select the page

on the Hitlist 

 number to view and 
Document View Page. You 
 level by typing the page 

number and clicking on the Show button. The zoom level can be selected 
from the drop down list. 

the zoom level using the options at the top of the 
can choose which page to view, and its zoom

 

The Download button will download, in ZIP format the currently displayed 
page. 

You can return to the Hitlist or the Search pages by pressing the appropriate 
button on the left of the Document View page, or you can Logout by pressing 
Logout. 
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Introduction 

oteStation Server, which will then store them to the 
selected ScanFile document folders. In addition, the RemoteStation Client 
can be used for retrieval from your ScanFile document store. RemoteStation 
is an ideal application for centralised scanning workstations and to allow 
remote offices access to your ScanFile document store. 

An advanced function of RemoteStation Server is it's ability to act as a 
master server, allowing users to store documents to slave RemoteStation 
Servers, therefore allowing a central user access point for storing documents, 
which can then be distributed to ScanFile document stores located 
elsewhere. 

RemoteStation features include the scheduled sending of documents to the 
RemoteStation server, support for TWAIN scanning devices and the sending 
of electronic format documents, and when scanning, to select between single 
and multi page file scanning. 

This chapter explains how RemoteStation Server is installed and configured, 
nstallation and configuration of the RemoteStation 

K
The Key Features are: 

Remote ScanFile Document Stores 
ScanFile registered users 
Email 
Networked Printers 
Local printers 

Support for the following Canon scanners: 
DR-3020 DR-3060 
DR-3080c DR-5020 
DR-5080c DR-5060F 
MS300 MS350 
MS400 MS500 
MS800 
TWAIN Devices 

ScanFile RemoteStation is a client-server application that allows you to store 
documents to a central ScanFile store from any location. Using TCP/IP 
connectivity, combined with ScanFile security, client workstations can send 
documents to the Rem

and also covers the i
Client. 

ey Features 

• TCP/IP based Client/Server architecture 
• Scan or Send Documents directly to: 

• 
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• Comprehensive Security 
Logon by username/password 
Full Audit log of all activity 
Encrypted document transmission 
IP Range Restrictions 

Requirements 
RemoteStation Server and Client are 32bit applications that have been 
designed to use a minimum amount of server/workstation and network 
resource.  Special attention should be paid to ensuring that the specification 
of any Client workstation is sufficient to meet the requirements of any 
attached scanner, and the types of documents being scanned and/or viewed. 
Further details on these are given below. 

RemoteStation Server 
RemoteStation Server must be installed on a Microsoft Windows 2000 or 
2003 Server with TCP/IP protocol loaded. Please ensure that the latest 
service packs for the operating system have been applied.  RemoteStation 
Server will require access to the ScanFile program directory and to the 
location of your ScanFile folders. 

Clients 
The specification of RemoteStation Client workstations is very important, and 
if incorrectly configured can affect the scanning and retrieval performance. 
The specification is dependent upon which operating system you run, what 
other applications you may be running and which scanners you may have 
attached to the workstation and what type of scanning you are performing. 
Much of this will also apply to workstations that are only used for retrieval 
purposes. 

If colour scanning and viewing is a requirement, you must also ensure that 
the graphics adaptor and monitor are suitable for viewing the documents, and 
that the workstation has sufficient RAM to allow for data to be processed. If 
there is insufficient RAM in the workstation, the operating system will use the 
hard disk as virtual memory. This however will dramatically affect the 
performance of the workstation. 
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The minimum recommended specification for a workstation is as follows: 

• Personal computer using a 400Mhz Pentium II Processor 
• 128MB RAM 
• 17” Display 
• CD-ROM Drive 
• 4GB Hard Disk Drive. 
• MS Windows 2000 Professional 

Before Installing 
RemoteStation server consists of a server service that utilises the local 
system account to access its resources. If the server running RemoteStation 
Server is not the same as that running ScanFile or where the folders/libraries 
reside, you must create a new user specifically for use with RemoteStation. 
This is also necessary if you intend to use the Printing option which allows 
Clients to scan & print documents to printers that the RemoteStation server 
has permissions for. 

Permissions 
The user you create must have Logon Locally rights and have permissions to 
the following locations: 

• ScanFile RemoteStation Server directory and subdirectories 
• ScanFile program directory 
• ScanFile folders drivea(s)/directories 
• Printers 
 
The type of permissions you can apply will be dependant upon the location of 
the programs and data, and what format of partition they reside on. You 
should create the user account and permissions for the ScanFile program 
directory and data locations prior to installing RemoteStation. After 
RemoteStation has been installed, the user account can be applied to the 
service and the RemoteStation server program directory. 

Server Installation 
To install RemoteStation Server, select Run… from the Start Menu and then 
choose SetupSRSServer.exe from the Software directory on the ScanFile 
CD. Press the OK button. 

The first step is to choose the language and press OK. 
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ScanFile Location 
RemoteStation server must have access to a Licensed installed copy of 
ScanFile. It needs this to enable it to use the User security information when 
users access folders using the RemoteStation Client. Select the ScanFile 
program directory and then press the Next button. 

The ScanFile path can also be entered as a UNC path 
Example: H\\<machinename>\path H. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory than the RemoteStation Server software will be installed into. A 
default of C:\ScanFile\SRS will be offered, however, this assumes that 
RemoteStation is not being installed on the same server as ScanFile. Please 
ensure that RemoteStation is not installed as a sub directory of the ScanFile 
program directory, as no users require direct access to the RemoteStation 
directory. Once you have chosen the drive and directory, press the Next 
button. 

Backup 
You will then be asked whether the install program should backup any files 
that the installation process will replace. These can be older versions of 
RemoteStation components - if you are installing over an existing installation 
- and common Windows components held in the Windows or 
Windows/System directories. If you choose to backup these components, 
you will be offered a default location of <Installation path>\Backup. 

Please note that the installation process will only replace older versions of 
common Windows components.  

RemoteStation Server is now ready to be installed. After this has completed, 
the application must be configured. At the completion of the installation you 
will be asked to reboot the server. 

RemoteStation Service 
When RemoteStation Server is installed, the ScanFile RemoteStation service 
will be added to the list of server services. By default, this will be configured 
to use the local system account for its permissions. However, if the ScanFile 
and/or the ScanFile folders it requires access to are on a different server, the 
use of the local system account will be inapplicable. The RemoteStation 
service will require full access to the ScanFile program directory and to the 
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ScanFile folders to be used with RemoteStation. Please see the Before 
installing section above. For information about creating a user account for the 
service to utilise. 

Server Configuration 
When RemoteStation server is first started, it will report that it is not licensed. 
Please see the RemoteStation section of the Licensing chapter in the manual 
for instructions on RemoteStation licensing. 

RemoteStation Server is in two parts; the RemoteStation Service, which will 
be automatically loaded, and the RemoteStation Server application, which is 
used to configure the RemoteStation Service and can also be used to 
monitor the service activity. Once the RemoteStation service has been 
configured the server application need not be running for the RemoteStation 
server to be active. 

When starting the RemoteStation Server application a screen with 5 tabs will 
be displayed. To configure the server service select the Configuration tab. 

Identification 
This section is used to set the IP address and the Port to be used by 
RemoteStation Server. The server Computer name will be automatically 
shown, and the IP can be selected by choosing from the available server IP 
addresses shown in the drop down list. The default Port is 2042, but this can 
be changed if required. If the IP address is changed from the default value, 
the RemoteStation server service will have to be stopped and restarted. 

Pressing the Advanced… button allows you to enter some descriptive 
information concerning the RemoteStation Server.  

The Description entered will be the one used by all RemoteStation Clients 
connecting to this server to identify the server. 

Contact details for the support of the server, consisting of Telephone and 
Fax numbers, and an email address can also be entered. 

Local Settings 
RemoteStation Server holds a log of transmissions from clients, and the 
Days field under Hold Transmission log determines the period that this log 
can be held for. If a client fails to complete a transmission to the server, 
details of this are held within the log. You can select whether this information 
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is kept, even though the transmission log is cleared by selecting the 
Preserved Failed Transmissions option. 

Pressing the Advanced… button will open a settings screen, from which you 
can set the location of the ScanFile folders and configure SMTP mail 
settings.  

RemoteStation Server needs to know the location of the ScanFile folders to 
be made accessible to RemoteStation Clients.  The entries can refer to local 
drive paths or to UNC paths. Pressing the Add button will allow you to enter 
the appropriate path. Please note that the network user account used by the 
RemoteStation service (default: local system account) must have 
permissions to the drives and or UNC locations. 

The location of the ScanFile 2003 program directory is shown in the 
ScanFile Path field, and can be amended if required. 

The SMTP settings of your mail server can be entered to enable 
RemoteStation Client users to email non-ScanFile users. You will need to 
enter the Domain name, Host name and the Port (default: 25). 

Server List 
RemoteStation servers can be linked to one another, allowing users to store 
and retrieve documents from more than one ScanFile document store. When 
a user logs on to a RemoteStation server, the server will attempt to validate 
the user name and password using the local security database. If the user 
name is not found locally, the server will then attempt to validate the user 
name on one of the additional servers defined within the server list. If it is 
successful, then the permissions that have been assigned to the user on that 
server will be applied. 

For each additional server, a user name and password must be created on 
that server to be used as the Share user, which enables users who are not 
registered on that server to store and retrieve documents from the server 
depending upon the permissions assigned to the share user. 

To create an additional server, press the Server list button and then select 
Add. You can then assign the additional server a Description, which is used 
to identify the server to users. 

You must then enter the IP Address and Port being used by the additional 
RemoteStation server, as well as the name of the Share User of that server 
and the share users Password. 

Additionally, contact details for that server may be added, which consist of 
Telephone number, Fax number and Email address. 
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The additional RemoteStation server's details can be edited by choosing the 
Edit option on the Server list, or deleted by choosing the Remove option. 

Security 
Specific IP Addresses or IP ranges can be added to the Security option to 
either allow or not allow them access to the RemoteStation server. Each time 
a RemoteStation Client attempts to connect to a RemoteStation server, the 
IP address of the Client will be checked against the entries in this list. 

You can select whether the IP addresses added to the list will be Granted 
access or Denied access, by choosing the appropriate option. 

To add an IP address to the list, select the Add option, and then enter a valid 
IP address and subnet mask. 

The entries in the list can be edited by selecting the Edit option, and 
removed using the Remove option. 

Connections 
The list of users currently logged on to the RemoteStation server can be 
monitored using the Connections option. Additionally, a Session Timeout 
period can be set (default: 20 minutes) which will automatically log out users 
which have been inactive for the timeout period, and therefore freeing up a 
license for other users. 

Events 
The Events display will list all activity that occurs on the RemoteStation 
server, such as connection requests, searches, and document transmissions. 
The number of Events that the list will hold at any one time can be selected 
by entering a number between 1 and 999999 into the Events to hold field. 
The Events display will also show the number of concurrent licences the 
server is licensed for and the number currently being used. 

RemoteStation Client 
The RemoteStation Client allows users to connect to RemoteStation servers 
and retrieve and store documents to those servers.  

To install RemoteStation Client, select Run… from the Start Menu and then 
choose SetupSRSClient.EXE from the SOFTWARE directory on the 
ScanFile CD. Press the OK button. 
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The first step is to choose the language and press OK. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory than the RemoteStation Client software will be installed into. A 
default of C:\Program Files\SrsClient will be offered and this should normally 
be accepted. However, if you wish to install it on a different drive and 
directory, then you can browse or type in the required path. 

The Destination directory selection dialogue will also display the available 
disk space on the chosen drive, as well as the space available after 
RemoteStation has been installed. Once you have chosen the drive and 
directory, press the Next button. 

Backup 
You will then be asked whether the install program should backup any files 
that the installation process will replace. These can be older versions of 
RemoteStation components - if you are installing over an existing installation 
- and common Windows components held in the Windows or 
Windows/System32 directories. If you choose to backup these components, 
you will be offered a default location of <Installation path>\Backup. 

Please note that the installation process will only replace OLDER versions 
of common Windows components.  

RemoteStation Client is now ready to be installed. After this has completed, 
the application must be configured. At the completion of the installation you 
may be asked to reboot the workstation. 

Client Configuration 
Selecting the option created in the ScanFile program group can start the 
RemoteStation Client. When the Client is started for the first time you will be 
asked to enter a password to be used to access the configuration options. 
Once you have entered this password, the Configuration screen will be 
shown 

Whenever you wish to configure the client, you can access the configuration 
screen by just entering the password you created above into the password 
field on the Client Login screen, without entering a user name. If the correct 
configuration password is entered, the configuration screen will be displayed. 
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Local Station settings 
The Client configuration will automatically detect the workstation Computer 
name and it's IP address and subnet mask. The subnet mask can be 
amended if required. 

Server Settings 
To enable the client to access a RemoteStation server it needs to know the 
computer name or IP address of the server. For private networks, either 
setting may be used, but for connections via the Internet, the IP address of 
the RemoteStation server must be entered. 

The Port the RemoteStation server uses must also be set. This will default to 
Port 2042. 

Once you have entered the server details, press the Tick icon at the bottom 
of the window, and the RemoteStation Client configuration is complete. 

Starting RemoteStation 
To start RemoteStation, select the RemoteStation Client from the ScanFile 
program group. You will then be required to login using a valid ScanFile user 
name and password. Once logged in the main RemoteStation menu will be 
displayed, showing 3 options: 

• View Protocol 
• Search 
• Scan/Send 

Keyboard 
If the RemoteStation does not have a keyboard attached, and is using a 
touch screen, a screen based keyboard can be used anywhere within 
RemoteStation by pressing the Keyboard picture at the bottom left of the 
RemoteStation screen. 

Tools 
RemoteStation uses standard icons throughout to navigate through the 
application. The main tools are described below. 
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Tool Beschreibung Tool Beschreibung 

 
Logout 

 
Search 

 Previous screen  Next screen 

 
Single Page Scan 

 
Mutli Page Scan 

 
Server or Workstation 

 
Internet Email 

 
Scan Document  

 
Select Document Source 

 
Send Document to 
Queue   

 

View Protocol 
This option can be used to monitor the status of scanning jobs waiting to be 
sent to a server, and also the history of specific types of jobs sent to the 
server. 

The time taken for scanning jobs to be sent to the server can be affected by 
several factors, the main one being the speed of the connection between the 
client and the server. 

Local Sending State 
This will show any documents queued locally that are waiting to be sent to 
the RemoteStation server. 

Serverside 
This option will show the job history for a user on a RemoteStation. All the 
jobs sent by a user to the Server can be listed. If there is more than one 
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RemoteStation server available to a user, you must first select the server you 
want to view the history on. You can then select the user. 

On the Settings screen, you can select to view the history for each of the four 
Send option: 

• Folder 
• User 
• Email 
• Printer 
Select one of these, and optionally add a single date or date range and then 
press the Forward button, and the send history will then be displayed. 

Search 
The Search option from the main RemoteStation menu will display the list of 
folders that the currently logged in user has rights to access. 

If there is more than one RemoteStation Server registered, then you will need 
to select the server that holds the folder you wish to search first. 

Search Screen 
Selecting the folder will display the Folder Search screen that will show the 
folder fields. Searching within RemoteStation gives the option to perform 
range searches within the selected folder, the first value being entered in the 
first field alongside a field name, and the second value in to the second field 
alongside the field name. 

You can also choose whether the search is to be an AND search or an OR 
search.. The AND search will result in producing a list of documents that 
match the search criteria entered into ALL fields. The OR search will list 
those documents that match the criteria entered into ANY of the folder fields. 

Once the search criteria has been entered, pressing the Search button will 
show the list of matching documents. 

Hitlist 
The Hitlist will show all documents that matched the search criteria entered. 
Each documents complete index information will be shown within its own 
separate 'box'. To view a specific document, click on the box. If a document 
has more than one page, FastPics of the pages will be displayed, but if the 
document only has one page, it will be immediately displayed. 
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You can return to the Search screen by clicking on the Back button. 

FastPics 
The FastPics display allows you to view in thumbnail format all the pages of 
the selected document, and then to select the page to view by clicking on the 
thumbnail. 

Viewing a Page 
The image viewing page can display one page of a document at a time. The 
page can be zoomed up or down, rotated or made to fit the display window. 

Scan/Send 
The Scan/Send option allows you to scan documents and then send them to 
one of four destinations: 

• Printer 
• Folder 
• User 
• Email 

Printer 
This option enables you to scan documents and have them sent to a local 
printer or a printer that the RemoteStation server has access to. The 
available server printers will be dictated by the configuration of the 
RemoteStation server. 

Printer List 

When selecting the Printer option, you must first select the location of the 
printer. This can be on the local workstation or on a RemoteStation server. 
Once selected, the available printers will be shown. If there is only one printer 
configured on the selected location, the Printer List will be skipped. 

Document Header 

After selecting the printer, you will be able to create a print header sheet onto 
which you can enter the following information: 

• Recipient 
• Originator 
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• Message 
 
Once this information has been added, press the Scan button to open the 
Scan screen 

Folder 
The Folder option allows you to scan documents to ScanFile folders that the 
currently logged in user has permissions to. If there is more than one 
RemoteStation Server registered, then you will need to select the server that 
holds the folder you wish to scan to first If the logged in user only has access 
to one folder on the server, a folder list will not be displayed. 

Folder Fields 

Once the folder has been selected, press the forward button to show the 
Folder fields, If the user only has access to one folder, the fields will be 
displayed automatically, without having to select the folder. 

From this screen you can enter the index information related to the document 
you wish to scan. You can also select the date and time that the document 
will be scheduled for sending to the RemoteStation server. This can be set at 
the bottom of the Folder fields display. Once this has been done, press the 
appropriate Scan button to open the Scan screen. 

You can select to scan single or multi-page documents. Selecting the Single 
page option will create a folder record for each page scanned. Selecting the 
Multi-page option will create a single folder record for all scanned pages. 

User 
This option allows you to send a scanned document to a registered ScanFile 
user. The documents will be sent to a users personal hitlist so that they can 
be accessed from within ScanFile. If there is more than one RemoteStation 
Server registered, then you will need to select the server that the user is 
registered on first  The list of users on the server will be displayed, and you 
can select one or more users to send the document to. Once you have 
selected the users, press the Forward button to show the index screen. 

Index Screen 

As the index data is not related to any ScanFile folder, the field names will be 
called Field 01 to Field 10.Any information entered will be shown in the users 
Personal Hitlist. Press the Forward button to open the Scan screen once you 
have entered the index information. 
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Email 
The Email option will send the scanned document to an internet email 
address. 

ScanFile Users 

When a user is created in ScanFile, an email address can be entered as part 
of the user information. This gives the option to send a document to a 
registered ScanFile users email address rather than to that users ScanFile 
Personal Hitlist. 

If there is more than one RemoteStation Server available, then you will need 
to select the server that the user is registered on first  The list of users on the 
server will be displayed, and you can select one or more users to send the 
document to. Once you have selected the users, press the Forward button to 
show the Email message screen. 

Internet Email 

This option will display the Email message screen, which will allow you to 
send a document to any valid internet email address. 

Email Message Screen 

On this screen, you can enter email addresses to send the document to. If 
you are sending to a ScanFile user, the Email field will be automatically filled. 
You can also select to copy the document to another user by entering the 
email address into the CC field. 

A Subject and email message can be added by typing them into the 
appropriate fields. 

Once you have completed the email message, press the Scan button to open 
the Scan screen. 

Scan Screen 
There are several options that can be set prior to scanning or importing, 
relevant to the type of document being scanned, and the source of the 
documents. Once these options have been selected, press the Scan button 
to scan the documents. 
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Document Source 
If you have a Canon DR range scanner attached to the workstation, this will 
be automatically detected, and you can start scanning immediately. If you 
wish to use a TWAIN device as the scanning source, you must first configure 
this. Pressing the Document Source button allows you to select whether the 
source is a Canon DR scanner, a TWAIN device, or an electronic document 
located on the workstation, such as an MS Word document. 

Canon DR Scanner 

If the selected source is a Canon DR range scanner, this scanner model is 
automatically detected, and the scan options available will be set accordingly. 

TWAIN Source 

When selecting the TWAIN source option, you will then have to select the 
device from the displayed list. You must ensure that the TWAIN driver for the 
device is installed correctly. When this option is used, pressing the Scan 
button in the RemoteStation Scan Screen will display the TWAIN source 
scan settings screen. 

EDOC 

This option allows you to select an electronic document from a storage 
device on the workstation. These can then be added to the current queue to 
be sent to the selected destination. 

Colour 
Three settings are available: 

• Black and White 
• Greyscale 
• Colour 

Resolution 
Three settings are available, and these will be dependant upon the attached 
scanner. The setting are Low, Medium and High resolution, which for the 
Canon DR5020/80c scanners would be 200, 300 and 400dpi. 

Brightness 
The scan brightness can be set from 1 to 255. for greyscale & colour, and 1 
to 7 for black & white 
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Text-Photo 
The Text option should be selected if the scan is black and white and it is not 
important as to the quality of any graphic elements contained on the 
document. 

The Photo option should be used when the documents contain graphic 
elements, such as photographs. This will scan the graphics at a higher 
quality than the Text option. 

Simplex-Duplex 
This option allows you to set whether the documents to be scanned are 
single or double-sided. 

Priority 
The Priority option allows you to set a level between 1 and 3 for a document. 
If many documents are waiting to be sent to the RemoteStation server, the 
documents with the highest priority will be sent first. 

Preview 
Any documents scanned can be previewed on the Scan screen before 
sending them to the RemoteStation server. They will be shown on the left 
side of the screen, and display tools are available to allow you to rotate and 
zoom the displayed image. If more than one page has been scanned, you 
can move between the pages by using the Up and Down arrows under the 
Documents option. The X under documents will delete the displayed page.  

Send Document 
Once you are happy with the scanned document, press the Send button, 
which will queue the document locally before sending it to the RemoteStation 
Server. Whilst sending, if the connection between the client and the server is 
broken, once it is re-established the document will once again be sent. The 
documents are queued locally until a successful transmission message is 
received from the server. 
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Scheduled Sending 
When scanning or importing documents to a ScanFile folder, you can select 
the date and time that the documents are to be sent to the RemoteStation 
server for adding to the folder. 

At the bottom of the Folder indexing screen, the current date and time will be 
displayed. You can amend this to the date and/or time that you wish the 
documents to be sent. Once you have completed the scanning and/or 
importing of documents, they are held in a queue locally until the scheduled 
date and time is reached, when the RemoteStation Client will attempt to send 
them to the server. 

You do not have to be logged into the RemoteStation Client for the 
documents to be sent, but the RemoteStation Client must be open. 
Additionally, if you are using a Dial Up connection to the RemoteStation 
server, this must be connected prior to the Client sending. 
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ScanFile Connector for 
ShareScan 
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Introduction 
With the ScanFile Connector for ShareScan, any eCopy enabled device can 
be used to scan and send documents to ScanFile Folders. Using TCP/IP 
connectivity, combined with ScanFile security, ScanStation can send 
documents to the RemoteStation server, which will then store them to the 
selected ScanFile document folders. RemoteStation Server with the ScanFile 
Connector for ShareScan is an ideal application for centralised scanning 
stations and to allow remote offices access to your ScanFile document store. 

An advanced function of RemoteStation Server is it's ability to act as a 
master server, allowing users to store documents to slave RemoteStation 
Servers, therefore allowing a central user access point for storing documents, 
which can then be distributed to ScanFile document stores located 
elsewhere. 

Please refer to the previous chapter on RemoteStation for instructions on 
how to install and configure the RemoteStation Server. 

Installing the Connector 
The ScanFile Connector for ShareScan is an add-on to the main eCopy 
ScanStation application. This must be installed and running correctly prior to 
the installation of the ScanFile Connector. 

To install the Connector on the ScanStation, select Run from the Start menu, 
and select setupScanFileConnector.exe from the Software directory on the 
ScanFile program CD. If the ScanStation does not have a CD drive, the 
installation program  can be copied to a network location and run from there. 

You will be asked to select the language and the installation location for the 
Connector, and then the program files will be installed. 

Once installed, the Connector can be configured. 

Connector Configuration 
Before the ScanFile Connector can be used, it must be configured by using 
the eCopy Administration application. For ShareScan, this can be accessed 
by running the ShareScan Administration program from the eCopy 
Applications program group. 
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In the Categories list select the Scan to ScanFile category, and the 
Connector Preferences will be shown. 

IP & Port 
The IP address and Port settings should be set to those that the 
RemoteStation server has been configured to use. If these are not set 
correctly, the Connector will not be able to communicate with the 
RemoteStation server. 

Login 
The Connector requires a valid ScanFile user name and password to be able 
to login to the RemoteStation server. The users must have permission for 
RemoteStation and the ScanFile Folders that documents will be saved to 

If the Automatic Login feature is not enabled, each user of the Connector will 
have to enter a user name and password each time they use the Connector 

With Automatic Login enabled, users of the ScanFile connector will not have 
to login. You can enter a user name and password that will be used by all 
users of the Connector, which will have been set with permissions for 
RemoteStation and ScanFile Folders. 
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Enable Scan to ScanFile 
The ScanFile Connector can be enabled or disabled with this option. If the 
Connector is enabled, the Send to ScanFile button will be available on the 
ScanStation. If disabled, the button will not be shown. 

Using the Connector 
On the ScanStation main screen, select the Scan to ScanFile button, after 
placing the document in the scanner feeder. 

 

Preview Screen 
Once the document has been scanned, the preview screen is displayed, 
where you can review the scanned pages, scan more pages, delete the 
document or select to Send to document to ScanFile. 
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Login 
If the Automatic Login feature is disabled, each user will have to login using a 
valid ScanFile user name and password. If the ScanStation being used only 
has a touch screen, a screen based keyboard is available. Pressing the ESC 
key will close the keyboard 

 

Destination 
You can select to send the scanned document to either a ScanFile user or a 
ScanFile folder. When you select to send to a ScanFile Folder, the following 
screen will be displayed, which allows you to select the folder you want to 
send to document to. 
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Index and Send 
Once you have selected the ScanFile Folder, the index fields for that Folder 
will be displayed, allowing you to type in the document details prior to 
sending. If the ScanStation being used only has a touch screen, a screen 
based keyboard is available  

 

Once you have entered the index information, the document can be sent to 
ScanFile by pressing the Send button, and the Connector will then close. 
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